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2 Introduction






2.1 Introduction

The Profile range of non-contact measuring systems from Brown & Sharpe Limited is based on proven
technology used in many standard and special purpose measuring systems. The machine is controlled using Pro-
Measure and Pro-Composer Software running under the Windows NT Operating System.

The Profile Gauge Manual contains hardware information and a comprehensive On-line Help system contains
full software and machine operation instructions.

WARNING: This manual, the printed Profile Gauge user guide, Pro-Measure Software and Pro-

Composer Software On-line Help, should be read carefully before operation to ensure operator safety
and accurate measurement results.
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3 Overview of Pro-Measure User Interface
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3.1 Overview of Design

When you start Pro-Measure, you see the main window and all of its working components.
The display is split into several areas.

1. Main Menu 4, Toolbar
2. Display window 5. Title Bar

3. Status Bar

Pm—Heasure - [2 Dims_pel =]

e

3.2 Display windows

There are two types of windows used by Pro-Measure. The Data display window when in Measurement or
Calibration mode and the Editor window when in the Editor mode.
Examples of the window types are as follows :

Data Display window - Text Mode
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Data Display window - Graphics Mode
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33 Application Status Bar

The status bar is displayed at the bottom of the Pro-Measure application window.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through
menus. This area similarly shows messages that describe the actions of toolbar buttons and menu items as you
move the mouse over them.

The right areas of the status bar have several indicators to show certain states of the system.

Indicator Description

CAP - The Caps Lock key is latched down.

NUM - The Num Lock key is latched down.

To the left of the Caps lock indicator is a STATUS INDICATOR. This shows the status of the system. A green

indicator means the system is idle, a red indicator indicates the system is busy.
The current date and time are also shown at the extreme right of the status bar.
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34 Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar provides
quick mouse access to several functions used in Pro-Measure.

If a function is available for use, the button will have a coloured graphic icon. Otherwise it will be 'greyed' out.
The Toolbar buttons available and their functions may vary depending upon the current mode of the software.

The two most common Toolbar options are as follows :

Measurement/Calibration Mode - Toolbar buttons..
Draw Zone Mode - Toolbar buttons.

Note : The keyboard function keys can be used to activate the corresponding toolbar button.

35 Title Bar

d@ﬁPro'Heasme -

The title bar is located along the top of a window. It contains the name of the application and current active
document.

3.6 To move the window, drag the title bar.

A title bar may contain the following elements:

4 Application Window Control-menu button

Calibration or Measurement window Control-menu button

|

Editor window Control-menu button

|

Maximise button. This enlarges the active window to fill the available space

Minimise button. This reduces the Application window to an icon

[ Restore button. This returns the active window to its size and position before you chose the Maximise or
Minimise command.
x| Close button. This will action the close application command.

Note: You can also move dialog boxes by dragging their title bars.
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3.7 Scroll bars

Displayed at the right and bottom edges of the document window. The scroll boxes inside the scroll bars
indicate your vertical and horizontal location in the document. You can use the mouse to scroll to other parts of
the document.

3.8 General Controls

The software is controlled by using the Mouse and Keyboard.

Most operations will be carried out using the Mouse and Text/data entry input via the Keyboard. Standard
Windows Mouse and Keyboard conventions apply.

If full keyboard operation is preferred, see the Windows Help system for standard keyboard navigation.

39 Machine Specific Data

There is a collection of settings and information that is specific to a particular machine and Software
installation. In the event that a complete software re-installation is required, this information will be used to
restore the machine specific settings.

The machine specific data includes :

Master.pcl This contains master dimension data.
Full Calibration Information used for a Full Calibration of the machine. Full calibration must be carried out
Coefficients. by a Brown & Sharpe Engineer.

Password Information. All passwords and settings as defined within the 'Options’ of Pro-Measure or Pro-
Composer.
File Selector settings.  All settings as defined within the 'Options' of Pro-Measure or Pro-Composer.

Windows Registry All relevant registry settings.
Settings.

The Backup command is used to save the settings to disk and the Software Setup utility can use the backup disk
to restore the original settings during future re-installations.
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4 Pro-Measure Menu Commands
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4.1 Main Menu Options

File menu
Edit menu
Tools menu

Debug menu
Window menu

Help menu
Note : The available menu options will vary depending upon the mode of the application.

4.2 Edit menu commands

The Edit menu offers the following commands:

Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.

Paste Pastes data from the clipboard into the document.

Find Searches the document for a specific word or string.

4.3 Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard. This
command is unavailable if there is no data currently selected.
Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+X

4.4 Copy command (Edit menu)

Use this command to copy selected data onto the clipboard. This command is unavailable if there is no data
currently selected.
Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+C

4.5 Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point. This command is unavailable
if the clipboard is empty.

Shortcuts
Keys: CTRL+V
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4.6 Find command (Edit menu)

Searches for specified text in the active document. Enter the text string you are looking for in the Find Dialog
box.
You can look for the next instance of the string and select the direction UP or DOWN the document.

Shortcuts
Keys: CTRL+F
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4.7 File menu commands

The File menu offers the following commands. The commands available will vary depending upon the current
mode of operation of the program.

New Creates a new document.

Open Opens an existing document.

Close Closes an opened document.

Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.

Print Setup Selects a printer and printer connection.

Open Calibration Opens a program ready for Calibration.

Open Measurement Opens a program ready for Measurement
1,2.3.4.... Option to re-load one of the four most recent files.
Exit Exits Pro-Measure.

4.8 New command (File menu)

Use this command to create a new document.

You can open an existing document with the Open command.
Shortcuts

Keys: CTRL+N

4.9 Open command (File menu)

Use this command to open an existing document in a new window. You can open multiple documents at once.
Use the Window menu to switch among the multiple open documents. See Window 1. 2. ... command.

You can create new documents with the New command.

Shortcuts

Keys: CTRL+O

4.10 Close command (File menu)

Use this command to close all windows containing the active document. The program will suggest that you save
changes to your document before you close it. If you close a document without saving, you lose all changes
made since the last time you saved it. Before closing an untitled document, the application will display the Save
As dialog box and suggest that you name and save the document.

You can also close a document by using the Close option on the document's window control menu. This menu
is accessed by selecting the icon that appears in the top left corner of the document window.

4.11 Save command (File menu)

Use this command to save the active document to its current name and folder. When you save a document for
the first time, the program displays the Save As dialog box so you can name your document. If you want to
change the name and folder of an existing document before you save it, choose the Save As command.
Shortcuts '

Keys: CTRL+S

4.12 Save As command (File menu)

Use this command to save and name the active document. The program displays the Save As dialog box so you
can name your document.
To save a document with its existing name and folder, use the Save command




4.13  Print command (File menu)

Use this command to print a document. This command presents a Print dialog box, where you may specify the
range of pages to be printed, the number of copies, the destination printer, and other printer setup options.
Shortcuts

Keys: CTRL+P

4.14 Print Setup command (File menu)

Use this command to select a printer and a printer connection. This command presents a Print Setup dialog box,
where you specify the printer and its connection.

4.15 Open Calibration command (File menu)

This command allows a Calibration program file to be selected to calibrate the gauging system and software.
Once the file has been selected, the 'F2' button will start the calibration routine.

4.16 Open Measurement command (File menu)

This command opens a Measurement program ready for measurement of the component. It will require the
selection of a program file to be chosen from the file selector.

Once the file has been selected and loaded, measurement will begin when the 'F2' Start button is pressed.

417 1,2,3,4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the most recently used documents.
Choose the number that corresponds with the document you want to open.

4.18 Exit command (File menu)

Use this command to end your current session. You can also use the Close command on the application Control
menu. The program prompts you to save documents with unsaved changes.

Shortcuts

Mouse: Double-click the application's Control menu button. This is the icon at the top left corner of the
application window.

Keys: ALT+F4
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4.19 Tools Menu commands

The Tools menu offers the following commands:

Editor Launches the Editor to enable creation or modification of Procal Programs.

Gauge Gauge related setting options.

Language Changes the language of the program, in a limited manner.

Options General settings for Pro-Measure, including. folder Paths, File selector options and Password
Setup.

Backu Saves Machine specific data to disk for use in future Software re-installations.

4.20 Editor command (Tools menu)

This command includes File options for the Procal Editor. The options are as follows :

New Creates a new Procal document and Launches the Editor.
Open Opens an existing Procal document in the Editor.

Closes the currently active Procal document.
Close
Save Saves the currently active Procal document using the same file name.
Save As Saves the currently active Procal document to a specified file name.
1,2,3.4... Option to re-load one of the recently opened files.

421 Gauge command (Tools menu)

This command includes setting options for Gauge. The options are as follows :

Device mapping Options for mapping devices in the system.
Diagnostics System diagnostic options.

4.22 Language command (Tools menu)

Use this command to change the language text used within the program. All the languages available will be
shown as options.

Notes :

This option is provided as a quick means to switch languages and only changes the text language specific to the
application. Where standard Windows functions are used by the application i.e. the standard windows File
Selector or Print dialog boxes, the language of these will be that of the installed Windows version. If you
require the program to be 100% localised with regards to language text you must install a localised version of
the Windows operating system of the Language you desire.

This language change is not permanent and will revert to the Windows Operating system language when you
begin the next session.
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Changing the language with this option will change the corresponding Help file language also. The Advanced
Procal Keyword reference section (Pro-Measure On-line Help) will only be available in English.

4.23  Options command (Tools menu)

Use this command to display the Options Dialog box where you can set global environment options for the
software such as default folder paths, passwords and file selector options.

4.24 Backup command (Tools menu)

This command is used to Backup machine specific data. It can be saved to floppy disk for use in future re-
installations.

4-7



4.25 Debug menu commands

The Debug menu offers the following commands for debugging Procal programs:

Procal Watch ~ Opens the Procal Watch Window.

Serial Trace Opens the Procal Serial Trace Window
Debug Runs and debugs Procal programs in Calibration mode.

Calibration

Debug Runs and debugs Procal programs in Measurement mode.
Measurement

Add Remove  Inserts or removes a Breakpoint in the program for debug purposes.
Breakpoint

Continue Continues program execution after a program has been stopped due to a break.
Execution

Single Step Enables single step execution of a program..

Terminate Stop debugging of Programs.
Debugging

4.26 Procal Watch command (Debug Menu)

This command opens the Procal Watch window. This is a display which shows the status of variables when a
Procal program is run. It provides a useful indicator as to the state of the program and can be used to identify
problems when debugging a program.

When the Procal Watch window is open, there are four types of variables that can be displayed. Each type has
its own page and the page can be selected by clicking on the corresponding tab at the top of the window. The
types of Variables are as follows :

Local These variables exist in the current context of a program
ie. applicable only to the currently active subroutine. They
are defined by the Declare:Local_Var command.

Global These variables exist for the entire life of a program and
are defined by the Declare:Global Var command.

Common These are variables which exist between chained
programs and are defined by the Declare:Common_Var
command.

System These are variables created by the application and exist

for all programs.

Scroll bars will become active if information can't fit within the Procal Watch window.

The Procal Watch window is split into two columns, the left hand column has the variable name and the right
hand column has the current value. The width of the columns can be adjusted by dragging the column dividing
bar at the top of the Procal Watch window.



4.27 Procal Serial Trace command (Debug Menu)

This window displays communications activity of the currently opened serial port (only one port can be open at
a time with Procal). It shows the communications parameter settings and the actual data that is being transmitted
or received. Transmitted data will be shown in blue and received data will be displayed in red.

4.28 Debug Calibration command (Debug Menu)

This command runs the program currently open within the Editor window in Debug Calibration mode. This is a
special calibration mode whereby if an error occurs during execution, the program will be stopped and the line
at which the error happened will be highlighted.

4.29 Debug Measurement command (Debug Menu)

This command runs the program currently open within the Editor window in Debug Measurement mode. This is
a special measurement mode whereby if an error occurs during execution, the program will be stopped and the
line at which the error happened will be highlighted.
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430 Add Remove Breakpoint command (Debug Menu)

This command inserts or removes a breakpoint from a Procal program.

A breakpoint pauses a program at a user defined position in the code.

This can be a useful function to enable sections of a program to be debugged at a time.

This command toggles the breakpoint On or OFF at the current line of the cursor position. The breakpoint is
denoted by a red mark at the left hand edge of the line. This is a temporary mark and is not stored with the
procal program.

Breakpoint

Once a program has been paused using a breakpoint, you can use the Continue Execution, Single Step or
Terminate Debugging commands.

4.31 Continue Execution command (Debug Menu)

This command enables a program to continue execution after it has been paused by a breakpoint.

4.32  Single Step command (Debug Menu)

This command enables a single step of a program to be executed at a time. It is only possible to do this once a
program has been stopped by a breakpoint. Each time this command is selected the next line of the program will
be executed.

4.33 Terminate Debugging command (Debug Menu)

This command stops the Debug mode. It is only possible to stop the Debug mode when a program has been
paused by a breakpoint.

4.34 Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.

Tile Arranges windows in non-overlapped tiles.

Arrange lcons Arranges icons of closed windows.

Window 1. 2, ... Goes to specified window.




4.35 New command (Window menu)

Use this command to open a new window with the same contents as the active window. This enables you to
display parts or different views of a document at the same time. If you change the contents in one window, all
other windows containing the same document reflect those changes. When you open a new window, it becomes
the active window and is displayed on top of all other open windows.

436 Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion.

4.37 Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.

4.38 Arrange Icons Command (Window menu)

Use this command to arrange the icons for minimised windows at the bottom of the main window. If there is an
open document window at the bottom of the main window, then some or all of the icons may not be visible
because they will be underneath this document window.

439 1,2,.. command (Window menu)

The application displays a list of currently open document windows at the bottom of the Window menu. A
check mark appears in front of the document name of the active window. Choose a document from this list to
make its window active. If there are more than 9 windows to choose from, a 'More Windows' option will be
available. This option provides a 'Select Window' dialog box to choose the window from.



4.40 Help menu commands

The Help menu offers the following commands, which provide you assistance with this application:

Help Topics Offers you an index to topics on which you can get help.
About Displays the version number of this application.

4.41 Help Topics command (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can jump to step-by-
step instructions for using the software and also reference information.

4.42 About command (Help menu)

Use this command to display the copyright notice and version number for your copy of this application.
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5 Pro-Measure Dialog Boxes
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5.1 Options Dialog Box

There are a set of parameters that apply to the general operation of Pro-Measure. These items include the folder
paths for files, file selector control and password control. These settings are specific to the Pro-Measure
environment and not document specific. Any changes made to these settings will be remembered in future
sessions of Pro-Measure and may be changed at any time.

The Options dialog box is obtained by selecting 'Options...' from the 'Tools' menu. The dialog box has four
Pages each accessible by pressing the corresponding tab at the top of the window.

The Pages are as follows :-

Folders Folder Path settings for program files.

Advanced  Advanced options.

Passwords  Password settings and control. Passwords can be used to restrict access to certain parts of the
Program. If they have been set and a restricted area is accessed, the password will be requested.

Selector File selector settings.

5.2 Options - Advanced Page

Open windows maximised

This option allows you to force the window of each newly opened file to fit the maximum available screen
space. A tick in this option will force the windows to be maximised, no tick will open a new window but leave
existing windows visible.

Report error in main program
This option is useful where sub procal programs are called from a main program. If an error occurs in the sub
program, it will be reported by the main program. A tick in the tick box means this option is activated.

Use Windows File Selector

This option allows you to change between the standard Windows file selector or the custom Brown & Sharpe
file selector. The Brown & Sharpe File selector allows more secure access to files including the ability to Hide
folders and set folder Backstops. A tick in this option means the Standard Windows file selector will be used, no
tick against the option means the Brown & Sharpe file selector will be used.



5.3 Options - Folders Page

This page contains the file paths for the various types of files used by Pro-Measure. The locations will be set to
default positions and it is not recommended that you deviate from these. The facility is provided to allow
flexibility for installations that may wish to store/retrieve files using a PC Network.

Calibration
This is the default file folder path used for Procal Calibration programs i.e. When the 'Open Calibration'
command is invoked, this will be the default path to retrieve the file from.

Measurement
This is the default file folder path where the Measurement Procal files are located. i.e. If a measurement file is
Opened or Saved, this will be the default path shown in the file selector.

Editor
This is the default file folder path of the file selector when used by the Editor.

|
Use the - button to activate the file selector to choose the folder for the specific setting. Alternatively you
may type in the full path manually.

5.4 Options - Passwords Page

Level 1 : Full Access
This password setting allows Full access to the software environment, no restrictions apply to the password
holder.

Level 2 : Program Creation and Editing
This password setting allows the password holder access to the Program Creation and Editing Functions.

Level 3 : Calibration
This password setting allows the password holder access to Calibration functions

Level 4 : Measurement
This password setting allows the password holder access to the measurement functions.

Set

The 'Set' button presents the "New Password' Dialog box. This is where you enter the password. Click the mouse
into the text boxes and type in the password you have chosen. You will notice that the password isn't displayed
on the screen. Press the 'OK' button to accept your changes. If you don't use the same password in each box, a
warning message will be displayed.



If you wish to remove a password, select the 'Set' option and use the mouse to highlight the password *'s in the
text box and then press the 'Delete’ key on the keyboard. Do this for both password text boxes and then press the
'OK' button.

INew Password

Note :
You do not have to set all the passwords, but must follow the convention that all levels below the level you are
setting have to be set first. i.e. To set password Level 3, you must set Level 1 and 2 first.

Warning :

It is important that you do not lose or forget your passwords. There is no way of retrieving them from the
software. If you forget the passwords for Level's 2,3 and 4 then they may be reset by someone with Level 1
access rights. If you lose or forget the password for Level 1 then you will have to re-install the software to reset
the password settings.

Note : If passwords are set, they will affect all Brown & Sharpe installed programs. i.e. Passwords set in Pro-
Measure will be active in Pro-Composer (if installed) and vice versa.



5.5 Options - Selector Page

Hidden Folders/Backstops drop-down menu

This menu gives you the choice setting the Hidden folders or folder Backstops. The Hidden folders are those
which will not be visible in the file selector. This can make finding and selecting files easier since any folders
that aren't relevant can be hidden. The folder Backstops are a locking mechanism that prevents the operator
from moving backwards out of a folder. This prevents access to unauthorised areas of the filing system. Any
folders that have already had attributes set will be displayed in the window just below the drop-down menu. The
contents of this window will change depending upon whether the 'Hidden folders' or 'folder Backstop' option is
selected.

New

This option allows you to select a new folder to be affected by the option chosen in the drop-down menu
(Hidden or Backstop). When this option is selected, the file selector will be opened. You can select the drive
from the drive icons at the top of the file selector. You can select the folder of interest by double clicking on the
folder icons in the main central window area. Alternatively you may type the full path in the text box at the
bottom of the window. If you select the folder by clicking on the folder icons ensure that the correct path
appears in the text box before you accept the settings by pressing the 'OK' button.

Delete

This option allows you to delete a folder 'Hidden' or 'Backstop' attribute that has been set. Click the mouse in
the folder listing window on the folder you wish to delete the attribute for and then press the 'Delete’ button.
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6 Using Pro-Measure






6.1 Calibration Mode

Calibration performs two functions, it initialises (prepares) Pro-Measure for use and will calibrate a gauging
system or device ready for measurement. The 'Open Calibration' command executes the Calibration program
which has been written to cause the system to perform appropriate operations on a specific measurement centre.
Before any components can be measured, the system will require calibration. This is performed by placing a
setting master into the gauging system and running the selected setting program.

On Profile gauges, the calibration program initialises the software, datums the scale reader, checks the correct
function of the CCD arrays and the scale reader, checks the alignment of the carriage and calibrates the
measurement system.

During Calibration, the operator should pay particular attention to prompts and messages which appear on the
VDU.

When the calibration sequence is complete, Pro-Measure will indicate whether calibration has been successful.
Generally there are only two states :

PASS
FAIL

If calibration has failed, retry by starting the program again. Successive failures indicate possible faults with the
gauging system or device.

6.2 Calibrate a Profile Gauge

1. Select the 'Open Calibration' option from the 'File' menu.

2. Select the Profile calibration file from the file selector.

3. Press the 'OK' button.

4. Your file will now be opened.

5. Once the file has finished loading, press 'F2' to begin the program.

6. There will be some on screen prompts and messages during execution of the program, respond to these
as necessary.

7.  When the program has completed all operations, the display window will clear.

8. Calibration is now complete.
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6.3 Calibration Faults

In the event of a fault during calibration, a system error message or message specific to the gauge calibration
program may be displayed. The gauge calibration program messages are :

Length Error
Diameter Error

The most likely causes of faults are dirt on the setting master, poor location of the setting master in the tooling
or wrong setting master being used. Check that the serial number on the setting master corresponds to that

displayed on the computer VDU, clean the setting master and re-run the calibration program. If the problem
recurs, contact the Brown & Sharpe Service organisation.

6.4 Measurement Mode

In Measurement mode the measurement system will support the following functions :

e Measure a component placed in the gauging device

e Display the results of measurement on the VDU

e  Update the statistics (if option available)
On entry into the 'Open Measurement' option after a successful calibration the data display window will contain
a blank screen with the Text display headings. The toolbar measurement control buttons will become active.
After each measurement has been completed, the data will be shown in the table below their corresponding

headings. Each screen full of information is called a page and if the number of dimensions displayed exceeds
the single page limit, the Page control will enable viewing of the next set of dimensions.

6.5 Start a Measurement program

1. Select the 'Open Measurement' option from the 'File' menu.
2. Select the file you wish to open from the file selector.

3. Press the 'OK' button.

4. Your file will now be opened.

5. Once the file has finished loading and the toolbar buttons become active (coloured), press the 'F2'
button to start the program running.

6. The program will now begin. There may be some on screen prompts or messages during execution of
the program, respond to these as necessary.

7. When the program has completed all operations, the measurement results will be shown in the data

display window.

Note : To make measurements on a component for which no measurement program has been written, use Pro-
Composer to create a measurement program. See the on-line help within Pro-Composer for details of how to use
this software.
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6.6 Execution Mode

Some Procal measurement programs may offer different modes of execution (i.e. Measurement with/without
Statistics if an SPC application is installed).

In cases where there are execution options available, when a Measurement program is opened a dialog box will
appear in the centre of the screen. The desired option can be selected from the list.

6.7 Measurement Mode Controls

Once a Measurement program has been loaded and initialised ready for use, there are several controls available.
These controls can be selected with the mouse or keyboard function keys.

The available buttons are as follows :

Starts execution of the measurement program.

Page if the number of dimensions displayed exceeds the single page limit.

Toggles between the different display modes of the data display window.

6.8 Toggle Control - Text Display Screen

Once a program has completed the measurement cycle, the results will be shown in the data display window.
The 'F4 Toggle' button on the toolbar changes the mode of the data display window. The default options to
toggle between are the Text screen and Graphics screen. Each time the button is pressed, the display will toggle
to the next available screen mode.

Pattizve : 3 Dms Unks ; oo
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o2 -d Average 2 150r% 1 Yuc] 15200 15000 PAST
001-0 Avrazs 3 sma 24.900 PAST

Note : Other custom screens may be available as toggle options.
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6.9 Page Control - Text/Graphic Display Screen

If the number of dimensions of a program exceeds the single page limit of the data display window, the 'F3
Page' button will update the display with the next page worth of dimensions. Each time this button is pressed,
the next set of dimensions is shown. The display will eventually return to the first dimensions when all pages
have been shown.
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Note: This button has the same effect on the Graphics Display screen.

6.10 Interpretation of Text Display Results

The text display will have the following headings for the results table.

Part Name This is the program name.
Result Overall classification of last component measured.
Description Dimension description.
Actual Actual measured value.
Deviation Deviation of actual value from the nominal value.
USL Upper specified limit.
LSL Lower specified limit.
Class Dimensional classification - can be :
PASS
FAIL
REWORK
NO CLASS (Blank space)
Units Units of measurement (mm or Inch).
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Part Name : 3 Dims Linits © mm

Result : PASS

Description Actual Deviation usL L&L Class
D01 -@ Average 1 5.048 0.048 5.100 4.900 PASS
D02 -@ Average 2 16.075 -0.025 15.200 15.000 PASS

D03 -@ Average 3 25.034 0.034 25.100 24.900 PASS

6.11 Interpretation of Graphics Display Results

The graphics display indicates (for each dimension) the relative position of the actual measurement to the Upper
and Lower specified limits. A small rectangular 'spot' marks the position and if a particular dimension is outside
the specified limits the spot will blink. The graphics display will have the following headings for the table.

Part Name This is the program name.

Result Overall classification of last component measured.
Description Dimension description.

Units Units of measurement (mm or Inch).

Part Mame : 3 Dims Units : mm
Result : FAIL
Description

D01 -@ Average 1
D02 -@ Average 2
D03 -@ Awverage 3
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6.12 Draw Zone Mode

This mode provides a graphical illustration of the scanned data within the specified zone. It can be instigated by
the Draw:Zone command within a Procal program for static measurements, or the Draw:R_Zone command for
rotational measurements. In addition, if an error occurs with one of the Find keywords during execution, the
problem zone will be available for display by pressing the F4 Toggle button.

This facility can be useful for 'debugging' procal programs where exact positioning on features of a component
is difficult.

When Draw Zone mode is active, the Toolbar buttons have different functions, indicated by different icons and
descriptions. See Draw Zone Mode -Toolbar buttons for their functions. The toolbar buttons have controls for
investigating the data within the specified zone.

The following image shows how the screen will look in Draw Zone mode.

61.082,13.444

7.664,-13.444 / 2.000
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The bottom left and top right co-ordinates for the zone are shown, along with the unit value per division i.e. in
the example above each division is 2mm, the units will be as set in the Procal program.

6.12.1 Zoom Function

The Zoom commands allow magnification/reduction of the display screen.

6.12.2 Zone Function

The Zone function allows quick 'zooming' onto a feature of interest within the displayed zone. When this button
is selected, a rectangular box will be displayed in the centre of the current screen.

The box can be moved about the display using the cursor keys :

UP Cursor key Moves the box up the screen

DOWN Cursor Key Moves the box down the screen
RIGHT Cursor Key Moves the box to the right of the screen
LEFT Cursor Key Moves the box to the left of the screen



The shape of the box can also be changed using a combination of SHIFT plus CURSOR Keys :

SHIFT + UP Cursor Key Enlarges box in Y

SHIFT + DOWN Cursor Key Reduces the box in Y
SHIFT + RIGHT Cursor Key Enlarges the box in X
SHIFT + LEFT Cursor Key Reduces the box in X

To display the contents of the box simply press the ENTER or RETURN key.
The image shows the zone box positioned at a specific feature within the zone.

51.685,14.004
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6.12.3 Cursor function

A Cursor cross hair is available to move through individual points within the scanned data. The co-ordinates of
the current cursor position will be displayed.
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51.685,14.004

6.12.4 Reference Function

This function places another cursor at the location of the current cursor position. This becomes a Reference
cursor. The normal cursor can now be moved as before, but the cursor co-ordinate readings are now relative to
the co-ordinates of the Reference cursor. This enables the location of a point within the zone to be displayed
relative to any other point within the zone.

The example below shows the active cursor (shown in green) at a position from the reference cursor (shown in
blue) of X=8.101 and Y=4.310 mm. The F9 Exit button reverts back to the normal control mode.

51.685,14.004
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6.13 Notes about Rotational Draw Zone

This is very similar to the Draw Zone control described, with the difference being that the display is shown as a
section at the position of a Rotational zone. The Zoom, Cursor, and Zone commands work in the same manner
as detailed above. An additional option is available on the toolbar, F8 Restore. This reverts the display to the
original settings as first displayed prior to any zooming, zone display etc.

6.14 Print Measurement results

The current page display of a text or graphic window will be printed upon selection of the Print command.
1. Make the screen display the page that you want to print..

2. Follow the printing a document instructions.

Note :

If the number of dimensions exceeds the single page limit, use the 'F3 Page' button to display the next page. The
print command only prints the currently visible page.

Only the ALL option will be available for the Print Range setting of the Print Dialog box when in Measurement
mode.
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7 File and Print Operations
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7.1 File Operations

The basic file 'New', 'Open’, 'Save', 'Save As' and 'Delete' commands are all available from the File Menu.

Creating a New File

Open an Existing File

Saving a file

Copying a File

Deleting a file

Select the 'New' command from the File menu.

Select the 'Open’ option from the File menu. This will cause the file selector to be
presented in which you can select the file you wish to open.

Select the 'Save' or 'Save As' command from the File menu. The 'Save' option will save
the document using its existing name. If it is a new document that has not been saved
before, you can assign a name and path to the file the first time you save it. The 'Save
As' command always prompts you for a name before it saves the files, even if it has
been saved before. You can change the name, folder and drive if desired in the file
selector dialog box that is presented upon choosing this command. If you try to save a
file with a name that already exists, you will be warned and given the option to cancel.

The simplest way to do this is to 'Open' the document that you wish to copy and then
use the 'Save As' command. Assign a new name to the file and also change the folder
and drive if desired. The 'Save As' command always prompts you before saving the file.
You can change the name, folder and drive if desired in the file selector dialog box that
is presented upon choosing this command.

Select the 'Delete’ option from the File menu. In the file selector dialog box that is
presented, select the file you wish to delete. You will be prompted to confirm that you
do want to delete the specified file.

7.2 Pro-Measure File Types

There is one main file type used by Pro-Measure. The file type can be identified by the file extension. This is
the three character reference that is attached to the end of the file name.

The file type is as follows :

PROCAL This is the Procal Measurement or Calibration file that is used by Pro-Measure. These are identified by
files the .PCL file extension.

Each of these files will be located in folders that are specified within the Options Dialog box.



7.3 Pro-Composer File Types

There are several types of file used by Pro-Composer. Each file type can be identified by the file extension. This
is the three character reference that is attached to the end of the file name.
The file types are as follows :

SCHEMATIC files

PROCAL files

CAD IMPORT files

STANDARDS
DATABASE files

This is the file that contains the picture of the component and its associated dimensional
data. These are identified by the .SCH file extension.

This is the Measurement file that is created from the Pro-Composer Schematic when it is
saved. These are identified by the .PCL file extension. This is also the file type used for
any Procal Measurement file such as Headers and Footers and Standards Database
Programs.

This is the CAD file type that can be used for importing component pictures into Pro-
Composer. They must conform to the DXF file interchange standard as used by most CAD
programs. These are identified by the .DXF file extension.

This is the file that contains the Reference information for a Measurement Standards
Database. These files are generated from PROCAL programs. You cannot create or modify
a Standards database file directly, you must create or edit it via the Procal file. Standards
Database files have the .STD file extension.

Each of these files will be located in folders that are specified within the Options Dialog box.

7.4 Folder Structure

All of the files required for use by Pro-Measure/Pro-Composer are maintained in categorised folders. The
following chart shows the folder structure :

Program Files

3 ggm Pro-Measure

7 Calibration
] Help
-] Library
1 Parts
4.7 Profile

{—}«‘ﬁ Program

{71 Plugins

{:E Standards

] Text
e Userdata

+{3 Utilties

The types of files stored within each folder are as follows :
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CALIBRATION Gauge calibration Procal program.

HELP On-line Help files.

LIBRARY Procal Measurement Library files.

PARTS User program files and Schematics.

PROFILE Setting master calibration data file.

PROGRAM Main Pro-Measure and Pro-Composer program files. The PLUGINS sub folder contains
additional system files.

STANDARDS Default Standards Database files and the Procal programs that created them.

TEXT Library routines language text files.

UTILITIES Gauge/Program utility files.

USERDATA Default folder for archive data which can be written into user files.

7.5 Open an Existing document

1. Select the 'Open’ option from the 'File' menu.
2. Select the file you wish to open from the file selector.
3. Press the 'OK' button.

4. Your file will now be opened.

7.6 Create a New document

1. Select the 'New' option from the File menu.
2. A blank document will be created.

3. You can now scan or import component data.

Note: When you save the new document for the first time, you will be prompted for a name for it.
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7.7 Close a document

1. Select the 'Close' option from the 'File' menu.

2. The document will now be closed. If you have modified the document and not saved it, you will be
given the option of saving the document before it is closed.

7.8 Delete a file

1. Select the 'Delete’ option from the 'File' menu.
2. This command presents the file selector where you may specify the file you wish to delete.

3. Select 'OK' to delete the selected file.

Note : You will be asked to confirm that you want to delete the selected file.

7.9 Save a document

1. Select the 'Save' option from the File menu.
2. Ifyou are saving the document for the first time, you will be prompted to give it a filename. Once a
document has a name, any subsequent saves will be made by over writing the existing document of

that name.

3. The file will now be saved.

Note : Use the 'Save As' option if you want to save the document under a different name or location.

7.10  Copy a document

1. Select the 'Open' option from the 'File' menu.

2. Select the file you wish to copy from the file selector.

3. Press the 'OK' button.

4. Your file will now be opened.

5. Select the 'Save As' option from the 'File' menu.

6. If you wish to copy the file to the same folder as the original, enter a new filename and then press the

'OK' button. Otherwise change the drive and/or folder accordingly to the new location that you want to
copy the file to, change the name if desired (though this isn't essential) then press the 'OK' button.
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7.11 Print a document

1. Select the 'Print' option from the 'File' menu.
2. Select the printer options from the Print Dialog box. This command presents a Print dialog box, where
you may specify the range of pages to be printed, the number of copies, the destination printer, and

other printer setup options.

3. Select 'OK' to print your document.
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8 Machine Specific Data
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8.1 Machine Specific Data

There is a collection of settings and information that is specific to a particular machine and Software
installation. In the event that a complete software re-installation is required, this information will be used to
restore the machine specific settings.

The machine specific data includes :

Master.pcl This contains master dimension data.
Full Calibration Information used for a Full Calibration of the machine. Full calibration must be carried out
Coefficients. by a Brown & Sharpe Engineer.

Password Information. All passwords and settings as defined within the 'Options' of Pro-Measure or Pro-
Composer.
File Selector settings.  All settings as defined within the 'Options' of Pro-Measure or Pro-Composer.

Windows Registry All relevant registry settings.
Settings.

The Backup command is used to save the settings to disk and the Software Setup utility can use the backup disk
to restore the original settings during future re-installations.

8.2 Backup Machine Specific Data

1. Select the 'Backup' command from the 'Tools' menu.

2.  When prompted, insert a blank formatted disk into the floppy drive.
3. Press the 'OK' button to begin the backup process.

4. A message will be displayed when the backup is complete.

5. Label the disk and mark it with the gauge serial ID number and the date. It is recommended that the
write protect tab of the disk is put into the locked position. Store the disk in a safe place.

6. Backup of machine specific data is now complete.
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8.3

Restore Machine Specific Data

IMPORTANT : Please read these instructions carefully before actually carrying them out on the computer.

1.

2.

10.

11.

12.

13.

14.

15.

Close all programs.

Ensure that the Pro-Measure Plugin manager has closed. i.e. no Brown & Sharpe icon in the right hand
panel of the task bar.

Insert the '"Pro-Measure for Windows NT' CD into the CD-Rom drive.

The CD should auto start. If this facility has been disabled, open Windows Explorer, click the CD icon
in the available drives, select the 'Setup.exe' file.

When the Setup program has started, a dialog window should be present on the screen. Read all
prompts throughout the process.

Press 'Next' to continue.

Select the destination folder. This is the folder where the Pro-Measure system is installed. Default is
C:\Program Files\Pro-Measure

Press 'Next' to continue.

From the Installation Setup Type screen, select the FULL INSTALLATION option or OFF-LINE
PROGRAMMING option. If FULL INSTALLATION is selected, and no Backup disk is available, this
will return the machine to the factory default settings and a full calibration of the machine will be
required. Full calibration must be carried out by a qualified Brown & Sharpe Engineer. Contact Brown
& Sharpe if you don't understand this statement.

Press 'Next' to continue.

When prompted for a Backup disk, select the YES option.

The data will now be restored.

A message will be displayed when the operation is complete.

The computer now needs to be restarted. Select the 'restart now' option, and press 'Finish' to end the
installation and restart the computer. If the 'restart later' option is selected, press 'Finish' to end the

setup program. Ensure the computer is restarted before running Pro-Measure or Pro-Composer.

The machine specific settings have now been restored.
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9 Pro-Measure Device Mapping
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9.1 Device Mapping - Principle

Device Mapping is the assignment of physical hardware components to the software logical control. The
software has a capacity for controlling many devices and the mapping system enables the software to identify
each specific device. When a device is mapped, it is given a unique 'Element' number. Any software control
(reading/writing) of this number will be applicable only to the mapped device.

9.2 Device Mapping Dialog Box

The device types available are 'Inputs', 'Outputs', 'Sensors' and 'Motors'. Each device type has its own page
within the dialog box and the pages can be made active by clicking the corresponding tabs at the top of the
window. Each page is controlled in the same way, the only difference being the available device types available
for mapping.

Mapped
This area lists the currently mapped devices.

Unmapped
This area lists the available devices currently unmapped.

Map
Once a device has been selected from the 'Unmapped' list, this button will cause the 'Mapping' dialog box to
open.

UnMap
Once a device has been selected from the 'Mapped' list, this button will unmap the device.

9.3 Mapping Dialog Box

This dialog box is where the element number is selected to be assigned to the chosen device.

Map Device
This is the description of the device selected for mapping.

Element
This is the particular part of the selected device i.e. One device may have several inputs.

To element

This is the number to be assigned to the selected device. The drop-down input box will be blank if no devices
have been mapped. If there has been devices already mapped, the default option will be the next free number. In
this case, the drop-down menu will also show all free numbers available lower than the previously mapped
element number.
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9.4 Map a device
1. Select the device to be mapped by clicking the device name from the 'Unmapped' list.
2. Click the 'Map' button.
3. Another small dialog box will now appear.
4. In the 'To element' drop-down box, type the element number to be mapped against the chosen device.
If a previous device has been mapped, the next free element number will be a default option. The drop-

down menu also contains all available element numbers lower than the last number to be mapped.

5. Press the 'OK' button.

6. The device should now be listed as mapped.
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10 Procal Programming Language

10-1






10.1 Programming with Procal

PROCAL is a simple metrologically orientated programming language. It provides the user with a high level of
flexibility in the solution of measurement problems. Utilising 'Keywords' of plain English, programs can be
written which will produce measurement results and classification for potentially hundreds of part types.

10.2 Definition of Terms

Language Translator The translator which interprets a PROCAL program when it is being executed.
Keyword A group of characters recognised by the language translator.

Parameter A value, enclosed within brackets which qualifies the keyword.

Parameter type Parameters exist in three types; NUMERIC, STRING, EXPRESSION.
NUMERIC type A group of numeric characters e.g. 10, 10.505, 0.010 ( .010 not acceptable).
STRING type A group of alpha-numeric characters e.g. ABC, AB1CD2

EXPRESSION type A group of alpha-numeric characters which represent an algebraic function e.g.

1.5+ 10.5 * (F[1]+F[2D).
Note : The example shows two pre-defined registers F[1] and F[2]

Delimiter A delimiter is a character which begins, separates, or terminates a series of
parameters. Only three delimiters are used, a left hand bracket '(' begins a series
of parameters, a comma ',' separates parameters and a right hand bracket ')’
terminates the series.

Syntax Composition of keywords, parameters and delimiters.

Instruction or command A complete program line which is syntactically correct that will instruct or
command the translator to perform a particular action.

Executing a program Causing the translator to become active and to act upon a selected program.

10.3 Language Syntax

The syntax of PROCAL is simple. It adopts the following constructs :
<Keyword> A keyword followed by no parameters.
<Keyword (P,,P, ,......,P,)> A keyword followed by (n) parameters.

Parameters must be enclosed within brackets and should be delimited by commas.

Comments are permitted in a program, and these are enclosed within curly brackets { }.

e.g. {This is a comment}

Comments permit the programmer to add text to the program which explains its operation, but is not acted upon
by the translator.

Note :
Within this text, optional parameters are shown enclosed within square brackets e.g. [,parameter,parameter].
All examples use mm unless otherwise specified.

10.4 Program structure and control environment

A PROCAL program will consist of several lines (sometimes hundreds) of instructions which are acceptable to
the PROCAL translator. When the program is being executed, the translator reads the keywords and issues
appropriate instructions to the system.
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10.5 Basic form of a Procal program

In its simplest form the program will consist of lines of instructions which will be executed by the translator,
starting at the first line and finishing on the last line.

The PROCAL instructions appear in the program in a specific order :
Assignment
Data input (from measurement devices)
Computation

Failure to observe this ordering could cause the program to produce unpredictable results. For instance, it would
not be sensible to perform computation before either the assignment and data input instructions had been
executed, since the measurement system would not be set up and the data registers would have nothing in them.
Like all programming languages, PROCAL allows the programmer to use the instructions in any way desired,
but as a general rule the ordering should be as follows :

Assignment

Input

Computational

Output

These instructions may be used with operator prompts, messages, etc and at a more advanced level, conditional
and branching commands.

Note :
Line numbers are never displayed in a program, but can be determined by referring to the cursor position shown
at the bottom right hand corner of the editor window.

10.6 Control environment

When a simple PROCAL program is executed, it runs within a Control Environment. The control environment
is responsible for :

Starting a program

Stopping a program

Classifying results

Displaying results

Updating statistics

When running simple programs, these functions are carried out automatically without intervention by the
PROCAL programmer.

The Control Environment is activated when the system is being used in the following MODES :
Calibration
Measurement

These modes are internally referred to by the OPERATING CODES (1 or 2). The following codes are assigned

Calibration -1
Measurement -2
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10.7 Operating Codes

Even in a simple measurement program it may be necessary for some instructions to be used during calibration
only, and further instructions during measurement only. Certain instructions permit this distinction by the use of
a parameter which is given a value (0, 1 or 2).

Example 1.

Prompt(THIS WILL APPEAR DURING CALIBRATION & MEASUREMENT, 0)

Will cause the prompt :

THIS WILL APPEAR DURING CALIBRATION & MEASUREMENT
To appear during :

Calibration

Measurement

Example 2.
Prompt(THIS WILL APPEAR DURING CALIBRATION ., 1)

Will cause the prompt :

THIS WILL APPEAR DURING CALIBRATION
To appear during :

Calibration

Example3.
Prompt(THIS WILL APPEAR DURING MEASUREMENT, 2)

Will cause the prompt :

THIS WILL APPEAR DURING MEASUREMENT
To appear during :

Measurement

In more advanced programs the MODE register can be utilised to permit a PROCAL program to CONTROL
every aspect of measurement, instead of relying upon the control environment to perform this function for it.
In this sense, the operating code (as a parameter) becomes redundant. However, the choice of usage is up to the
programmer.

It should be clear from the above that the PROCAL program can be constructed so as to perform different
functions, depending on the MODE it is being operated in. In other words, a PROCAL program can effectively
be TWO programs in ONE. One which is active during calibration, the other active in Measurement.

As a general rule, programs created for non-contact gauging systems will not have a calibration component,
since this operation is carried out by a 'one off' calibration program.

Note : The operating code parameter is now optional on many PROCAL instructions and can be omitted
altogether when programming PROFILE systems. When operating code is not included, the system will default
to a value of 0 which indicates active in all cases.

10.8 Co-ordinate Data Structure

Irrespective of the hardware configuration, as a general principle, data is collected by scanning the component
with a number of transducers. The data gathered from these, is recorded as points from the surface of the
component and are stored in the XY co-ordinate data structure.

In this way, an accurate representation of all or part of the component can be stored for later analysis using the
computational functions.

10-4



Basic Profile Measurement Technique :
SCAN COMPONENT

/

(]

[ s

CONVERT TO CO-ORDINATES

.

STORE IN DATA STRUCTURE

T

PERFORM MEASUREMENT

10.9  Procal Registers

Registers are used to store measurement and measurement support data. These are made available to the
programmer for manipulation and output to appropriate devices. There are a large number of registers, a few
registers are listed below with simple examples of their usage.

NUMERIC REGISTERS
D Diameter type
EX Edge type
A Angle type
F Function type
M Measurement type
E External measurement type
NOM NOMinal size of a special dimension
USL Upper specified limit (entered)
LSL Lower specified limit (entered)
uUSL! Upper specified limit (computed)
LSL' Lower specified limit (computed)
MODE Operating mode



TEXT REGISTERS

LAB LABel of a specified dimension
DESC DESCeription of a specified dimension
TEXT TEXT entered by user during program execution

All registers except MODE are accessed individually using an INDEX number enclosed within square brackets
i.e [i] where i is an integer number between 1 and the limit of the system (see language reference).

The following examples should illustrate how the registers are accessed.
The DIAMETER registers are used to hold diameter information after the computational FIND instruction has

been executed.
They are accessed as follows :

D[1] - value of diameter 1
D[2] - value of diameter 2
D[n] - value of diameter n

The EDGE registers hold the position of edges found from the co-ordinate representation of the component, and
lengths can be calculated by computing the difference between them.

EX[1] - X position of edge 1

EX][2] - X position of edge 2

EX[n] - X positions of edge n
Example :

Compute:Meas(1,EX[2]-EX[1])
Here the length is computed by subtracting edge position 1 from edge position 2. The result is placed into
measurement register M[1].

The MEASUREMENT registers store the actual results of the previous manipulations, however, it may be
useful to manipulate these. These are accessed in a similar fashion.

M[1] - measurement of dimension 1
M][2] - measurement of dimension 2
M|n] - measurement of dimension n

The EXTERNAL registers are used to store measurements which have been recorded by external devices and
transferred to the TML system by serial or other communication interfaces.

E[1] - external measurement 1
E[2] - external measurement 2
E[n] - external measurement n

These registers MUST be assigned to a measurement register before they can be acted upon by the system.

Example.
Compute:Meas(1, E[1])

All of the numeric type registers can be manipulated using COMPUTE: instructions.

TEXT
The text registers are accessed using the 'square bracket' notation but cannot be manipulated like numeric
registers. These registers would normally be used during formatted output to devices such as printers, disks, etc.
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The MODE Register

The MODE register is a special register which contains the value (1 or 2) as the current operating mode of the
system.

The MODE register does not use the 'square bracket' notation and is generally used in CONDITIONAL
EXPRESSIONS.

Note : The MODE register is included here for completeness, but normally programs generated for non-contact
measurement will not need to use it.

10.10 Types of Procal Instructions

The PROCAL translator will respond to a large number of keywords. A keyword PLUS its associated
parameters form a single instruction which can be acted on by the translator.
The types of instruction are :
1. Interactive
Assignment
Input
Computational
Output
Branching
Conditional
Looping

e A O

1. Interactive The interactive group of words enable the programmer to
issue instructions that will interact with the operator
during a measurement sequence.

. Assignment Assignment keywords provide a means of setting up
measurement support, such as nominals, tolerances etc.
These are used BEFORE data is read into the system.

3. Input These words control the input of data from measurement
centres such as the Profile. These words must be called
before computation can take place.

4. Computational After data has been logged, a series of computational
keywords may be used to perform manipulations upon it.
The result of the computation is placed in a unique
measurement register, ready for display by the system.

5. Output These instructions permit user defined output to specified
'devices' and may include formatted files for reading by
other analysis software e.g. Spreadsheets.

6. Branching These instructions permit advanced programming, which
may be included to control all aspects of a gauging
sequence.

7. Conditional These instructions permit advanced programming, which
may be included to control all aspects of a gauging
sequence.

8. Looping These instructions permit advanced programming, which
may be included to control all aspects of a gauging
sequence.

[\
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10.11 Assignment Instructions

Assignment instructions enable the user to set up measurement support data to values which are appropriate to
each measurement problem.

To make the programmers life easier PROCAL will apply DEFAULT values whenever possible. Hence certain
instructions do not have to be included in the program for it to function correctly.

Generally, in the interests of speed, an assignment instruction is executed ONCE only by the translator.
Assignment Instructions include :

Units:All

Define:Meas

Format:Numeric(Characteristic, Mantissa)

Define:Zone

10.12 Interactive Instructions

These instructions enable the program to communicate with the operator by displaying instruction messages on
the VDU or by acting upon responses from the operator via the keyboard.

Interactive instructions include :

Prompt

Wait:Key

Wait:lnput

10.13 Input Instructions

The input instruction can be divided into two groups :
e  Profile Scanning
e Data Input

PROFILE SCANNING

Profile scanning is the primary method of inputting data via the software, and this group includes instructions
for controlling the movement of the measurement centre.

The instructions include :

Datum
Move:AbsXY
Move:RelXY

Define:X Origin

Scan:X

DATA INPUT

This group of instructions control data logging from the specified devices. The device input keywords have a
generic format.

i.e. Read:device (p1,p2,....,pn)

The instructions include :

Read:Keyboard

Read:Input
Read:Sensors

It is important to note that some of these devices require other instructions to be executed prior to being used
themselves.
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10.14 Computational Instructions

The computational instructions are used to assign the result of a computation to an appropriate data register.
Computation involves the evaluation of a valid EXPRESSION.

Components of an Expression

An expression is a string of characters made up of the following components :
Mathematical operators

Logical (binary) operators

Mathematical functions

Numerical Constants

Numerical data registers

MATHEMATICAL OPERATORS CONSIST OF :

+ (Plus)
- (Minus)
* (Multiply)
/ (divide)
" (Power)
O) (Parenthesis)
BINARY OPERATORS ARE :
BAND (Binary AND)
BOR (Binary OR)
BXOR (Binary eXclusive OR)

MATHEMATICAL FUNCTIONS AVAILABLE ARE :

SQRT (square root)

ABS (absolute)

SIN (sine)

COS (cosine)

TAN (tangent)

ASIN (arc sine)

ACOS (arc cosine)

ATAN (arc tangent)

DEG (converts to degrees)

RAD (converts to radians)

INT (returns the integer part of a float)
RDM (returns a pseudo random number)

Note : The trigonometric functions operate in degrees.

NUMERICAL CONSTANTS
A numerical constant is simply a string of characters which can be evaluated to a single numerical value.
Example.

0 (zero)

1.5 (one point five)

99 (ninety nine)

8.725 (eight point seven two five)

NUMERICAL DATA REGISTERS

Example.
M]5] (measurement register five)
NOM]2] (nominal register two)
LSL[16] (lower specified limit register sixteen)
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USL'[3] (computed upper specified limit register three)

COMBINING THE COMPONENTS TO MAKE A VALID EXPRESSION

The components of an expression MUST be combined in such a way so as to yield a valid expression. Don't
worry too much as the PROCAL editor will check ALL expressions as they are entered and will report an error
if they are not acceptable.

The evaluation of an expression however complex will ALWAYS yield a single result.

Example.
1+2 Result =3
SQRT(4) Result =2
M[3] + M[16] Result = result of measurement 3 + result of

measurement 16

The result will be placed into a data register as defined by the COMPUTE: word being used.
A number of valid expressions follow :

Example 1.
EX[4]-EX[1]
Here the result will be the difference between the position of edge 4 and edge 1.

Example 2.
(F[1]+F[3])/ 2 + 0.7 * F[2]

This example illustrates the ORDER in which the components of an expression are evaluated.
Step 1 : F[1]+F[3]
Contents of parenthesis first F[1]+F[3] to yield an intermediate result R1
Step 2 : R1/2
The result of step 1 is divided by 2 to yield R2
Step 3 : 0.7*F[2]
The procedure of the multiply operator '*' is greater than that of the plus operator '+' so this item is calculated
next to yield R3.
Step 4 : R2+R3
Lastly the remaining intermediate results are ADDED together to yield the final value.
As a general rule, simply follow normal algebraic practice when constructing an expression.

Example 3.
This example shows how mathematical functions are used. The syntax to be observed is :
function(value)
where the function is any one of those given above, followed by a value which MUST be enclosed within
brackets. The value can be any valid expression.

SQRT (M[1]1"2+M[2]2)

Here the result is evaluated to the square root of the sum of the squares of measurement 1 and measurement 2.
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10.15 Using the FIND command

Having defined the measurement zones the appropriate feature can now be found. The FIND instruction is used
for this purpose.
Find(Register,Feature,Zone 1,[,Zone 2, Zone n])

Register The number of the register into which the measured value of FEATURE will be
placed.

Feature The feature to be found.

Zone The number of the zone where the feature is to be found, (more than one zone may
be specified for certain features).

ACTION Performs a measurement within the specified zones and places the result in the
specified register. The feature can be user defined or one those listed in the Keyword
reference.

Using the example in the Measurement Zones page, we would 'find' the features as follows :

Find(1,dia,1) Places the measured diameter in D[1]
Find(1,edge,2) Places the position of edge in zone 2 in EX[1]
Find(2,edge,3) Places the position of edge in zone 3 in EX[2]

Now that the values of each feature are stored in an appropriate register, they can be manipulated as required or
prepared for output using the COMPUTE instructions.

10.16 Measurement Zones

A measurement zone acts on the co-ordinate data structure and forms a bounded area, within which a feature of interest
exists.

+15 4

+10 /

+5 —

=10

'15 T T T T T T
0 10 20 30 40 50 60

The diagram shows three zones, and features of interest are :
ZONE 1 - a diameter
ZONE 2 - an edge
ZONE 3 - a second edge

For a zone to have any affect in a PROCAL program, the limits of the zone must be defined using the instruction :
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Define:Zone(number[, X(MIN).X(MAX),Y(MIN).Y(MAX)])

From the diagram, zones 1 to 3 would be defined as follows :
Define:Zone(1.10.15,-5.5)
Define:Zone(2,25,35.5.15)
Define:Zone(3,45,55,0,5)

After a zone has been defined, the relevant feature within that zone can be found using the FIND instruction.

10.17 Preparing Measurements for Output

Measurements are not available for classification, display, or output to 'devices' such as the printer unless they
have been placed in a measurement (M[]) register. This action is performed by the following :

Compute:Meas

10.18 Output Instructions

A number of OUTPUT words are provided and these instructions permit flexible output to the following
'devices'.

PRINTER (centronics port)

FILE (filename defined by user)

OUTPUTTING TO A DEVICE
Outputting data to any of the named devices requires the following instructional sequence:

Open:(device)
Write: (1st WRITE instruction)
Write: (2nd WRITE instruction)

"
"

1"

Write: (nth WRITE instruction)
Close:(device)

Note : A device must be open before it can be written to and must be CLOSED after writing is over.
Example 1.

Open:Printer

Write: Time

Write:Date

Write: Text(This is some Text)
Write: Text(This is some more text)
Close:Printer

This program segment would cause the following to be printed (assume Time=12:00:00-and Date= 01/01/99) :
12:00:00
01/01/99
This is some Text
This is some more Text

Any of the devices can be OPENED, indeed ALL devices can be OPENED simultaneously.

Example 2.
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Open:Printer

Open:File(MYFILE)

Write:Time

Write:Date

Write: Text(This is some Text)
Write: Text(This is some more Text)
Close:Printer

Close:File(MYFILE)

This would cause the output shown in Example 1 to be despatched to BOTH devices i.e.
- the printer
- a FILE named as MYFILE

10.19 Customised Reports to the Printer

The example programs shown below show how to use the PROCAL "Write' keywords to customise reports to
the printer.
Example 1.

Read:Keyboard(1,1,0,NEW BATCH? 1=YES 0=NO,1.0)

If(E[1]=1) {If new batch started enter new details)

Text Input(1,20,Customer:)

Text Input(2,10,Batch No. :)
{******************************START OF

Open:Printer
Write:TeXt(***********************************)

Write: Text(* YOURNAME MANUFACTURING COMPANY *)
Write:’rext(***********************************)
Write: Text( )

Write: Text( )

Write: Text( Part NUMBER: AA123-001)

Write: Text( )

Write: Text( )

Write:Field(1)

Write:Field(2)

Write: Text( )

Write: Text( )

Write: Text( )

Write: Text( )

Close:Printer

End:If

{}
{}
{}
{PROCAL Instructions to gauge component go here }
{}
{}
{}

{Write all dimension data}
Open:Printer
Write:Dimension_All(1,4)
Write: Text( )
Write: Text( )
Close:Printer
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Notes :

The HEADER text is printed dependant on the entry made by the operator. This is controlled by the value

entered (1 or 0) and is tested by the conditional IF statement (See Conditional Instructions).

- When E[1] =1

Both TEXT INPUT instructions and all of the 'header text' instructions will be executed. The results

can be seen on the first few lines of the printout.

The Customer name and Batch No. were entered into text fields 1 and 2 using the TEXT INPUT
instructions. These fields were then output to the printer using the'Write:Field' instructions.

- When E[1] = 0 (this is the default entry)
The dimensional data is written to the printer.

The spacing in the printout is achieved using a "Write: Text' command, outputting a single space character

i.e. Write: Text()

The example above will produce the following output

o o o o o o o o e o o o o o o o o o o

+ YOURNAME MANUFACTURING COMPANY  #
LR e e e T
PART NUMBER : AA123-001

Customer: The Maotor Company
Bstch No. : 100074

Description Actual Deviation
D01 -@ Average 1 5.043 0.048
D02 - @ Average 2 15.075 -0.025
D03 -@ Average 3 25.034 0.034
Description Actual Deviation
D01 -@ Average 1 5.048 0.048
D02 -@ Awverage 2 15.075 -0.025
D03 -@ Average 3 25.034 0.034
Description Actual Dewviation
DO1 -@ Awverage 1 5.048 0.048
D02 -@ Average 2 15.075 -0.025
D03 -@ Average 3 26.034 0.034

usL
5.100
15.200
25.100

uUSsL
5.100
15.200
25,100

usL
5.100
15.200
26.100

LSL

4.900
15.000
24.900

LSL

4.900
15.000
24.900

LSL

4.900
15.000
24.900

Class
PASS
PASS
PASS

Class
PASS
PASS
PASS

Class
PASS
PASS
PASS
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Example 2.

Read:Keyboard(1,1,0,NEW BATCH? 1=YES 0=NO,1,0)
If(E[1]=1) {If new batch started enter new details}
Text Input(1,20,Customer:)

Text Input(2,10,Batch No. :)

sk sk sk sk sk sk sk sk sk ok sk sk ok skosk ok ok sk skoskok sk skoskok sk skskok koskskok k)
HEADER }

Open:Printer
Write:TeXt(**********************************)

Write: Text(* YOURNAME MANUFACTURING COMPANY *)
Write:TeXt(**********************************)
Write:Text( )

Write: Text( )

Write: Text( Part NUMBER: AA123-001)

Write: Text( )

Write: Text( )

Write:Field(1)

Write:Field(2)

Write: Text( )

Write: Text( )

Write: Text( )

Write: Text( )

Close:Printer

End:If

{)

{)

{}

{PROCAL Instructions to gauge component go here }
{}

{}

{}

Text _Input(3,6,Serial no.)

{Write serial number & all dimension data}
Open:Printer

Write:Field(3)

Write: Text( )

Write:Dimension_All(1,4)

Write: Text( )

Write: Text( )

Close:Printer
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This will produce the following report :

oo o o o o o o o o i o g o o o

* YOURNAME MANUFACTURING COMPANY  #

E A o o R o o o o o o

PART NUMBER : A54321/B

Customer: The Motor Company
Batch MNo.: 1870-B

Serial no. : B-1001

Description ' Actual Deviation UsL LSL Class
D01 -@ Average £.048 0.048 5.100 4.900 PASS
D02 -@ Average 2 15.075 -0.025 15.200 15.000 PASS
D03 -@ Average 3 25.034 0.034 25.100 24.900 PASS

Serial no. : B-1002

Description Actual Deviation UsL LSL Class
D01 -3 Average 1 5.048 0.048 5.100 4,900 PASS
D02 - & Average 2 15.075 -0.025 15.200 15.000 PASS
D03 -@ Average 3 25.034 0.034 25,100 24.900 PASS

Serial no. : B-1003

Description Actual Dewviation usL LSL Class
D01 -& Average 1 5.048 0.048 5.100 4.900 PASS
D02 -&@ Average 2 15.075 -0.025 15.200 15.000 PASS
D03 -@ Awverage 3 25.034 0.034 26.100 24.800 PASS

10.20 Archiving to a File

Archive data can be stored on the hard disk using the following instructions :

Open:File
Close:File

All the generic 'Write' instructions may be used with these instructions enabling customised output to a
specified filename.

Note : The file will be placed in the USERDATA folder by default. All data written to a file is APPENDED to

previous data already present in the file or written to a new file depending upon the Open:File parameters (i.e.
1=append, 2=new file).
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Example 1.

Read:Keyboard(1,1,0,NEW BATCH? 1=YES 0=NO,1,0)
IF(E[1]=1) {If new batch started write header to file}
Open:File(b1814_01.DAT,2) {open as new file}

Write: Text(YOURNAME MANUFACTURING COMPANY)
Write: Text( )

Write: Text(PART NUMBER: B1814-01)

Write: Text(CUSTOMER: THE MOTOR CO.)

Write: Text( )

Write: Text( )

Close:File(B1814 01.DAT)

End:If

{)

{}

{3

{PROCAL Instructions to gauge component}
{3
{}
{}
{Write sample number & all dimensional data}
Open:File(B1814_01.dat,1) {open for appending}
Write:Sample Size

Write: Text( )
Close:File(B1814 1.DAT)

In this example the data would appear as follows :

YOURNAME MANUFACTURING COMPANY

PART NUMBER : B1814-01
Customer: The Motar Company

1

Description Actual Deviation USL LsL Class
D01 -@ Average 1 5.048 0.048 5.100 4.900 PASS
D02 - @ Average 2 15.075 -0.025 15.200 15.000 PASS
D03 -@ Awverage 3 25.034 0.034 25.100 24.800 PASS
2

Description Actual - Deviation usL - LSL Class
D01 -@ Average 1 5.048 0.048 5.100 4.900 PASS
D02 -& Average 2 15.075 -0.025 15.200 15.000 PASS
D03 -@ Average 3 25.034 0.034 25100 24.900 PASS

File:B1814_01 DAT

The contents of ANY ASCII file can be examined using the Pro-Measure EDITOR.
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10.21 Writing Data to a Serial Port

Writing ASCII data to a specified serial port is easy when using the output instructions. However it is assumed
that the programmer already has an understanding of serial interfacing and will set the port parameters to values
appropriate for the device to which the port is connected to.

The serial ports can be controlled using the following instructions :

Define:10_Serial

Open:Serial
Close:Serial

Example.

Text_Input(1,20, Customer:)
Text_Input(2,10, Batch No.:)
Define:10_Serial(1,8.1,7,1,0)

{)

{3

{PROCAL Instructions to gauge component }
{}

{)

Open:Serial(1)

{Start of the Header}
Write: Text(Part Number : SM1972.1)
Write:Field(1)
Write:Field(2)

Write: Text()

Write: Text( )

{Start of component data}
Write:Sample Size
Write:Dimension(1,4)
Write: Text( )

Close:Serial

10.22 Branching Instructions

Branching Instructions cause the program to depart from the single linear sequence, which is the 'normal' way a
program is translated. These conditional instructions cause the translator to skip whole sections of program or to
'jump' to a totally new context. The Keywords used are :

Goto

Mark

Gosub

Begin:Sub

End:Sub

Example.

1"

"

Goto(Jumpl)
Compute:Meas(1,E[1])

"

"

Mark(Jumpl)
Compute:Meas(2,D[1])
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Execution of this program segment will cause the translator to bypass the instruction:
Compute:Meas(1,E[1])

Note : The point in a program to which a 'Goto' is to be made is marked with a name of up to 30 characters. The
name chosen would normally reflect the usage e.g.

Mark(Error Handler)

Mark(Measure)

Mark(Printout)

10.23 Subroutines

Subroutines are useful constructs that permit whole sections of instructions to be grouped together. Although
subroutines are not always suitable in a particular application, there are certain advantages to be gained by their
usage :
e  Frequently used program segments are written ONCE only and then 'called’ with a SINGLE
instruction.
e Assignment instructions within a subroutine are executed once only, making overall program
execution faster.
e  Programs containing subroutines can be more structured and easier to understand.

The keywords which support subroutines are :
Gosub

Begin:Sub
End:Sub

Example.

"

1"

Gosub(Measure)

"

1"

Begin:Sub(AssignData)

{PROCAL Instruction to gauge component}

"

End:Sub

Notes :

A subroutine can appear anywhere in a program.

Instructions contained in a subroutine are ignored by the translator until the routine is called by a GOSUB
instruction.
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10.24 Conditional Instructions

The conditional instructions allow a program to make DECISIONS and to modify its behavior accordingly.
Three instructions form the basis of conditional statements but all three need not be used in a given instance.
These instructions are :

If

Else

End:If

THE CONDITIONAL EXPRESSION
The 'If' instruction acts upon a CONDITIONAL EXPRESSION and will evaluate it as:

TRUE (non-zero)

or
FALSE (zero)
The conditional OPERATORS permitted are:
= Equal
< Less than
<= Less than or equal to
> Greater than
>= Greater than or equal to
1= Not equal
AND Logical AND
OR Logical OR

A CONDITIONAL EXPRESSION contains three parts :

(EXPRESSION 1) (CONDITIONAL OPERATOR) (EXPRESSION 2)
These three components form a complete conditional expression which is evaluated by the PROCAL translator
as TRUE or FALSE.

Example.

Conditional Expression Result

=1 True

(2+3)<5 False

2/2>=4 True

M[1],(NOM[1]-0.5) ? - depends on register value

E[1]>(NOM[1]+USL[1]) ? - depends on register value
Example 1.

IfM[1]1>(NOM[ 1]+USL[1]+0.5),0versize)

"

1"

Goto(End)

Mark(Oversize)
Display:Message(Component Oversize)
Wait: Time(5)

"

"
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Example 2.

"

"

MARK(keyboardInput)
READ:KEYBOARD(1,100,0, Enter Digitcal Reading)
If(E[1]=0, Input Error)
COMPUTE:MEAS(1,E[1])

GOTO(Input OK)

MARK(Input Error)

DISPLAY:MESSAGE(Zero value NOT permitted)
WAIT:TIME(5)

CLEAR:MESSAGE

GOTO(Keyboard Input)

MARK(Input OK)

1"

"

Example 3.
This is the same as Example 2. The equivalent program segment is neater and takes less instructions.

Mark(Keyboard Input)

Read:Keyboard(1,100,0, Enter DIGITCAL Reading,2)
If (E[1]=0)

Display:Message(Zero value NOT permitted)

Wait: Time(5)

Clear:Message

Goto(Keyboard Input)

End:If

"
"

1"

10.25 Looping Instructions

These instructions provide a means of REPEATing a series of commands UNTIL a condition is met.
The looping keywords include:

Repeat
Until

Example 1.

"
1"

"

Compute:Func(1,0)

Repeat
Compute:Func(1,F[1]+1)
Until(F[1]=100)

"

"
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This example uses F[1] as the loop counter. The first 'Compute:Func' sets F[1] to zero. The second (enclosed
within the 'Repeat-Until' loop) increments the register every loop.

Note : The Until instruction acts on a CONDITIONAL EXPRESSION and will loop to the 'Repeat’ command
until the condition is TRUE.

Example 2.

"

"

Compute:Func(1,0)

Compute:Func(2,0)

Repeat

Read:Keyboard(1,50,-1, Enter Reading, 2)
Compute:Func(1, F[1]+E[1])
Compute:Func(2, F[2]+1)

Until (E[1]<0)

{Subtract last E[1] from sum of readings}
Compute:Func(1,F[1]-E[1])
Compute:Func(2,F[2]-1)
Compute:Meas(1,F[1]/F[2])

"

1"

Here successive readings may be entered from the keyboard UNTIL a negative value is entered. The average
reading is then calculated by the 'Compute:Meas' instruction.
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10.26 Program Example - Lengths and Diameters

The following example illustrates how a PROCAL program is written. The part to be measured is as shown. The
program must measure three diameters (D1, D2, and D3) and a length (L1) with the results output to a printer as
well as to the VDU.

15 20 . 20
L1
f
[
!
cu —] J— - 1 (7]
B2 2 |2
]
) §
1
A suitable program is :-
Units:All("mm" program is in mm's
Format:Numeric(3,3) 3 digits before/after the decimal point
{*** DIAMETER 1**%*} remark statement
Define:Meas(D1,"Diameter 1",10,0.1,- assigns label, description, nominal, tolerances and
0.1,1) class type to measurement
Define:Zone(1,10,15,-15,15) defines measuring zone
Call(Step,0.1) defines X-axis step as 0.1lmm
Call(Dia, 1, M[D1]) measures a diameter in zone no.1 and stores the
value in measurement register M[D1]
Compute:Meas(D1,M[D1]) outputs 1st measurement D1
{*¥* EDGE 1 ***}
Define:Zone(1,17.25,22,0,15) ,
Call(Step,0.01) defines X-axis step as 0.01lmm
Call(Edge,1,EX[1]) measures an edge in zone no.1 and stores the value
in edge register EX[1]
{*** DIAMETER 2%**}
Define:Meas(D2,"Diameter 2",20,0.1,-
0.1,1)
Define:Zone(1,27.5,32.5,-15,15)
Call(Step,0.1)
Call(Dia,1,M[D2]) measures a diameter in zone no.1 and stores the
value in measurement register M[D2]
Compute:Meas(D2,M[D2]) outputs 2nd measurement D2

Define:Zone(1,37.5,42.5,0.15)
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Call(Step,0.1)
Call(EDGE,1,EX[2])

{*** LENGTH 1 ***}
Define:Meas(L1,"Length 1",20,0.25.-
0.25,1)
Compute:Meas(L1,ABS(EX[2]-EX[1]))

{*** DIAMETER 3 ***}
Detine:Meas(D3,"Diameter 3",15,0.1,-
0.1,1)

Detine:Zone(1,50,55,-15,15)
Call(Step,0.05)

Call(Dia, 1,M[D3])
Compute:Meas(D3,M[D3])
Open:Printer

Write:Dimension All(1,4)

Close:Printer

measures an edge in zone no.1 and stores the value
in edge register EX[2]

outputs 3rd measurement L1 as the length between
edges EX[2] and EX[1]

outputs 4th measurement D3

opens printer as an output device

sends all the information on measurements 1-4 to the
printer

closes the printer

The measurement zones are defined as shown.

Y A ZONE ZONE ZONE ZONE - ZONE

1 2 4 5
15 1
F1r1 1 [ 1
10 . o
N 11| |
> 11 | N |
| 1] | [ || |
0 o T d0 T3 &  s=p 1di 70 >
-5 — | |
-10 —— | ! L
el Lo L L]
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10.27 Program Example - Thread Measurement

An example program is as follows :-

Define:Meas(ED1,"Effective Diameter",... assigns label, description, nominal, tolerances, class
type to measurements

Define:Meas(P1,"Pitch",...

Define:Meas(D1,"Major Diameter",...

Define:Meas(D2,"Minor Diameter",...

Define:Meas(A1,"Leading Flank Ang",...

Define:Meas(A2,"Following Flank Ang",...

Define:Zone(1,,,-15,15) defines measuring zone

Call(Step,0.005) defines X-axis step as 0.005mm

Call(Thread:Helix,1) measures thread to calculate helix angle, and aligns
slide

Call(Thread:R,1,M[ED1],M[P1],M[DI1],M[ Measures the thread in zone 1 and stores the values

D2]1.M[A1],M[A2]) in the measurement registers M[label]

Compute:Meas(ED1,M[ED1]) outputs Effective Diameter

Compute:Meas(P1,M[P1]) outputs Pitch

Compute:Meas(D1,M[D1]) outputs Major Diameter

Compute:Meas(D2,M[D2]) outputs Minor Diameter

Compute:Meas(A1,M[A1]) outputs lead Flank Angle

Compute:Meas(A2,M[A2]) outputs Following Flank Angle

Helix:Abs(0) Returns the slide to datum position

Note : As an alternative to the above program, 'Thread:Helix' can be replaced by 'Helix:Abs(Angle)' to specify
the angle required. This will improve the cycle time.

10.28 Program Example - Standards Database

The following Procal Program example is for a WHITWORTH TAPER THREADS Standards Database.

{ WHITWORTH DATABASE FOR TAPER THREADS - DIN 3858/BS 21 }
Define:Mode(2,2)
Units:All("Inch")

{ Defines Start of Database }
Begin:Standard("Whitworth",20032)

Std:Display(20078,10000) { Thread Pitch Diameter at X:Nominal}
Std:Display(20073,10000) { Thread Gauge Length:Nominal}
Std:Display(20061,10000) { Thread Pitch:Nominal }

Std:Apply(20033) { Thread:RH Taper }

{Define major diameters}

Begin:StdTable(20078,10000,20073,10000) { Pitch Diameter at X & Gauge Diameter }
Std:Nominal(0.2812,1)

Std:Nominal(0.3601,1)

Std:Nominal(0.4843,1)

Std:Nominal(0.6223,1)

Std:Nominal(0.7793,1)
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Std:Nominal(0.9952,1)
Std:Nominal(1.2508,1)
Std:Nominal(1.5918,1)
Std:Nominal(1.8238,1)
Std:Nominal(2.2888,1)
Std:Nominal(2.9018.1)
Std:Nominal(3.4018,1)
Std:Nominal(4.3918,1)
Std:Nominal(5.3918,1)
Std:Nominal(6.3918,1)
End:StdTable

{ Define DIA FOR GAUGE LENGTH Sizes }
Begin:StdTable(20073,10014)
Std:Nominal(0.2812,1)
Std:Nominal(0.3601,1)
Std:Nominal(0.4843,1)
Std:Nominal(0.6223,1)
Std:Nominal(0.7793,1)
Std:Nominal(0.9952,1)
Std:Nominal(1.2508,1)
Std:Nominal(1.5918,1)
Std:Nominal(1.8238,1)
Std:Nominal(2.2888,1)
Std:Nominal(2.9018,1)
Std:Nominal(3.4018,1)
Std:Nominal(4.3918,1)
Std:Nominal(5.3918,1)
Std:Nominal(6.3918,1)
End:StdTable

{ Define Pitch Sizes T.P.1.}
Begin:StdTable(20061,10000,20073,10000,1)
Std:Nominal(28,1)
Std:Nominal(28,1)
Std:Nominal(19,1)
Std:Nominal(19,1)
Std:Nominal(14,1)
Std:Nominal(14,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
End:StdTable

{ Define Crest Truncation Sizes }
Begin:StdTable(20075,10000)
Std:Nominal(0.0057,1)
Std:Nominal(0.0057,1)
Std:Nominal(0.0084,1)
Std:Nominal(0.0084,1)
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Std:Nominal(0.0114,1)
Std:Nominal(0.0114,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
End:StdTable

{ Define Root Truncation Sizes }
Begin:StdTable(20076,10000)

Std:Nominal(0.0057,1)
Std:Nominal(0.0057,1)
Std:Nominal(0.0084,1)
Std:Nominal(0.0084,1)
Std:Nominal(0.0114,1)
Std:Nominal(0.0114,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145.1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
End:StdTable

{ Define gauge length }

Begin:StdTable(20073,10000)

Std:Nominal(0.1575,1)
Std:Nominal(0.1575,2
Std:Nominal(0.2362,3)
Std:Nominal(0.2520,4)
Std:Nominal(0.3228.,5)
Std:Nominal(0.3740,6)
Std:Nominal(0.4094,7)
Std:Nominal(0.5,8)
Std:Nominal(0.5,9)
Std:Nominal(0.626,10)
Std:Nominal(0.689,11)
Std:Nominal(0.811,12)
Std:Nominal(1.0000,13)
Std:Nominal(1.126,14)
Std:Nominal(1.126,15)
End:StdTable

{ Define useful (thread) length }
Begin:StdTable(20074,10000)

Std:Nominal(0.2559,1)
Std:Nominal(0.2559,2)
Std:Nominal(0.3819,3)
Std:Nominal(0.3976.4)
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Std:Nominal(0.5197,5)
Std:Nominal(0.5709,6)
Std:Nominal(0.6614,7)
Std:Nominal(0.752,8)
Std:Nominal(0.752,9)
Std:Nominal(0.9213,10)
Std:Nominal(1.0512,11)
Std:Nominal(1.1732,12)
Std:Nominal(1.4094,13)
Std:Nominal(1.5787,14)
Std:Nominal(1.5787,15)
End:StdTable

{define left flank angle fixed at 30 degrees }
Begin:StdTable(20064,10000)
Std:Global(27.5,1.0,-1.0)

End:StdTable

{define right flank angle fixed at 30 degrees }
Begin:StdTable(20065,10000)
Std:Global(27.5,1.0,-1.0)

End:StdTable

{define Thread Taper fixed at 3.978 degrees }
Begin:StdTable(20072,10000)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
End:StdTable

{ Grade Tables }

Grade:Table(20073,10000,1)
Std:R_Grade("1/16",35.4331,-35.4331)
End:StdTable
Grade:Table(20073,10000,2)
End:StdTable
Grade:Table(20073,10000,3)
Std:R_Grade("1/4",51.1811,-51.1811)
End:StdTable
Grade:Table(20073,10000,4)
Std:R_Grade("3/8",51.1811,-51.1811)
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End:StdTable
Grade:Table(20073,10000.5)
Std:R_Grade("1/2",70.8661,-70.8661)
End:StdTable
Grade:Table(20073,10000,6)
Std:R_Grade("3/4",70.8661,-70.8661)
End:StdTable
Grade:Table(20073,10000,7)
Std:R_Grade("1",90.5512,-90.5512)
End:StdTable
Grade:Table(20073,10000,8)
Std:R_Grade("1 1/4",90.5512,-90.5512)
End:StdTable
Grade:Table(20073,10000,9)
Std:R_Grade("1 1/2",90.5512,-90.5512)
End:StdTable
Grade:Table(20073,10000,10)
Std:R_Grade("2",90.5512,-90.5512)
End:StdTable
Grade:Table(20073,10000,11)
Std:R_Grade("2 1/2",3500,-3500)
End:StdTable
Grade:Table(20073,10000,12)
Std:R_Grade("3",137.7953,-137.7953)
End:StdTable
Grade:Table(20073,10000,13)
Std:R_Grade("4",137.7953,-137.7953)
End:StdTable
Grade:Table(20073,10000,14)
Std:R_Grade("5",137.7953,-137.7953)
End:StdTable
Grade:Table(20073,10000,15)
Std:R_Grade("6",137.7953,-137.7953)
End:StdTable

Grade:Table(20074,10000.1)
End:StdTable
Grade:Table(20074,10000,2
Std:R_Grade("1/8".35.4331,-35.4331)
End:StdTable
Grade:Table(20074,10000,3)
Std:R_Grade("1/4",51.1811,-51.1811)
End:StdTable
Grade:Table(20074,10000,4)
Std:R_Grade("3/8",51.1811,-51.1811)
End:StdTable
Grade:Table(20074,10000,5)
Std:R_Grade("1/2",70.8661,-70.8661)
End:StdTable
Grade:Table(20074,10000,6)
Std:R_Grade("3/4",70.8661,-70.8661)
End:StdTable
Grade:Table(20074,10000,7)
Std:R_Grade("1",90.5512,-90.5512)
End:StdTable

Grade: Table(20074,10000,8)
Std:R_Grade("1 1/4",90.5512,-90.5512)
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End:StdTable
Grade:Table(20074,10000,9)
Std:R_Grade("1 1/2",90.5512,-90.5512)
End:StdTable
Grade:Table(20074,10000,10)
End:StdTable
Grade:Table(20074,10000,11)
Std:R_Grade("2 1/2",137.7953,-137.7953)
End:StdTable
Grade:Table(20074,10000,12)
Std:R_Grade("3",137.7953,-137.7953)
End:StdTable
Grade:Table(20074,10000,13)
Std:R_Grade("4",137.7953,-137.7953)
End:StdTable
Grade:Table(20074,10000,14)
Std:R_Grade("5",137.7953,-137.7953)
End:StdTable
Grade:Table(20074,10000,15)
Std:R_Grade("6",137.7953,-137.7953)
End:StdTable

End:Standard

10.29 Gageport Program Examples

Example 1:

The program will call the ‘Read Gageport — RGP’ subroutine to read from Port 1 of a Gageport. The Gageport
will be activated in ‘read immediate’ mode. The device connected to the Gageport is a B&S DigitCal (Gage
number 1), and the port has been mapped to ‘Sensor 1’

Include:Library

Units:All("mm™")

Format:Numeric(3,4)

Define:Meas(D01, Cal _Diameter, 12.800, 0.050, -0.050, 1, 0)
Set:Error_Text("D01 Cal Diameter [ DO1 - @ Cal]")
CALL("RGP", 1,0, "", E[64], 0)

Compute:Meas(D01, E[64])

Set:Error_Text( )

Example 2:
This program will read a transducer probe that has been calibrated. The probe has been mapped to Sensor
number 1, and has a factor of 0.001 set in the Gageport Setup screen (via the PluginManager).

Cal_Master.pcl
{This program calls a segment that contains calibration data from the probe. The file that contains }
{The calibration data 'CalData’ is called by the RCGP command and modifies the subsequent }

{Readings of the probe by adding the calibration data to the probe reading }

Include:Library
Include:Segment("Cal _Master")

Units:All

Format:Numeric(3,4)
Define:Meas(B01, Bore Diameter, 7.750, 0.050, -0.050, 1, 0)
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Set:Error_Text("B0O1 Bore Diameter [ BO1 —~ @ Bore]")

CALL("RCGP", 1, 2, CalData,"Press SPACE to capture probe reading", E[63], 0)
Compute:Meas(BO1, E[63])

Set:Error_Text( )

Cal Master.pcl

{ This segment is called from the program Diameter.pcl and takes a reading from the probe and }
{ then prompts for the Calibrated Bore diameter that it has just measured. The 'master }

{ diameter' value then has the probe reading subtracted from it and the result stored in the }

{ 'CalData’ file which is created in the Userdata directory }

CALL("RGP", 1, 2, "DiaTest = %4.0f Press SPACE to store", E[1], 0)
CALL("WCGP", CalData, "Enter Master Value", E[1])

10.30 Formatted Input/Output

INPUT
The format specifiers for input are :

? Any character

%f Floating point value

%d Integer value

%s String of characters.

\xx Hexadecimal value for ASCII code
Example.

Open:Serial(1)
Read:Format(%f ABC %d \0D, 5,1)
Close:Serial

This example will read in two values separated by ABC and terminated by a Carriage Return (OD Hex), The
first value can be any floating point value and the second any integer value.

OUTPUT
The format specifiers for output are :
%n.mf Floating point value (n=total numbers of digits, m=number of digits after the decimal point)
%nd Integer value (n=total number of digits)
%ns String (n=total number of characters)
%g Floating point value, same as %n.mf but with n.m values passed as set in the Numeric:Format
keyword.
%a String, same as %ns but with the string centre aligned.
Example.
Open:File(DATA.DAT)

Write:Format(NOMINAL of %s=%7.3f,0,LAB[1],NOM[1])
Close:File(DATA.DAT)

This will write the following to a file named DATA.DAT in the USERDATA folder.
NOMINAL of M01 = 100.000
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10.31 Ascii to Hex Conversion Table

00 NUL 300 60 "
01 SOH 311 6la
02 STX 322 62b
03 ETX 333 63 ¢
04 EOT 344 64d
05 ENQ 355 65e
06 ACK 366 66 f
07 BEL 377 67 g
08 BS 388 68 h
09 HT 399 69 i
0A NL 3A 6A j
0B VT 3B; 6B k
0C NP 3C< 6C1
0D CR 3D = 6D m
OE SO 3E> 6En
OF SI 3F 9 6F o
10 DLE 40 @ 70p
11 DC1 41 A 71q
12 DC2 42B 2t
13 DC3 43C 73's
14 DC4 44D 74 t
15 NAK 45E 75u
16 SYN 46 F 76 v
17 ETB 47G 77w
18 CAN 48 H 78 x
19 EM 491 79y
1A SUB 4A] TAz
1B ESC 4BK 7B {
ICFS 4CL 7C
1D GS 4D M 7D}
1E RS 4EN 7E ~
IF US 4F O 7F DEL
20 SP 50 P

21! 51Q

2" 52R

23 # 538

24§ 54T

25 % 55U

26 & 56 V

27" 57TW

28 ( 58 X

29) 59Y

2A * 5AZ

2B + 5B

2C, 5C\

2D - 5D ]

2E. SE A

2F / S5F _
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10.32 Error Trapping

PROCAL supports a large number of error messages which are designed to assist the user during the operation
of the software.

If an error occurs in the course of running a PROCAL program, a message will be displayed and the system will
be halted. It may be useful for a PROCAL program to TRAP certain errors and take alternative action.

The Trap:Error keyword is used for this purpose.

When an error is trapped, the normal error handling is bypassed i.e. the error message will NOT be displayed
and the system will not be halted. It is important therefore that the programmer ensures the program takes
appropriate action.

Example.
Trap:Error(1,51, PrinterError)
{1
{}
{1
{PROCAL Instructions to gauge component}
{}
{)
{}
Mark(Printout)
Open:Printer
Write: Text(This is some text)
Close:Printer
Goto(End)
Mark(PrinterError)
Display:Message("Printer Fault: Check paper etc")
Wait:Time(5)
Clear:Message
Goto:Printout
Mark(End)

Here the error being trapped is 'Cannont open Printer' i.e.
Error Type =1
Error Number = 51
Note : The 'Trap:Error' instruction is executed BEFORE the instructions that may cause the error are
encountered by the translator.
The program segment marked as : 'Printer:Error' will be executed IF and only IF the 'Printer:Timeout' error
occurs.
This segment will display a user defined error message for 5 seconds and then attempt to access the printer
again i.e.

Goto(Printout)

IMPORTANT :
More than one 'Trap:Error' command may be active at any one time.
An error trap may be switched OFF by executing the 'Trap:Error' instruction either WITHOUT a MARK to
GOTO or using a 'NULL' mark e.g.
Trap:Error(1,51)
Or
Trap:Error(1,51,)
Both switch OFF a previous 'Cannot open Printer' trap.

See Error Trapping Codes table for list of trappable errors.
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10.33 Program Debugging

In its simplest form, a PROCAL program can be written to perform successfully with the programmer
experiencing very few problems during its development. A complex program may be written, however, which
does not perform as the programmer intended AND is difficult to follow.

The Debug Menu commands provides some useful controls to assist in program debugging.

10.34 Breaking out of a Locked Program

With some of the more advanced commands it is possible for a PROCAL program to become LOCKED, e.g.

Repeat

Until(0)

Since the terminating condition in the 'Until' instruction is FALSE and does not change, this loop will NEVER
terminate.

Clearly a means of escaping this loop is required. The key combination ALT and F9 pressed simultaneously on
a keyboard will cause program execution to ABORT.

Notes :
Some instructions are impossible to escape from and the above will have no effect.
The escape facility will not always take effect immediately.

10.35 Rotational Measurement Option

The option consists of a motorised head stock with computer controlled spindle rotation and includes software
for the measurement of runout, straightness, concentricity, dimension across flats, deviation of diameter with
rotation, and the location of max and min radial features.

The additional NAME' functions available when this option is fitted are as follows:-

INDEX FRO: IF
CONC FRO: 2D
CONC: 1D RRO
CONC: 2D RRO: 1D
DIA: ROT RRO: 2D
STRA RAD: ZPOS
FRO FLAT

Plus the following additional PROCAL commands :-

ROTATE: ABS
ROTATE: REL
ROTATE: RESET
DRAW: R ZONE

Each one of these above measurement functions can be written manually by entering a sequence of instructions
using the editing functions. Alternatively, Pro-Composer programs can be modified to include these additional
rotation functions.
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10.36 Thread Measurement Option

This option consists of a computer controlled slew mechanism for automatic in cycle alignment of the thread
helix angle to a maximum of 5 degrees and includes software for the inspection of parallel vee form threads
with flank angles between 50-70 degrees to determine Major, Minor and Effective Diameter, Pitch and Flank
Angles.

The additional 'NAME' functions available when this option is fitted are as follows :-

CALL (THREAD:HELIX.zone.[angle])

CALL (THREAD:R.zone,[effective dia,pitch.major dia,minor dia,leading flank angle following flank angle])
CALL (THREAD:L.zone,[effective dia,pitch.major dia,minor dia,leading flank angle.following flank angle])
The additional PROCAL command is as follows :-

HELIX:ABS (angle)

Note : There are two methods of aligning the traverse mechanism to the required angle.

1. Use the HELIX:ABS in the measurement program to specify the required angle i.e. HELIX:ABS (2.5)

2. Use the THREAD:HELIX in the measurement program to measure the thread, calculate the helix angle and
then align the slide.
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10.37 Programming Hints - Modifying CALL statements

Some of the measurement routines available to the user can return several values. An example of this is
Call(DIA...) which can return average, minimum, maximum diameter, and the X co-ordinates of these values.
All of these values can be stored in a single measurement but if not all values are required, zeros should be
specified. The zeros after the last required value may be omitted.

e.g. to find the maximum diameter only :-

Call(Dia,zone,0,0,M[DMX])

e.g. to find the average and maximum diameters only :

Call(Dia,zone, M[DAV],0,M[DMX])

Note : For each M register value i.e. M[D01] defined in a measurement function there must be a
DEFINE:MEAS statement included.

10.38 Programming Hints - Draw:Zone

This command can be used in a PROCAL measurement program to display the data contained in a measurement
zone and the X and Y co-ordinates. For this function to work, the Draw:Zone command must be positioned in
the PROCAL measurement program directly after the 'CALL' statement.

e.g.
Define:Meas(...)

Define:Zone(1..)...
Call(Step,...)
Call(Dia,l1....)

Draw:Zone(1)

Note : Using DRAW:ZONE the specified zone will be scanned and the measurement computed. The
DRAW:ZONE will then display the scanned data. However, if for instance, there is an insufficient number of
data points to carry out the measurement, the zone will not be displayed and a Procal error will appear. If a
PROCAL Error occurs during measurement , modify the program by increasing the 'DEFINE:ZONE'
parameters (i.e. X min) to enlarge the zone, and include the DRAW:ZONE statement. When the program is run,
the scanned data will be displayed and the F3 key can be used to define the new measurement zone. The
'DEFINE:ZONE' parameters can be modified to include the new x and y co-ordinates.
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10.39 Programming Hints - Scanning of Zones

When a specified zone is scanned, the data is stored in memory and this data is only released if there is not
enough room for a new scan (in which case the oldest data is released). This is useful to achieve optimum cycle
times where for instance a taper on a component is measured to output the angle and is used to calculate an
intersection point.

If the zones are both assigned the same X and Y values and the second zone has the same or larger 'step'
increment, the taper will only be scanned once. However, if the second zone is larger or requires a higher
resolution scan then the taper will be scanned twice to collect additional data points.

ANGLE ZONE

INTERSECTION ZONES

10.40 Programming Hints - Overscanning

The PROCAL command DEFINE:ZONE defines a region in which a measurement is taken. However, because
the measuring CCD arrays are in the form of an inverted 'V, the system will overscan in X to compensate for
this angular offset. The length of overscan will depend entirely on the size of the zone defined.

The diagram shows the method of overscanning where the system interrogates the max and min X and Y co-
ordinates of the specified zone to define its overall length of scan.

START : \
PDSITIDN.\\“\\Rxl
‘ r———+#
' :t\ FINISH

‘l I POSITION

F—

\ \
IL____II

_ X 1 —

l- -|

OVERALL LENGTH
OF SCAN
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10.41 Programming Hints - Rotational Measurement Functions

Each rotation measurement uses system default parameters for the X and Z scanning rates. This means
that unlike static measurement functions the NAME' function CALL (STEP...) is not used. If STEP is
used to overwrite the default value it will be ignored. However the NAME' function INDEX can be
used to overwrite the default parameters for the number of scan positions. e.g. CALL (INDEX,2)
specifies 2 rotational scans in X instead of the default 4 scans.

When using DEFINE:ZONE, if no Z values are specified the system will default to 0-360 degree
rotation. If a smaller angular rotation is specified i.e. 0-180 degree the system will still use the default
scan increments which provides a higher scan resolution.

By far the quickest and simplest method of using rotation functions is to create a program in Pro-
Composer and then any rotation zones which are required can be defined as a diameter to obtain the
zone co-ordinates. The program created can then be modified using the Procal editor.

10.42 Programming Hints - Thread Measurement Functions

CALL (STEP,...) is used to define the X increment when the thread is scanned. The value depends
upon the size of the thread to be measured. It is recommended a value relative to the pitch of the thread
is used . The ratio of pitch to step increment is 1:200 i.e. 15mm pitch = 0.008mm step. If after the
thread is scanned an error message 'INSUFFICIENT DATA POINTS' is displayed, the 'STEP' value
will require editing to a smaller resolution.

For accurate measurement of threads, the zone defined using DEFINE:ZONE must include a minimum
of 2.5 X Pitch in X..

To ensure length measurement accuracy, threads should be measured at the end of a PROCAL
program. This will eliminate any inaccuracy due to the movement of the slew mechanism.

10.43 Standards Databases - Programming Hints

The number of nominals defined in a block defining Features with Sub-Features, must be identical to the
number of any other blocks defining Features and SubFeatures. Hence, when creating a database it is better to
define one block of a particular block, and then copy the block and edit. This will avoid problems caused by a
mismatch of parameters.
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11 Standards Databases






11.1  Standards Databases

The Standards Database facility enables the user to retrieve nominal and tolerance data from a database of
International Standards and attach them to specified dimensions. The option provides an alternative to manually
entering dimensional specifications from an engineering drawing. The following Standards databases are
currently available for selection from within Pro-Composer, in both metric and imperial units.

ISO METRIC Parallel Screw Threads - Preferred Limits
UNC Parallel Screw Threads - Preferred Limits
METRIC Taper Threads — Standard and Short
WHITWORTH Taper Threads

NPTF Taper Threads

ISO SHAFT LIMITS & FITS Selected Fits

DIN 7168 Tolerance Grades

UNIJEF Parallel Extra-Fine Pitch Screw Threads
UNJF Parallel Fine-Pitch Screw Threads

UNIJC Parallel Course Pitch Screw Threads

8 UNJ Parallel 8 T.P.I. Constant Pitch Screw Threads
12 UNJ Parallel 12 T.P.1. Constant Pitch Screw Threads
16 UNJ Parallel 16 T.P.I. Constant Pitch Screw Threads
DIN228 Inch

DIN228 mm

DIN3858 Inch

DIN3858 mm

DIN40430 Inch

DIN40430 mm

NPT mm

NPT Inch

In addition, the user is provided with the necessary software commands to modify and/or append the existing
databases and create new databases.

11.2 Modify and Create Standards Databases

The databases are all written as PROCAL programs using dedicated PROCAL commands. Each database
program can be selected for editing using the 'Open' option available for selection from the Pro-Measure 'Editor
menu. The default database programs are as follows :-

ISO THREAD MM (Normal) WHITWORTH MM (Tapered)

ISO THREAD INCH (Normal) WHITWORTH INCH (Tapered)

UNC THREAD MM (Normal) NPTF INCH (Tapered)

UNC THREAD INCH (Normal) NPTF MM (Tapered)

ISO FITS MM ISO METRIC MM (Tapered)

ISO FITS INCH ISO METRIC INCH (Tapered)

DIN 7168 FITS ISO METRIC SHORT MM (Tapered)
DIN 7168 ANGLES ISO METRIC SHORT INCH (Tapered)
DIN 7168 RUN-OUT UNJ THREAD INCH (Tapered)

IMPORTANT: Care must be taken when editing to ensure that database errors do not occur.
When changes are made to a database it is necessary to re-start Pro-Composer for the changes to be recognised.



11.3 Creating a New Database

The following PROCAL commands are available to allow the user to create a new database :-

Begin:Standard Std:Nominal
End:Standard Grade:Table
Begin:StdTable Std:R_Grade
End:StdTable Std:A_Grade
Std:Display Std:Global
Std:Apply

11.4 Selection of Units

The database can be set to use mm or inch by the use of the existing PROCAL command 'Units:All'.
Pro-Composer will only retrieve a database if the units currently set match the units defined in the database.
Therefore, if the user wishes to use a database in both metric and imperial, then 2 copies of the database must be
made with the necessary conversions and 'Units:All' command. The same 'Name' can be defined in the
'Begin:Standard' command of both the mm and inch database programs, although the PROCAL programs must
have different names.

11.5 Program Example - Standards Database
The following Procal Program example is for a WHITWORTH TAPER THREADS Standards Database.

{ WHITWORTH DATABASE FOR TAPER THREADS - DIN 3858/BS 21 }
Define:Mode(2,2)
Units:All("Inch")

{ Defines Start of Database }
Begin:Standard(" Whitworth",20032)

Std:Display(20078,10000) { Thread Pitch Diameter at X:Nominal}
Std:Display(20073,10000) { Thread Gauge Length:Nominal}
Std:Display(20061,10000) { Thread Pitch:Nominal }

Std: Apply(20033) { Thread:RH Taper }

{Define major diameters}
Begin:StdTable(20078,10000,20073,10000) { Pitch Diameter at X & Gauge Diameter }
Std:Nominal(0.2812,1)
Std:Nominal(0.3601,1)
Std:Nominal(0.4843,1)
Std:Nominal(0.6223,1)
Std:Nominal(0.7793,1)
Std:Nominal(0.9952,1)
Std:Nominal(1.2508,1)
Std:Nominal(1.5918,1)
Std:Nominal(1.8238,1)
Std:Nominal(2.2888,1)
Std:Nominal(2.9018,1)
Std:Nominal(3.4018,1)
Std:Nominal(4.3918,1)
Std:Nominal(5.3918,1)



Std:Nominal(6.3918,1)
End:StdTable

{ Define DIA FOR GAUGE LENGTH Sizes }
Begin:StdTable(20073,10014)
Std:Nominal(0.2812,1)
Std:Nominal(0.3601,1)
Std:Nominal(0.4843.1)
Std:Nominal(0.6223,1)
Std:Nominal(0.7793.,1)
Std:Nominal(0.9952,1)
Std:Nominal(1.2508,1)
Std:Nominal(1.5918,1)
Std:Nominal(1.8238,1)
Std:Nominal(2.2888,1)
Std:Nominal(2.9018,1)
Std:Nominal(3.4018,1)
Std:Nominal(4.3918,1)
Std:Nominal(5.3918,1)
Std:Nominal(6.3918,1)
End:StdTable

{ Define Pitch Sizes T.P.1.}
Begin:StdTable(20061,10000,20073,10000,1)
Std:Nominal(28,1)
Std:Nominal(28,1)
Std:Nominal(19,1)
Std:Nominal(19,1)
Std:Nominal(14,1)
Std:Nominal(14,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
Std:Nominal(11,1)
End:StdTable

{ Define Crest Truncation Sizes }
Begin:StdTable(20075,10000)
Std:Nominal(0.0057,1)
Std:Nominal(0.0057,1)
Std:Nominal(0.0084,1)
Std:Nominal(0.0084,1)
Std:Nominal(0.0114,1)
Std:Nominal(0.0114,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)



Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
End:StdTable

{ Define Root Truncation Sizes }
Begin:StdTable(20076,10000)
Std:Nominal(0.0057,1)
Std:Nominal(0.0057,1)
Std:Nominal(0.0084,1)
Std:Nominal(0.0084,1)
Std:Nominal(0.0114,1)
Std:Nominal(0.0114,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145.1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
Std:Nominal(0.0145,1)
End:StdTable

{ Define gauge length }
Begin:StdTable(20073,10000)
Std:Nominal(0.1575,1)
Std:Nominal(0.1575.2)
Std:Nominal(0.2362,3)
Std:Nominal(0.2520.4)
Std:Nominal(0.3228,5)
Std:Nominal(0.3740,6)
Std:Nominal(0.4094,7)
Std:Nominal(0.5,8)
Std:Nominal(0.5,9)
Std:Nominal(0.626,10)
Std:Nominal(0.689,11)
Std:Nominal(0.811,12)
Std:Nominal(1.0000,13)
Std:Nominal(1.126,14)
Std:Nominal(1.126,15)
End:StdTable

{ Define useful (thread) length }
Begin:StdTable(20074,10000)
Std:Nominal(0.2559,1)
Std:Nominal(0.2559,2
Std:Nominal(0.3819,3)
Std:Nominal(0.3976,4)
Std:Nominal(0.5197.5)
Std:Nominal(0.5709,6)
Std:Nominal(0.6614,7)
Std:Nominal(0.752,8)
Std:Nominal(0.752,9)
Std:Nominal(0.9213,10)
Std:Nominal(1.0512,11)
Std:Nominal(1.1732,12)
Std:Nominal(1.4094,13)



Std:Nominal(1.5787,14)
Std:Nominal(1.5787.15)
End:StdTable

{define left flank angle fixed at 30 degrees }
Begin:StdTable(20064,10000)
Std:Global(27.5,1.0,-1.0)

End:StdTable

{define right flank angle fixed at 30 degrees }
Begin:StdTable(20065,10000)
Std:Global(27.5,1.0,-1.0)

End:StdTable

{define Thread Taper fixed at 3.978 degrees }
Begin:StdTable(20072,10000)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
Std:Nominal(3.978,1)
End:StdTable

{ Grade Tables }

Grade: Table(20073,10000,1)
Std:R_Grade("1/16",35.4331,-35.4331)
End:StdTable
Grade:Table(20073,10000,2)
Std:R_Grade("1/8",35.4331,-35.4331)
End:StdTable
Grade:Table(20073,10000,3)
Std:R_Grade("1/4",51.1811,-51.1811)
End:StdTable
Grade:Table(20073,10000,4)
Std:R_Grade("3/8",51.1811,-51.1811)
End:StdTable
Grade:Table(20073,10000,5)
Std:R_Grade("1/2",70.8661,-70.8661)
End:StdTable
Grade:Table(20073,10000,6)
Std:R_Grade("3/4",70.8661,-70.8661)
End:StdTable

Grade: Table(20073,10000,7)
Std:R_Grade("1",90.5512,-90.5512)



End:StdTable
Grade:Table(20073,10000,8)
Std:R_Grade("1 1/4",90.5512,-90.5512)
End:StdTable

Grade: Table(20073,10000,9)
Std:R_Grade("1 1/2",90.5512,-90.5512)
End:StdTable
Grade:Table(20073,10000,10)
Std:R_Grade("2",90.5512,-90.5512)
End:StdTable
Grade:Table(20073,10000,11)
Std:R_Grade("2 1/2",3500,-3500)
End:StdTable
Grade:Table(20073,10000,12)
Std:R_Grade("3",137.7953,-137.7953)
End:StdTable
Grade:Table(20073,10000,13)
Std:R_Grade("4",137.7953,-137.7953)
End:StdTable
Grade:Table(20073,10000,14)
Std:R_Grade("5",137.7953,-137.7953)
End:StdTable
Grade:Table(20073,10000,15)
Std:R_Grade("6",137.7953,-137.7953)
End:StdTable

Grade:Table(20074,10000,1)
Std:R_Grade("1/16",35.4331,-35.4331)
End:StdTable
Grade:Table(20074,10000,2)
Std:R_Grade("1/8",35.4331,-35.4331)
End:StdTable

Grade: Table(20074,10000,3)
Std:R_Grade("1/4",51.1811,-51.1811)
End:StdTable
Grade:Table(20074,10000.4)
Std:R_Grade("3/8",51.1811,-51.1811)
End:StdTable
Grade:Table(20074,10000,5)
Std:R_Grade("1/2",70.8661,-70.8661)
End:StdTable
Grade:Table(20074,10000,6)
Std:R_Grade("3/4",70.8661,-70.8661)
End:StdTable
Grade:Table(20074,10000,7)
Std:R_Grade("1",90.5512,-90.5512)
End:StdTable
Grade:Table(20074,10000,8)
Std:R_Grade("1 1/4",90.5512,-90.5512)
End:StdTable
Grade:Table(20074,10000,9)
Std:R_Grade("1 1/2",90.5512,-90.5512)
End:StdTable
Grade:Table(20074,10000,10)
Std:R_Grade("2",90.5512,-90.5512)
End:StdTable
Grade:Table(20074,10000,11)
Std:R_Grade("2 1/2",137.7953,-137.7953)



End:StdTable
Grade:Table(20074,10000,12)
Std:R_Grade("3",137.7953,-137.7953)
End:StdTable
Grade:Table(20074,10000,13)
Std:R_Grade("4",137.7953,-137.7953)
End:StdTable
Grade:Table(20074,10000,14)
Std:R_Grade("5",137.7953,-137.7953)
End:StdTable
Grade:Table(20074,10000,15)
Std:R_Grade("6",137.7953,-137.7953)
End:StdTable

End:Standard

11.6 Standards Databases - Programming Hints

The number of nominals defined in a block defining Features with Sub-Features, must be identical to the
number of any other blocks defining Features and SubFeatures. Hence, when creating a database it is better to
define one block of a particular block, and then copy the block and edit. This will avoid problems caused by a
mismatch of parameters.

11.7  Using the Standards Database in Pro-Composer

The Standards Database option is controlled from within the Measurement Properties dialog box where a
database can be applied to the selected measurement feature. The database standard can be selected from the
'Standards Database' drop-down menu on the "Measurement' Page of the Measurement Properties dialog box.
The default is "None' and all other applicable standards will be listed as options for selection. The available
standards will depend upon the units and feature types i.e. ISO Limits and Fits standard only applies to
diameters and lengths, while the ISO Metric and UNC Thread standards apply to particular thread dimensions.

When a database has been selected, the 'Standards Database' Page of the Measurement Properties window will
have further options that must be set. Click on the 'Standards Database' page tab at the top of the dialog box to
make this page active.

The parameters shown on this page will vary depending upon the measurement type and standard selected. Each
parameter will have a text box that displays the nominal value. This value will initially be the rounded value
obtained from the component scan, which is also displayed as the nominal value on the 'Measurement' page. If
the value is displayed with green text, then it is a valid value according to the selected standard. If the value is
displayed with black text then it is not exactly represented in the chosen database and must be modified. You
may use the Up or Down 'arrow" buttons to scroll through the available options at increments defined by the
database i.e. 0.1mm/0.004". Select the next nearest acceptable value in the direction you are going. You may
also type in a new value manually. Once the value is acceptable i.e. represented in the database, it will be
displayed in green text.

For certain features (e.g. threads) some nominal parameter values will be dependent on others and therefore the
order in which you set the values is important. The 'Standards Database' dialog box is designed such that the
values are listed in order of importance from top to bottom of the dialog box. Therefore set the parameters in
this order, i.e. the top parameter first working down the page.

In addition to the Nominal parameters, for all feature types there will also be a 'Grade' parameter. The 'Grade'
drop-down menu box will have the available grading options applicable to the standard, feature and units type.
Select the option from the drop-down menu.



Once all the parameters have been set, accept the values by pressing the 'OK' button to accept the changes and
close the dialog box or the 'Apply’ button to accept the changes but leave the dialog box open. If you have not
set the parameters correctly, a warning message will be displayed and you will have to set the parameters to
suitable values.

Once the parameters have been accepted, this will cause the nominal and tolerance values in the 'Measurement'
Page to be adopted from the database. These values will now be highlighted in grey and also locked such that
you will not be able to change the values.

Notes :

If SPC is switched ON and the user selects the 'SPC' Page of the Measurement Properties Dialog box when
defining or editing a measurement feature, data retrieved from a database will be used for the SPC default
calculations.

Use the 'CANCEL' button to abort this operation.

Changing the Units of a schematic from 'mm’ to 'Inch’ or 'Inch' to' mm' after Standards Database parameters
have been set will result in the Standards Database settings being reset. i.e. 'Standards Database' option in the
'Measurement' Page of the Measurement Properties Dialog box will be set back to 'None' and the Standards
Database will not be active. However, any nominals that were generated by the Standards Database will remain,
converted to the appropriate units type.

Only databases which are applicable to the currently selected measurement type are available for selection. If a
selected measurement type has no relevant database available, then the 'Standards Database' field will be in-

active or not visible in the '"Measurement' page options of the Measurement Properties dialog box.

The folder path for the Standards Database files is set in the Pro-Composer 'Options' dialogue box. This will
have a default setting but can be changed if desired.

11.8 FeaturelD number table

DIAMETER AVERAGE 20000
DIAMETER MAX FORM 20001
DIAMETER MIN FORM 20002
DIAMETER TURNED 20003
DIAMETER MIN METAL 20004
DIAMETER AT X 20005
DIAMETER LINE LINE INTERSECTION 20006
DIAMETER LINE EDGE INTERSECTION 20007
DIAMETER SPHERE 20008
EDGE NORMAL 20009
EDGE INCREMENTAL 20010
EDGE LINE LINE INTERSECTION 20011
EDGE LINE RADIUS INTERSECTION 20012
EDGE GAUGE DIAMETER 20013
EDGE RADIUS CENTRE 20014
EDGE MAX FORM DIAMETER 20015
EDGE MIN FORM DIAMETER 20016
EDGE SPHERICAL END 20017
EDGE THREAD LINE INTERSECTION 20018
EDGE THREAD RADIUS INTERSECTION 20019
LENGTH 20020
ANGLE HALF VERTICAL ORIGIN 20021
ANGLE INCLUDED 20022

RADIUS NORMAL 20023



RADIUS Y CENTRE

CENTRE LINE STATIC

CENTRE LINE DYNAMIC TURNED
CENTRE LINE DYNAMIC AVERAGE
THREAD LH PARALLEL

THREAD RH PARALLEL

THREAD LH WORM

THREAD RH WORM

THREAD LH TAPER

THREAD RH TAPER
CONCENTRICITY AVERAGE
CONCENTRICITY TURNED
CONCENTRICITY MAX FORM
CONCENTRICITY GAUGE DIAMETER
CONCENTRICITY THREAD DIAMETER
RUN OUT RADIAL

RUN OUT FACE

RUN OUT FACE FACE

ROTATION DIAMETER AVERAGE
ROTATION DIAMETER MAXIMUM
ROTATION DIAMETER MINIMUM
ROTATION DIAMETER OVALITY
STRAIGHTNESS NORMAL

ACROSS FLATS DIMENSION
ACROSS FLATS SYMMETRY
ACROSS FLATS MAXIMUM
ANGULAR POSITIONS MIN RADIUS
ANGULAR POSITIONS MAX RADIUS
ANGULAR POSITIONS MIN ANGLE
ANGULAR POSITIONS MAX ANGLE

ANGULAR POSITIONS ACROSS FLATS ANGLE

ANGULAR POSITIONS ANGLE A B
GROOVE DEPTH

FORM DEVIATION LINE

FORM DEVIATION RADIUS

ANGLE HALF HORIZONTAL ORIGIN
THREAD PITCH DIAMETER
THREAD PITCH

THREAD MAJOR DIAMETER
THREAD MINOR DIAMETER
THREAD LEFT FLANK ANGLE
THREAD RIGHT FLANK ANGLE
THREAD ROOT RADIUS

THREAD TAPER

THREAD LEAD ERROR

THREAD RUN OUT

THREAD CIRCULARITY

THREAD FUNCTIONAL DIAMETER
THREAD INCLUDED TAPER ANGLE
THREAD GAUGE LENGTH

THREAD USABLE THREAD LENGTH
THREAD CREST TRUNCATION
THREAD ROOT TRUNCATION
THREAD PITCH DIAMETER AT X
THREAD MAJOR DIAMETER AT X
THREAD MINOR DIAMETER AT X
THREAD TOOTH THICKNESS
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20024
20025
20026
20027
20028
20029
20030
20031
20032
20033
20034
20035
20036
20037
20038
20039
20040
20041
20042
20043
20044
20045
20046
20047
20048
20049
20050
20051
20052
20053

20054
20055
20056
20057
20058
20059
20060
20061
20062
20063
20064
20065
20066
20067
20068
20069
20070
20071
20072
20073
20074
20075
20076
20078
20079
20080
20081



THREAD LEFT PRESSURE ANGLE 20082

THREAD RIGHT PRESSURE ANGLE 20083
THREAD ADDENDUM 20084
THREAD DEDENDUM 20085
THREAD DEPTH 20086
THREAD LHRH PARALLEL 20087
THREAD LHRH TAPER 20088
OFFSET DIAMETER ECCENTRICITY 20089
OFFSET DIAMETER SYMMETRY 20090
ROTATION DIAMETER INTERRUPTED 20091
CONCENTRICITY INTERRUPTED 20092
RUN OUT INTERRUPTED RADIAL 20093
EDGE OVER WIRE LOCATION 20094
DIAMETER OVER WIRE 20095
DIAMETER WIRE CENTRE 20096

11.9 FeatureParameterID number table

NOMINAL 10000
USL 10001
LSL 10002
CLASS TYPE 10003
LABEL 10004
DESCRIPTION 10005
XBAR 10006
HISTO 10007
UCLX 10008
LCLX 10009
UCLR 10010
LCLR 10011
X POSITION 10012
EDGE INCREMENT 10013
DIAMETER 10014
NUMBER OF AXIAL HITS 10016
NUMBER OF HITS 360 10017
START ANGLE 10018
IS REF EDGE 10019
REF PLANE X 10020
MEASURE FROM 10021
HELIX ANGLE 10023
PITCH DIAMETER 10024
FILTER 10025
NO STARTS 10026
SCAN COMP RANGE 10027
END ANGLE 10028
ANGLE 10029
RADIUS 10030
SCAN TYPE 10031
REF EDGE 10032
CENTRE LINE 10033
REF ANGLE 10034
REF ANGLE OFFSET 10035
STANDARDS DATABASE 10036
STANDARDS DATABASES 10037

STANDARDS TABLE 10038
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STANDARDS GRADE
UCLS

LCLS

STD GRADE
TARGET

WARNING

THREAD SIZE
SURFACE TYPE
SURFACE PERCENT
No. INTERRUPTIONS
WIRE RADIUS
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10039
10040
10041
10043
10044
10045
10046
10047
10048
10049
10050






12 Procal Editor
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12.1 Procal Editor

The Procal Editor is the built in utility to enable creation or modification of Procal programs. The editor
operates in a similar manner to a word processor whereby lines of text can be written or modified. It can also be
used in conjunction with the debugging facility to indicate where errors have occured during program
execution.

The editor display window will show the contents of the Procal program, a sequential list of commands and
associated parameters.

12.2  Procal Editor - Display Window

The editor display window will show the contents of the Procal program, a sequential list of commands and
associated parameters. This window can be re-sized and moved and is also directly affected by the Window
Menu commands. If all of the program cannot fit into the window at the same time, scroll bars will become
available to enable navigation about the entire program. There is also a Status Bar at the bottom of the window.

‘Meas(M01, "Dinension
‘Heas(M02, "Dinension
‘Heas(HM03, "Dimsnsion
‘Meas(M04, "Dimension 4
‘Heas(M05, "Dinsnsion &
:Heas(M06, "Dinsnsion
‘Heas(HM07, "Dinension 77,
‘Meas (M08, "Dinension 87,

[
I O

e = R
e et S St S S S

|
Pl el o e’
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Note :
You can have more than one procal program open in the editor at one time and each will have its own display
window. Having more than one program open is useful for copying segments from one program to another.

12.3  Procal Editor - Status Bar

This is the status bar that appears at the bottom of the Procal editor display window. The area to the left will
display messages relevant to the current syntax of the command being typed into the editor. There is also an
Indicator area on the right hand side of this status bar.

Indicator Description

Ln COL The 'Ln Col' indicator shows the current cursor position on the screen. Ln is the Line number (Vertical
position of the cursor) and Col is the Column number (Horizontal position of the cursor).
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12.4 Procal Editor - Cursor control

A flashing bar indicates the current position of the text editor cursor. This is the point at which new text can be
entered or existing text can be modified. The cursor can be moved about the document using the cursor keys of
the computer keyboard.

Computl: Heas (M08, 10+RDM(G . 3)-0.1)

The mouse pointer also has additional functionality when in editing mode. This pointer can move the text editor
cursor to a different position by moving the mouse and then clicking the left hand button at the new position.
I Mouse Pointer Style when in Editor mode.

12.5 Procal Editor - Automatic Colour Coding

A colour coding system is automatically applied to the command lines of the procal program in the Editor
display window. This lets you easily pick out mistakes and formatting problems and also enables the code to be
read more easily. Different colours are used for different types of command and parameters.

; {2 Iinas Program - last Hodified by DH 01910983
Define: Meas(HM0Ll, "Dinension 1°

sl
10.0,0.1,-0.1.1)
Define:Meas(M02, "Dimsnsion 27,1 . 1L

a.4 -
0.4, -

.
.

Compute: HMeas({(M01, 104+RDH(0 . 3)-0 1)
Conpute:Heasz(HM02, 1D+RDH{C¢ . 3)-3.1)

The colour coding is as follows :

Remarks ] Green
Commands carried out when the program loads and initialises. I Dark
Blue
Commands carried out during normal execution of the program e Blue
Descriptions . Red
Numbers B Pink
All other text I Black
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12.6  Procal Editor - Editing controls and shortcut keys

General navigation around the document is done with the four cursor keys of the keyboard, or by clicking the
left hand mouse about the display window.
Other controls are as follows :

F1 Help Contents.
Delete Removes character or selected text permanently from document.
Insert Toggles between Overwrite and Insert typing mode.

Return or Enter  Inserts a new line at the current cursor position. Usually used to start a new line when a line of
text has been entered.

Caps Lock Toggles the keyboard between Capital or lower case characters. Holding down the Shift key
whilst typing has the same effect.

Page Down Moves the cursor and screen display down the document.

Page Up Moves the cursor and screen display up the document.

CTRL +C Copy selected items to clipboard.

CTRL + X Cut selected items to clipboard.

CTRL +V Paste contents of clipboard at current cursor position.

CTRL +F. Find a specific word or string of text.

End Move cursor to end of line.

Home Move cursor to beginning of line.

Shift + End. Highlight the complete line to the right of the cursor.

Shift + Home Highlight the complete line to the left of the cursor.
Shift + (cursor Highlight text.
keys).

Note :

You can click the right hand mouse button when in the editor window to display a menu with 'Cut’, 'Copy' and
'Paste’ options.

When you use the 'Cut’ or 'Copy' commands, the selected item is temporarily stored in memory. This temporary
memory area is called the Clipboard.

12.7  Procal Editor - Typing

Each line of code will have a Procal Keyword and associated parameters. These must be typed using the
appropriate syntax as shown in the Procal Reference guide. When you begin to type on a new line, you will
notice that the background colour of that particular line is shaded grey. This indicates that the line does not
contain complete information. This could be because you haven't finished typing or because of an error in the
typing. When the line is complete and accurate the background colour will return to normal. In addition, as the
line is typed, automatic colour coding will be applied to the line content.

Note :
As you type in a new command, the Status bar will indicate syntax for the command type.
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12.8 Procal Editor - Highlighting

Most of the editing operations require selection of the text to be edited. When text is selected for editing, it is
highlighted i.e. the background colour changes to blue and the text colour changes to white.

Highlighting of text is done by holding down the Shift key and then moving the text cursor with the cursor keys.
As the cursor moves over the text, it becomes highlighted. You can also use the mouse to highlight text. Move
the mouse to the start of the text you wish to highlight and then hold the left hand mouse button whilst dragging
the text cursor over the text.

Control keys for Highlighting

Shift + (cursor keys). Highlight text.
Shift + End. Highlight the complete line to the right of the cursor.
Shift + Home Highlight the complete line to the left of the cursor.

Def ineEMeas(HUZ: ”Dizaeni'wn Q.10 0.1,-0.1,1)

il

1
a1

Compute:Heas(M01, t0+RDM (1} Z)-—
Compute:Meas(M02, 10+RDM{D . 3)-

Compute:Heas(M01, 104+RDM({D 3)-0.1)
Compute: Heas(M02, 10+RDM (1 3)-0. 1)
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Example of several l1nes hlghllghted

2\Dﬁﬁsupcl

t Hodified by DH 0101933
"Dimen=ion 1".10.0.0.1.-0.

“Dlmwnwlnn 2", 1ﬂ._.0.1 -0.

:{M01, 10+FDH(0O.
(M02, 10+REDH( 0.
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12.9 Overwrite and Insert text

1. Move the cursor to the point on the line you want new text.

2. If you wish to overwrite the existing entry, simply type in the new information. If you wish to insert
something and retain the existing entry, press the 'Insert' key on the keyboard before you type the new

information.

Notes :
The 'Insert' key toggles between Overwrite and Insert mode.

12.10 Search a document

1. Inthe document, click where you want to start searching.
2. On the 'Edit' menu, click 'Find' and then enter the search text in the 'Find What' box.
3. To find additional instances of the same text,vcontinue to click 'Find Next'.

Notes :

To search for more instances of the same text after you have closed the Find dialog box, press 'F3'.
For Help on an item, click '?' at the top of the dialog box, and then click an item.

12.11 Delete characters

1. Move the cursor to the position on the line just before the character you want to delete.

2. Press the 'Delete' key once to remove the character.

Notes :
Hold down the 'Delete' key to remove each subsequent character.

The 'Delete’ key removes the character to the right of the cursor position. You can also use the 'Backspace' key

to remove characters to the left of the cursor position.
To cancel a selection, click anywhere in the document.

12.12 Delete words or part of a line

1. Move the cursor to the position on the line just before the word or section you want to delete.

2. Highlight the word or section using the keyboard (shift + right cursor key) or mouse (hold down left

hand mouse button and drag, highlighting across the word).

3. Press the 'Delete' key once to remove the word or section.

Note :
To cancel a selection, click anywhere in the document.
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12.13 Delete a whole line

1. Move the cursor to the start of the line you wish to remove.
2. Highlight the complete line by holding the 'Shift' key and then pressing the 'End' key.
3. Press the 'Delete’ key once to remove the line.

Note :
To cancel a selection, click anywhere in the document.

12.14 Delete several lines at once

1. Move the cursor to the start of the first line you wish to remove.

2. Highlight the lines you wish to remove by holding the 'Shift' key and then pressing the down cursor
key.

3. Press the 'Delete' key once to remove all the highlighted lines.

Note :
To cancel a selection, click anywhere in the document.

12.15 Copy words or part of a line

1. Move the cursor to the position on the line just before the word or section you want to copy.

2. Highlight the word or section using the keyboard (shift + right cursor key) or mouse (hold down left
hand mouse button and drag, highlighting across the word).

3. Select the 'Copy' option from the 'Edit' menu.

4. Move the cursor to the position you want to copy a new instance of the previous selection and select
the 'Paste' option from the 'Edit' menu.

Note :

You can keep 'Pasting' the selected text until the next time you use the 'Copy' or 'Cut' command.
To cancel a selection, click anywhere in the document.
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12.16 Copy a whole line

1. Move the cursor to the start of the line you wish to remove.
2. Highlight the complete line by holding the 'Shift' key and then pressing the 'End’ key.
3. Select the 'Copy' option from the 'Edit' menu.
4. Move the cursor to the new position you would like a new instance of the previously selected line.
5. Select the 'Paste' option from the 'Edit' menu.
Note :

You can keep 'Pasting’ the selected line until the next time you use the 'Copy' or 'Cut' command.
To cancel a selection, click anywhere in the document.

12.17 Copy several lines at once

1. Move the cursor to the start of the first line you wish to remove.

2. Highlight the lines you wish to remove by holding the 'Shift' key and then pressing the down cursor
key.

3. Select the 'Copy' option from the 'Edit' menu.
4. Move the cursor to the position you want a new instance of the selected lines.
5. Select the 'Paste’ option from the 'Edit' menu.

Note :

You can keep "Pasting' the selected lines until the next time you use the 'Copy' or 'Cut' command.
To cancel a selection, click anywhere in the document.

12.18 Copy to another document

1. In the document that contains the information you want to copy, select the information by highlighting
it.

2. From the 'Edit' menu, click 'Copy'.

3. Inthe document where you want the information to appear, click the place where you want to put the
information.

4. Select the 'Paste’ option from the 'Edit' menu.
Note :

You can paste the information multiple times, until the next time you use the 'Cut' or 'Copy' commands.
To cancel a selection, click anywhere in the document.
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12.19 Move words or part of a line

1.  Move the cursor to the position on the line just before the word or section you want to move.

2. Highlight the word or section using the keyboard (shift + right cursor key) or mouse (hold down left
hand mouse button and drag, highlighting across the word).

3. Select the 'Cut' option from the 'Edit' menu.

4. Move the cursor to the position you want to move the highlighted text to and select the 'Paste’ option
from the 'Edit' menu.

Note :

You can keep 'Pasting' the selected text until the next time you use the 'Copy' or 'Cut' command.
To cancel a selection, click anywhere in the document.

12.20 Move a whole line

1. Move the cursor to the start of the line you wish to move.
2. Highlight the complete line by holding the 'Shift' key and then pressing the 'End' key.
3. Select the 'Copy' option from the 'Edit' menu.
4. Move the cursor to the new position you would like the selected line to be moved to.
5. Select the 'Paste’ option from the 'Edit' menu.

Note :

You can keep 'Pasting' the selected line until the next time you use the 'Copy' or 'Cut' command.
To cancel a selection, click anywhere in the document.

12.21 Move several lines at once

1. Move the cursor to the start of the first line you wish to move.

2. Highlight the lines you wish to remove by holding the 'Shift' key and then pressing the down cursor
key.

3. Select the 'Copy' option from the 'Edit' menu.
4. Move the cursor to the new position you want the selected lines to be moved to.
5. Select the 'Paste’ option from the 'Edit' menu.

Note :

You can keep "Pasting' the selected lines until the next time you use the 'Copy' or 'Cut’' command.
To cancel a selection, click anywhere in the document.
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12.22 Move information into another document

1. In the document that contains the information you want to copy, select the information by highlighting
it.

2. From the 'Edit' menu, click 'Cut'.

3. In the document where you want the information to appear, click the place where you want to put the
information.

4. Select the 'Paste' option from the 'Edit' menu.
The information is removed from the original document and appears in its new location.

Note :

You can paste the information multiple times, until the next time you use the 'Cut' or 'Copy' commands.
To cancel a selection, click anywhere in the document.

12.23 Print a Procal Program

1. Open the program file with the Editor that you wish to print.

2. Follow the printing a document instructions.

12.24 Print part of a Procal Program

1. Open the program file that you wish to print (open within the Editor).
2. Highlight the part of the program you wish to print.

3. Follow the printing a document instructions and when the Print dialog box appears, click the 'Selection’
option in the 'Print Range' section of the dialog box.
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13 Procal Keyword Reference
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13.1 Keyword Reference - Introduction

The flexibility and power of Procal is provided by the array of Keywords available. There are actually hundreds
of words and variables that can be used within Procal programs. Obviously, depeninig upon the specific
measurement problem and the skills of the programmer, only certain keywords will be required. Therefore, the
keyword defintions have been categorised into three groups. These are as follows :

Pro- This is all the keywords that can be included within Procal programs generated by Pro-Composer.
Composer

Manual This is a list of common keywords that may be used in addition to those in the Pro-Composer group for
Edit manual editing of programs or for segment authoring.

Advanced This is a complete alphabetical list of all available keywords and variables.

User

Note :

Each group will be divided into subsections relating to the type of keyword or variable.
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13.2  Procal Keyword Reference - Pro-Composer

13.2.1 Measurement Control

Define:Zone
Compute:Meas
Rotate:Abs

Limits: Warning
Release:Scan Memory
Helix:Abs

Units:All

Define:X Origin
Define:Meas

Call

13.2.2 Program Control

Set:Error_Text
Declare:Global Var
Evaluate
Include:Library

Include:Segment

13.2.3 Input/Qutput

Format:Numeric
Display:Message
Wait:Key
Clear:Message
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13.3  Procal Keyword Reference - Manual Edit

13.3.1 Measurement Control

Classify:Dims

Datum
Define:Transform Angle
Define:Transform Offset
Display:Dims

Draw:R Zone
Draw:Zone

Find

Move:AbsXY
Move:RelXY

Rotate:Rel

Rotate:Reset
Rotate:Scan

Scan:X

Set:System Diameter

13.3.2 Program Control

Auto:Measure
Call

Else

End:If

Goto

If

Mark

Repeat

Until

Wait: Time

13.3.3 Input/Output

Close:File
Close:Printer
Close:Serial
Define: IO Serial
Format:Text
Length:Text
Mid:Text
Open:File
Open:Printer
Open:Serial
Prompt
Read:External

Read:Format
Read:Keyboard
Write:Colour
Write:Date
Write:Dimension
Write:Dimension All
Write:Field
Write:Format

13-4



Write:Page

Write:Position

Write: Text
Zone:Text

13.34

Class
ClassOf

Comp Units
Data File

13.3.5 Standards Database

Begin:Standard
Begin:StdTable

End:Standard

End:StdTable

Grade:Table
Std:A_Grade
Std:Apply
Std:Display
Std:Global
Std:Nominal
Std:R_Grade

Variables/Functions
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13.4  Procal Keyword Reference - Advanced User
A

Add:Polynomial
Array Max
Array_Min
Auto:Gosub
Auto:Measure
Auto:Start

AV

Axis Pitch
AxisMaxAccel
AxisMaxSpeed
AxisPos
AxisStSpeed
Begin:Standard
Begin:StdTable
Begin:Sub

Call

Call (Advanced User)
Chain:Program
Class

Class:Type

Class RTType
Classify:Component
Classify:Dims
ClassOf
Clear:Message
Clock

Close:File
Close:Keyboard
Close:Printer
Close:Serial
Close:User Screen
Close:User Window
Comp_Class

Comp_ Units
Compare:Text
Compute:Centre Line
Compute Func

Compute:Meas
Compute:Polynomial

Compute:R_Centre Line
Copy

cX

CY

[6V4

D

Data File

Date

Datum

Datum:Axis
Declare:Common_ Var
Declare:Global Var
Declare:L.ocal Var
Define: 10 _Serial

Define:Dynamic
Define:Dynamic_Function
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Define:Function
Define:10 Start
Define:Meas
Define:Menu_Exit
Define:Menu Header
Define:Menu List
Define:Menu_Options
Define:Mode
Define:Screen
Define:Table
Define:Table Float
Define:Table Integer
Define:Table Option
Define:Table Text
Define:Transform Angle
Define:Transform Offset

Define:User Key
Define:User Window

Define:X Origin
Define:Zone
Desc

Description
Display:Dims
Display:Message

Display:Table
DMax

DMin

DO

Draw:Box
Draw:Circle
Draw:Circular Arc
Draw:Line
Draw:R Zone
Draw:Zone
Dump:Zone
DX

DXMax
DXMin
DynAverage
DynMaximum

DynMinimum
E

Edge Offsets
Else

EMail
EMail:File
End:If
End:Measure
End:Standard
End:StdTable
End:Sub
Evaluate
Evaluate: Text
EX

Exit:Off
Exit:On

EY

F
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Failed
File:Copy
File:Delete
File:Exist
File:Length
Filter:Fourier
Filter:Gaussian
Find

Find (User defined functions)

Format:Display
Format:Numeric

Format:RTDisplay
Format: Text
Gosub

Goto
Grade:Table
Helix:Abs

1

If
Include:Library
Include:Segment
Init:Polynomial
Initialise: Text
LA

Lab

Label
Language:Text
Last Machine Save
LB

LB[64]

LC

Length:Text
Limits: Warning
Limits:USL_LSL
Limits:Range
Limits:Sigma
Limits: XBar
Load:Machine Data
LSL

LWL

M

Machine Type

Move:AbsXY
Move:Axis
Move:RelXY

MRange
MSigma
MZ
NDims
Nom

13-8



Nominal

NZ

On:Timer
Open:File
Open:Keyboard
Open:Printer

Open:Serial
Open:User Screen

Open:User Window

Poly

Poly Coet X
Poly Coef Y
Prog Name
ProgDir

Prompt
PStat

PX
PY
R

Read:Dynamic
Read:External

Read:File Pos

Read:Format

Read:Inputs
Read:Key

Read:Keyboard
Read:Scan

Read:Sensors
Recover
Release:Scan_Memory
Repeat

Rotate:Abs
Rotate:Rel
Rotate:Reset
Rotate:Scan

RPos

RX

RY

S

Save:Machine Data
Scan:X

Scanned
Select:Screen
Sensor
Sensor:Check
SeriallD
Set:DefaultClipping
Set:Error

Set:Error Text
Set:File Pos
Set:Outputs
Set:System Diameter
SPos
Statistics:GroupSize
Statistics:Update
Std:A_Grade
Std:Apply
Std:Display
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Std:Global
Std:Nominal
Std:R_Grade
Stop

Stop:Axis
SubMode

System Diameter

Trace Title
Trap:Error
Units: All
Until

Version

VPB: Dark Reference
VPB:Idle
VPB:Load Data
VPB:Measure
VPB:Measure Edge
VPB:Reset Counter
VPB:Reset Status
VPB:White Reference
VPB Data

VPB FailFrames
VPB Header

VPB PassFrames
VPB Status
Wait:Axis
Wait:Dynamic
Wait:Input
Wait:Key

Wait: Time
Write:Char
Write:Colour
Write:Date
Write:Dimension
Write:Dimension All
Write:Format
Write:Field
Write:Page
Write:Position
Write:Scan
Write:Size

Write: Text

Write: Time

XAv

XMax

XMin

XOrigin

XPos

YAy
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Zone
Zone:Text
Zone PointC
Zone PointH
Zone PointR
Zone PointW
Zone PointX
Zone PointY
ZOrigin
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13.4.1  Aln]

n- 1-64
ACTION: Returns
Angle of line to machine axis (H_ ANGLE)
Angle between upper and lower lines (I_ ANGLE)
Left and right flank angles (L_THREAD, R THREAD )

DEFAULT: N/A.

13.4.2 Add:Polynomial(Actual,Expected)

Actual - Measured value.
Expected - Expected value.
ACTION: Adds in an actual value and the expected value for a point, ready for the

Compute:Polynomial word. Must be called after Init:Polynomial.
DEFAULT: N/A.
EXAMPLE: Init:Polynomial(0,1)

Add:Polynomial(M[1],Nom[1])

Add:Polynomial(M[2],Nom[2])

Add:Polynomial(M[3],Nom[3])

13.4.3 Array_Max|[Array]

Array - 1 — Number of arrays connected.

ACTION: Returns and sets the upper clipping limit for the specified VPB array.
DEFAULT: N/A.

EXAMPLE: Evaluate(Array Max[2]:=12.0)

Display:Message("Upper limit for Array 3 = %f",0,0,Array_Max[3])

13.4.4 Array_Min[Array]

Array - 1 — Number of arrays connected.

ACTION: Returns and sets the lower clipping limit for the specified VPB array.
DEFAULT: N/A.

EXAMPLE: Evaluate(Array Min[2]:=0.5)

Display:Message("Lower limit for Array 3 = %f",0,0,Array_Min[3])
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13.4.5 Auto:Gosub(Subroutine)

Subroutine - 1-30 characters.
ACTION: Causes the specified subroutine to be executed as part of the loading process of
the program. This can be used to initialise user screens, data arrays etc.
DEFAULT: N/A
EXAMPLE : Auto:Gosub("InitScreen")
Begin:Sub("InitScreen")
Open:Screen(4,1)
Write:Format("Results Screen")
Close:Screen(4,1)
End:Sub

13.4.6 Auto:Measure

ACTION: Repeats the measurement cycle until the STOP key is pressed.
DEFAULT: Single Measurement

13.4.7 Auto:Start

ACTION: Causes the Procal program to be started automatically after it has been loaded.
DEFAULT: User must start program by clicking on the start button or pressing 'F2'.

13.48 AV|n]

n- 1-64

ACTION: Returns Average of a user expression Average thickness ( THICK ).
DEFAULT: N/A.

EXAMPLE: Find(1,Thick,1)

Compute:Meas(D01,AV[1])

13.4.9 Axis_Pitch[Array]

ACTION : VPB calibration parameter set during full calibration in order to compensate for length
errors.
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13.4.10 AxisMaxAccel[Axis]

ACTION : Returns the maximum acceleration of the specified motor axis.

13.4.11 AxisMaxSpeed[Axis]

ACTION : Returns the maximum speed of the specified motor axis.

13.4.12 AxisPos[Axis]

ACTION : Returns the current position of the specified motor axis. On Profile machines, XPos, YPos,
RPos and SPos variables should be used instead.

13.4.13 AxisStSpeed[Axis]
ACTION : Returns the start/stop speed of the specified motor axis.

13.4.14 Begin:Standard(''Name'',FeaturelD)

Defines the name and type of the database and should be placed at the beginning of the database program. The
"Name', which can be maximum of 20 alpha-numeric characters and is displayed in the 'Standards Database'
drop-down menu on the 'Measurement' page within the Measurement Properties dialog box in Pro-Composer,
does not have to duplicate the database program name. The FeatureID is the main Feature that the database
relates to.

See list for currently available Feature 1D's
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13.4.15 Begin:StdTable(FeaturelD, FeatureParameterID[, SubFeaturelD,
SubFeatureParameterID,Units, SearchType, Increment])

FeaturelD

FeatureParam

eterID
SubFeaturelD
SubFeaturePa
rameterID

Units

SearchType

Increment

The ID of the Feature which this standard table relates to. e.g. 20000 for Diameter: Average.
The ID of the Parameter which this standard table relates to. This is normally 10000 'Nominal'
measurement icon.

Used when a particular measurement defined by 'FeatureID' and 'FeatureParameterID' has
another measurement dependant. For instance, when a thread database is created, the major
diameter is firstly defined and the pitch is a possible dependant. Simple measurements types
such as diameters and lengths do not have any dependants and therefore these values are set to
zero or can be omitted. The Parameter table is the same as that for FeaturelD and
FeatureParameterID.

Used when defining thread databases to indicate whether the pitch is defined in the units of the
database or T.P.1. This is only applicable for thread databases which specify a pitch table in
Inch. The default is to use Program Units.

- 0 defines Feature in default program units

- 1 defines Feature in T.P.I (threads per Inch)

Used to define whether the nominal values of the database OR the step increment is used when
the up/down 'arrow' buttons are selected to modify the default values within the database
parameters window in Pro-Composer.

Thread databases tend to use the nominal search mode as fixed nominal values exist for all of
the thread parameters. If a particular standard defines tolerance grades for a size band i.e. 5 to
10mm, the increment search mode is appropriate.

- 0 nominal search mode

- 1 increment search mode

Defines the step increment for the increment search mode.

13.4.16 Begin:Sub(Name[,Variablel,...,Variable19])

Name -
Name -
Variable -
ACTION :

DEFAULT:
EXAMPLE :

1 - 30 Characters.

1 - 30 characters.

Up to 19 local variable names for passed parameters.

Marks the start of a subroutine and declares the local name of any passed
parameters. Parameters whose variable names are declared prefixed with '&' can be
changed within the subroutine. A parameter can be declared as a text variable by
prefixing its name with '$'".

N/A

Declare:Global Var(Count)

Evaluate(Count:=1)

Gosub(Reset Counter,Count) { Set Count =0 }

Begin:Sub(Reset Counter,&Counter)

Evaluate(Counter:=0)
End:Sub
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13.4.17 Call(Label,[| Parameter 1,Parameter 2,...])

Label : name of subroutine -
Parameter 1.n-  values to pass to routine, or registers to put return values into.

Note: Square brackets indicate that parameters are optional, but must be specified as zero if they occur before a

parameter that is required. For example, if a maximum diameter is wanted:
CALL(DIA,zone,0,0,M[Dmx])

ACTION :
routine.
DEFAULT : N/A
The following subroutines are available from measurement libraries:
General :
STEP INDEX
PRINT:DIMS

Static Measurement :

Executes the code contained in the specified subroutine, passing the values of the parameters to the

HA
1A

RAD
RAD:FORM

RESET:CCL
SET:CCL
SETSCANCOMPRANGE

DIA EDGE:GDIA FILTER:ZSCAN
TDIA EDGE GRV:DEPTH
DIA:EDGE EDGE:INT MEASURE:CCL
ANGLE:AB EDGE:RAD
LINE:FORM EDGE:INC

STRT EDGE:THREADRAD

EDGE:THREADLINE

Dynamic Measurement
CONC CONC:MAX RRO
CONC:AVG FRO SET:RCCL
CONC:GDIA FRO:1F MEASURE:RCCL
DIA:ROT CONC:THREAD MEASURE:RCCLA

Thread Measurement :

THREAD:R TAPER:L THREAD:SCL

THREAD:L TAPER:R THREAD:SCR
TAPER:U THREAD:U
TAPER:X

Gageport :

RGP RCGP WCGP
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FLAT:-MAX

MIN:ZPOS
MAX:ZPOS

WORM:L
WORM:R
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13.4.18 Advanced User Additional Call Routines

The following Advanced subroutines are available from measurement libraries:

SCAN:ZONE FLIP:ZONE RX:100
CcCL FRO:2D RY:72

CLIP HALF:ZONE RZ:AF
CONC:1D MOD360 RZ

CONC:2D OLD:STEP SCAN:RX:ZONE
CONC:AVE R_EDGE SCAN:RY:ZONE
CONC3 RAD:ZPOS SCAN:RZ:ZONE
DIA:INT RESET:RCCL SETEDGESTEP
DIA:XPOS RRO:1D STRA
DOFILTER RRO:2D THREAD:HELIX

13.4.19 Call(Angle:AB,Angle A,Angle B,Result)

Measures angular differences between two angles.
e.g. Call(Angle:AB,Zmin[Z01],Zmax[Z02],M[A01])

R

A - Angle A
B - Angle B
R - Result

13-17



13.4.20 Call(CCL,zone 1,zone 2)

Uses the diameters in zones 1 and 2 to find the centre line of the component - height and angle, corrects for any
component misalignment .

Note: This command should be inserted at the beginning of the program.

[ [

I I B

L_ L

13.4.21 Call(Clip,MaxD,MinD)

Clips VPB (Video Processing Board) array at Max and Min diameters. Can be used to keep tooling out of zone
or remove internal holes.

13.4.22 Call(Conc,zone,[conc])

Measures the concentricity relative to the machine axis of a diameter within the specified zone. Returns the
concentricity.

e.g.

Define:Meas(C01,"Concentricity",...)

Define:Zone(1, , ,-15,15)

Call(Conc, 1, M[CO01])

Compute:Meas(C01,M[CO1])

A e

AXIS
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13.4.23 Call(Conc:1D,zone-1,zone-2,[conc])

Measures the relative concentricity of two diameters within the specified zones. Returns the concentricity.
e.g.

Define:Meas(C01,"Concentricity”,...)

Define:Zone(1, , ,-15,15)

Define:Zone(2, , ,-15,15)

Call(Conc:1D, 1, 2,M[CO1])

Compute:Meas(CO1,M[CO1])

|

13.4.24 Call(Conc:2D,zone-1,zone-2,zone-3,[conc])

Measures the concentricity of the diameter in zone 1 relative to an axis defined by the diameters in zones 2 and
3. Returns the concentricity.

e.g.

Define:Meas(C01,"Concentricity”,...)

Define:Zone(1, , ,-15,15)

Define:Zone(2, , ,-15,15) - DIA'A’

Define:Zone(3, , ,-15,15) - DIA'B'

Call(Conc:2D, 1, 2, 3, M[CO1])

Compute:Meas(C01,M[CO1])
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13.4.25 Call(Conc3,rl,r2,r3,conc)

Similar to Conc:2D, but takes register indices of three concentricities instead of three zones (i.e. conc must have
been scanned).

e.g.

Find(1,Conc,1)

Find(2,Conc,2)

Find(3,Conc,3)

Call(Conc3,1,2,3,M[C02])

13.4.26 Call(Conc:Ave,zone,conc)

Measures the concentricity relative to the machine axis of a diameter within the specified zone. Returns the
concentricity. This command is identical to the Conc call command.

13.4.27 Call(Conc:Avg,zone,conc,axial hits)

Measures the concentricity of the average diameter within the specified zone.

o
p L
o [

13.4.28 Call(Conc:Gdia,zone,diameter,cone)

Measures the concentricity of the gauge diameter within the specified zone.

13.4.29 Call(Conc:Max,zone,conc)

Measures the concentricity of the maximum diameter within the specified zone.

13.4.30 Call(Conc:Thread,zone,conc)

Measures the concentricity of a thread within the specified zone.
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13.4.31 Call(Dia,zone,[d-av,d-min,d-max,d-x,d-xmin,d-xmax])

Measure a diameter in the specified zone. Returns average, min and max diameters, average X position, and the
X position of the minimum and maximum diameters.

o —x c=x min d—x mMmox
I"—l'_'l | L ="
i i A= | l |
| | I I WY
| | | | T T
Lo L L
[ [ I — | |
| | | | | |
| 1 | | | !
| | I ! I'\._./{
L__ _JI L_ __; T

c-av d—min d—moux

13.4.32 Call(Dia:Edge,zonel,zone2,ix,iy,error)

zonel - Dia (Line)
zone2 - Edge
The position of an intersection of a diameter(line) and an edge.

13.4.33 Call(Dia:Int,zone-1,zone-2,[ix,diam])

Finds the diameter at an intersection between the lines in the specified zones. Returns the X position and
diameter at the intersection.
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13.4.34 Call(Dia:Rot,zone-1,[d-ave,d-min,d-max])

Measures the diameter within the specified zone at a number of angular positions. Returns the overall average
and the maximum and minimum average diameters.
e.g. to find the maximum diameter

Define:Meas(D01, MAX, "Diameter",...)
Detine:Zone(l, , ,-15,15)
Call(Dia:Rot,1,0,0,M[DO01])
Compute:Meas(D01,M[D01])

13.4.35 Call(Dia:Xpos,zone,x,[diam]])

Finds the diameter at a specified X position within a zone. Returns the diameter at that position.

eclge—x

T

13.4.36 Call(DoFilter,zone,type,amount)

Performs filter on zone, see Filter:Zscan call.

13.4.37 Call(Edge,zone,[edge-x,edge-y])

Finds an edge in the specified zone. Returns the X and Y co-ordinates of the edge.

edge—x

— - — -

eclge—vy
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13.4.38 Call(Edge:Gdia,zone,diam,[x])

Finds the position of a specified diameter within the specified zone. Returns the X co-ordinate of the diameter.

ecdge—x

e b e

T
L 1

13.4.39 Call(Edge:Inc,zone,dy,[edge-x, edge-y])

Finds the position of a specified change of radius (+ve, or -ve) within the specified zone. Returns the X and Y
co-ordinates of the point at which the change occurs. A positive dy value will find an increase in radius from the
minimum data in the zone and a negative dy value will find a decrease in radius from the maximum data in the

zone.

eclge—x

—— 1=
I
|

I

\\f_+___i__:+dy ledge—y
L |

—;dge—x

gl
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13.4.40 Call(Edge:Int,zone-1,zone-2,[ix,iy])

Finds the intersection of two lines in the specified zones. Returns the X and Y co-ordinates of the intersection.

1 =

| e

| LT

: =T

| o
4 1 |
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13.4.41 Call(Edge:Rad,zone-1,zone-2,[ix,iy])
Finds the intersection of a line in zone 1 and a radius in zone 2. Returns the X and Y co-ordinates of the

intersection.

1 7
] I

13.4.42 Call(Edge:Threadline,zonel,zone2,ix,iy,error)

zonel - Thread

zone2 - Line
The position of an intersection of a line and a thread.

13.4.43 Call(Edge:ThreadRad,zonel,zone2,X,Y)

zonel - Thread

zone2 - Rad
The position of an intersection of a radius and a thread.
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13.4.44 Call(Filter:Zscan,type,amount)

Set filter options for rotational scans (automatically calls DOFILTER after each scan).
Currently supported : Call(Filter:Zscan,1,amount)

1 Fourier Filter

0 Off

1 Light
2  Medium
3 Heavy

Amount

13.4.45 Call(Flat,zone,[z-min,af-dim,sym]})

Finds the angular position of flats, the across-flats dimension and symmetry to the machine axis within the
specified zone. Returns the angle, dimension across flats, and symmetry.

e.g. to find across - flats dimension

Define:Meas(AF1,"Across-Flats",...)

Define:Zone(1, , ,0,15,0,60)

Call(Flat,1,0,M[AF1])

Compute:Meas(AF1,M[AF1])

— — | A/F SYMMETRY | &

A/F DIMENSION
I
|
I
I
|
]

AF MAXIMUM

| §

13.4.46 Call(Flat:Max,zone,z_max,af max)

The across flats maximum value within a zone.

13.4.47 Call(Flip:zone,z)

Flips a zone to the other side of the current CCL..
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13.4.48 Call(Fro,zone,[runout])

Measures the run-out relative to the machine axis of a face in the specified zone. Returns the run-out.
e.g.

Define:Meas(F01,"Face-Runout",...)

Define:Zone(1, , , 8,10)

Call(Fro,1,M[FO1])

Compute:Meas(F01,M[F01])

! M/C
[ _ B 1 axis

Edge zone for a FRO to be defined as shown (or narrower if preferred).

s v

13.4.49 Call(Fro:1F,zone-1,zone-2,[runout])

Measures the run-out of a face in zone 1 relative to a face in zone 2. Returns the run-out
e.g.

Define:Meas(F01,"Face-Runout",...)

Define:Zone(l, , , ,)

Define:Zone(2, ., ,)

Call(Fro:1F,1,2, M[FO1])

Compute:Meas(FO1,M[FO01])

a7 o—{A]

13-27



13.4.50 Call(Fro:2D,zone-1,zone-2,zone-3,[runout])

Measures the run-out of a face in zone 1 relative to an axis defined by diameters in zones 2 and 3. Returns the
run-out

e.g.

Define:Meas(F01,"Face-Runout”,...)

Define:Zone(l, ,-15,15) - DIA'A’

Define:Zone(2, ,,-15,15) - DIA'B'

Call(Fro:2D,1,2,3M[F01])

Compute:Meas(FO01)

13.4.51 Call(Grv:Depth,zonel,zone2,Depth)

Measures the depth of a groove on the component.

z2
r—-—=——=-=-- -
D

z1

t t

i
z1 - zonel
z2 - zone2
D - Depth
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13.4.52 Call(HA,zone,[angle])

Measures a half angle in the specified zone. Returns the half angle.

13.4.53 Call(Half:Zone,z)

Ensure zone is positive only.

13.4.54 Call(IA,zone,[angle])

Measures an included angle in the specified zone. Returns the included angle.
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13.4.55 Call(Index,[x-index,z-index])

Sets the number of scans to be taken over a zone in the x and z directions. This command can be used if the
operator wants to overwrite the default parameters.

For Scans in X at Different Angular positions : 100 data points in X at 6 different equispaced angular positions
i.e. 60 degrees.

For Scans in Z at Different Axial positions : 72 data points in Z at 4 different equispaced axial positions for
FACE RUN-OUT, RADIAL RUN-OUT and DIAMETER WITH ROTATION. 360 data points in Z at 4
different equispaced axial positions for RADIUS OFFSETS and ACROSS FLATS.

13.4.56 Call(Line_Form,zone,Angle,Deviation)

Measures the deviation of the component form for a line feature. Note, Angle is supplied not returned.

A - Angle
D - Deviation

13.4.57 Call(Max:Zpos)

Returns the radius and Z position of rotational max. radius (used by max. radius and max. angle). Can also have
Min:Zpos.

13.4.58 Call(Measure:CCL,z1,z2,Reg)

Measures the Static Centre-line (CCL) in zonel(z1) and zone2 (z2). Reg is a unique ID for CCL, starting at 1,
incrementing positively.

IS0 e

' 1 1
] ' 1
-

13.4.59 Call(Measure:RCCL,z1,z2,Reg)

Measures the Dynamic Turned Centre-Line (RCCL) in zonel(z1) and zone2 (z2). Reg is a unique ID for CCL,
starting at 1, incrementing positively.

'
[
J— —_ 1 +
0 ] ' '
1 ' ' I
- - -

_‘.T‘—L—I'_‘—.‘—
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13.4.60 Call(Measure:RCCLA,z1,z2,Reg,RotHits)

Measures the Dynamic Average Centre-Line (RCCLA) in zonel(z1) and zone2 (z2). Reg is a unique ID for
CCL, starting at 1, incrementing positively.

IETNN e W

'

' '
' 1
! ’
-
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13.4.61 Call(Min:Zpos)

Returns the radius and Z position of rotational min. radius (used by min. radius and min. angle). Can also have
Max:Zpos.

13.4.62 Call(Mod:360,ang)

Ensure parameter is between 0 and 360, e.g. angular differences.

13.4.63 Call(Old:Step)

Restores STEP to values as before the last call to Call(Step).

13.4.64 Call(Print:Dims)

Prints the measurement details of a program using a simple (fixed) report format.

13.4.65 Call(R_Edge,zone,[rfx,rfy])

Finds an Edge in the specified zone and sets this to be the machine datum. Returns the X and Y co-ordinates of
the reference edge.

13.4.66 Call(Rad_Form,zone,Radius,Deviation)

Measures the deviation of the component form for a radius feature. Note, Radius supplied by caller, not returned
by function.
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13.4.67 Call(Rad,zone,[radius,radius-x,radius-y])

Measures a radius in the specified zone. Returns the radius and the X and Y co-ordinates of the centre of the
radius.

rodius—x

roadius—y M'd'u;I
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13.4.68 Call(Rad:Zpos,zone,[r-min,r-max,z-min,z-max])

Finds the positions and values of the maximum and minimum Y co-ordinates within the specified zone. Returns
maximum and minimum Y co-ordinates and the angles at which they occur.

e.g. to find max and min radial dimensions

Define:Meas(R01,"Min Radius",,...)

Detine:Meas(R02,"Max Radius",...)

Define:Zone(1, , ,0,15,0,360)

Call(Rad:Zpos,1,M[RO1],M[R02])

Compute:Meas(RO1,M[RO1])

Compute:Meas(R02,M[R02])

MIN RADIUS

MAX RADIUS

AMNGLE A-B

MIN ANGLE
MAX ANGLE /
T
M/C
DATUM

In this example the component will rotate 360 degrees collecting 360 data points i.e. 1 degree steps. This
implies that there is an error of plus/minus 1 degree. If greater accuracy is required, for instance, to find the
maximum radius , a course scan can be taken, followed by a higher resolution scan taken from the course
angular position.

e.g.

Define:Meas(R0O1,"Min Radius",...)

Define:Zone(1, , ,0,15,0,360)

Call(Rad:Zpos,1,0,0,F[1])

Rotate:Rel(-2,F[1])

Rotate:Reset

Define:Zone(1, , .0,15,0,4)

Call(Rad:Zpos,1,M[RO1])

Compute:Meas(R0O1,M[RO1])

Note : Notice how the function register F[1] is used to store the first measurement which is not used for output.
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13.4.69

Sp

Md
$Message
&val

Go
$Calfile

ACTION:

DEFAULT:

13.4.70

Call(RCGP,Sp,md,$Calfile,$Message,&val,go)

Sensor number

Mode: 0 = Immediate read, 1 = Wait for gage switch, 2 = wait for Fikey.
Text which will be displayed on screen (mode 2 only).

Register / Variable which the reading will be stored in.

Gage offset — scaling factor which is applied to the measurement .
Filename where calibration value will be read from.

This subroutine will take a reading from a Gageport port that has been given a
unique sensor number. It will then modify this value in accordance with data that
is read from a file (created by WCGP). This value may then be modified further
by a user defined ‘gage offset’ (if any) before being stored in a function or
variable.

N/A

Call(Reset:CCL)

Set CCL to machine axis.

13.4.71
Set RCCL to

13.4.72

Sp
md

$Message
&val

Go

Val

ACTION:

DEFAULT:

Call(Reset:RCCL)

machine axis.

Call(RGP,Sp,md,$Message,&val,go)

Sensor number

Mode: 0 = Immediate read, 1 = Wait for gage switch, 2 = wait for operator to press
SPACE BAR.

Text which will be displayed on screen (mode 2 only).

Register / Variable which the reading will be stored in.

Gage offset — scaling factor which is applied to the measurement .

A previous reading is passed to this argument.

This subroutine will take a reading from a Gageport port that has been given a
unique ‘sensor’ number. It will then store that reading in a function or variable
after modifying it by a user defined ‘gage offset’ (if any).

N/A
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13.4.73 Call(Rro,zone,[runout])

Measures the run-out of a diameter in the specified zone relative to the machine axis. Returns the run-out
e.g.

Detine:Meas(R01,"Run-Out",...)

Define:Zone(1, ,,0,15)

Call(Rro,1,M[RO1])

Compute:Meas(RO1,M[RO1])

M/C
AXIS

13.4.74 Call(Rro:1D,zone-1,zone-2,[runout])

Measures the run-out of a diameter in zone 1 relative to the diameter in zone 2. Returns the run-out.
e.g.

Define:Meas(R01,"Run-Out",...)

Define:Zone(l, , ,0,15)

Define:Zone(2, , ,0,15)

Call(Rro:1D,1,2,M[RO1])

Compute:Meas(R01,M[RO1])
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13.4.75 Call(Rro:2D,zone-1,zone-2,zone-3,[runout])

Measures the run-out of a diameter in zone 1 relative to an axis defined by diameters in zones 2 and 3.
e.g.

Define:Meas(RO1,"Run-Out"....)

Define:Zone(1, , ,0,15)

Define:Zone(2, , ,0,15) - DIA'A’

Define:Zone(3, , ,0,15) - DIA'B'

Call(Rro:1D,1,2,3,M[RO1])

Compute:Meas(R01,M[RO1])

13.4.76 Call(rx:100,z)

Scan axial rotational zone, taking 100 hits per scan. See also the scan:rx:zone call.

13.4.77 Call(ry:72,z,x,y)

Scan dynamic rotational zone, taking 72 hits per scan (i.e. 5 degrees for a full 360 degree scan). See also the
scan:ry:zone call.

13.4.78 Call(rz,n,z)

Calls scan:rz:zone, after setting number of hits to n.

13.4.79 Call(rz:af,n,z)

Calls scan:rz:zone, after setting STEP in z to n.

13.4.80 Call(scan:rx:zone,z)

Scan rotational zone, taking several axial scans (like straightness).
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13.4.81 Call(scan:ry:zone,z,X,y)

Scan rotational zone, doing several rotational scans offset in Y.

X is position of edge. See diagram.

With 3 scans e 7

13.4.82 Call(scan:rz:zone,z,y)

Scan rotational zone, doing several rotational scans offset in X.

Midpoint --- P

13.4.83 Call(Scan:Zone,z)

Scan static zone (if not already scanned).

13.4.84 Call(Set:CCL)

Set CCL to the one previously measured.

13.4.85 Call(SetEdgeStep)

Sets scan increment based on 1/100th of height of zone.

13.4.86 Call(Set:RCCL)

Set RCCL to the one previously measured.
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13.4.87 Call(SetScanComponentRange)

Sets the measurement range of the machine.

Oorl P30 mode.
2 P80 mode.
3 Both.

13.4.88 Call(Step,|[x-step,z-step])

Sets the increment of scanning in thé X and Z directions.

13.4.89 Call(Stra,zone,|strt])

Measures the straightness within the specified zone. Returns straightness.
e.g.

Define:Meas(S01,"Straightness",...)

Define:Zone(1, , ,-15,15)

Call(Stra,1,M[S01}])

Compute:Meas(S01,M[S01])

13.4.90 Call(Strt,zone,[strt])

Measures the straightness within the specified zone. Returns straightness.
e.g.

Define:Meas(S01,"Straightness",...)

Define:Zone(1, , ,-15,15)

Call(Stra,1.M[SO01])

Compute:Meas(S01,M[SO01])
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13.4.91 Call(Taper:L,zone,diameter,g_plane,zhits,pitch.edgel,Lengthl,ed
ge2,L.ength2)

Measures the features of a left hand Taper thread within a specified zone.

el

Note :
Call Taper:X for extra parameters to be returned.

13.4.92 Call(Taper:R,zone,diameter,g_plane,zhits,pitch,edgel,Lengthl,ed
ge2,L.ength2)

Measures the features of a right hand Taper thread within a specified zone.

et

Note :
Use Taper:X for extra parameters to be returned.

13.4.93 Call(Taper:U,zone,diam,g_plane,zhits,pitch,edgel,L.1,edge2,L.2,]
ang,f ang,t ang,trun_c,eff,major)

Unslewed Taper measurement on machines without slew mechanism. Can be used on left hand or right hand
thread, no slewing. Does not use Taper:X and some sub-features are not available.

13.4.94 Call(Taper:X,l_ang,f ang,t ang,trun_c,trun_r,eff,major,minor)

Use immediately after Taper:L or Taper:R calls to access further parameters.

13.4.95 Call(Tdia,zone,[td-max,td-min])

Measure a turned diameter in the specified zone. Returns maximum and minimum turned diameter.

13.4.96 Call(Thread:Helix,zone,[angle])

Measures a thread within the specified zone and uses the data to calculate the helix angle, then aligns the
component in order to measure the thread accurately.

13.4.97 Call(Thread:L,zone,[effective dia,pitch,major dia,minor
dia,leading flank angle,following flankangle])

Measures a left hand thread within the specified zone and returns the effective diameter, pitch, major and minor
diameters and leading/following flank angles.
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13.4.98 Call(Thread:R,zone,[effective dia,pitch,major dia,minor
dia,leading flank angle,following flank angle])

Measures a right hand thread within the specified zone and returns the effective diameter, pitch, major and
minor diameters and leading/following flank angles.

13.4.99 Call(Thread:SCL,zone,zhits,rt_rad,taper,ld_err,r_out,acty,f dia)

This call returns safety critical features for left hand parallel threads. Use after Thread:L

13.4.100 Call(Thread:SCR,zone,zhits,rt rad,taper,ld_err,r_out,acty,f dia)

This call returns safety critical features for right hand parallel threads. Use after Thread:L

13.4.101 Call(Thread:U,zone,eff dia,pitch,major,]_ang,f ang)

Unslewed thread measurement used on machines with no slew mechanism. No safety critical features available,
minor diameter not available. Used on either left hand or right hand thread, no slewing.

13.4.102 Call(WCGP,$Calfile,$Message,val)

$Message Text which will be displayed on screen (mode 2 only).
Val A previous reading is passed to this argument.
$Calfile Filename where calibration value will be stored.
ACTION: This subroutine will receive a value from a function or variable and will

compare it to a ‘master value’ that the user inputs via the keyboard. The
comparison data is then saved to a file. This ‘calibration’ file can then be used
by the RCGP subroutine.

DEFAULT: N/A
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13.4.103 Call(Worm:L,zone,NominalPitchDiameter,Pitch,Major,Minor,Nu
mberofStarts)

Measures the features of a left hand Worm thread within a specified zone.

NSNS

Note :
Use Worm:X for extra parameters to be returned.

13.4.104 Call(Worm:R,zone,NominalPitchDiameter,Pitch,Major,Minor,Nu
mberQOfStarts)

Measures the features of a right hand Worm thread within a specified zone.

/NSNS

Note :
Use Worm:X for extra parameters to be returned.

13.4.105 Call(Worm:X,NominalPitchDiameter,toothw,l_ang,r_ang,addend
um,dedendum,thr_depth)

Use immediately after Worm:L or Worm:R calls to access extra parameters.

13.4.106 Chain:Program(Filename)

Filename - Name of program.

ACTION: Loads and runs the requested program and switches to Mode if specified else
stays in the current mode. All variables are reset except those that have been
declared common in both programs.

DEFAULT: N/A
EXAMPLE: Chain:Program(". \CANS\330ml Trimmed")
13.4.107 Class_RTType(Dimension Start,Dimension End,Class_type)
Dimension Start - Number of first dimension.
Dimension End - Number of last dimension.
Class_type - 0 =No class.
1 = Always Reject.
2 = External.
3 = Internal.

4 = Always Rework

ACTION: Redefines the class type for the range of dimensions specified at run time.
DEFAULT: Always reject.

13-41



13.4.108 Clock

ACTION : Returns the time in seconds since ProMeasure was started.
13.4.109 Close:User_Window(Operating Mode)
Operating Mode - 0 = All cases.

1 = Calibration.

2 = Measuring.
ACTION: Closes a previously opened user text window.
DEFAULT: N/A

13.4.110 Close:Keyboard

ACTION: Closes the keyboard if it has been previously been opened.
EXAMPLE: Open:keyboard

Read:key(1)

Close:keyboard
DEFAULT: N/A
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13.4.111 Compute:Meas(Dimension, Expression)
When used with LABEL,DESCRIPTION etc:

Dimension - 1-256.
Expression - A valid PROCAL 2 expression.
ACTION : The result of the expression is placed in the measurement register of the

dimension with the specified label. Compute:Meas is still necessary to
output the measurement results even if they have been calculated elsewhere.

When used with DEFINE:MEAS:
Dimension - Label of 1 - 3 characters
Expression - A valid PROCAL 2 expression
ACTION : If the expression is present, the result of the expression is placed in the

measurement register of the dimension with the specified label. If the
measurement register has already been given a value using library routines
or EVALUATE, then the expression should be omitted. Note that
Compute:Meas is still necessary to output the measurement results even if
they have been calculated elsewhere.

DEFAULT: N/A

EXAMPLE 1:
This example will show how the data registers would be used to output a valid measurement :
Compute:Meas(1,D[1])
Compute:Meas(2,EX[2]-EX[1])
Here measurement 1 will be the diameter in zone 1 and measurement 2 will be the length between edges 1 and
2.

EXAMPLE 2:

Compute:Meas(1,2.5*F[3]-0.5*F[4])
The expression will be executed in normal algebraic manner. Hence, the two multiplications will be carried out
first, and the second will be subtracted from the first. The result is placed in register M[2].

EXAMPLE 3:
Compute:Meas(7,ASIN(M[1}/M[2]))
Here the result of evaluation will return an angle which will be placed in measurement register M[7].

IMPORTANT :

(i) 'Compute:Meas' instructions must be inserted AFTER the register it uses have been assigned a feature value
with the 'Find' keyword.

(ii) If 'Compute:Meas' is not called in a program NO RESULTS will appear on the displays.

A general purpose register (F[ ]) can be useful for temporary storage of results.
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13.4.112 Copy(Flag)

Flag -

ACTION:

DEFAULT:

13.4.113 D[n]

n -
ACTION:

DEFAULT:

0-1.
0 = Don't print border.
1 = Print border.

Sends measurement screen to previously opened printer. The value of 'Flag'
" dictates whether or not to include the border.
N/A

1-64

Returns average diameter for the following find functions. DIA, RDIA, TDIA,
TDMIN, [L/R] THREAD

N/A.

13.4.114 Data_File[n]

n -
ACTION:
DEFAULT:
EXAMPLE:

1-9

Returns a fully qualified file name based on the program part name.
N/A.

Open:File(Data File[1],2)

Write:Format("Part Count = %d",0,PartCount)
Close:File(Data_File[1])

13.4.115 Date[n]

n-
ACTION:

DEFAULT:
EXAMPLE:
Note :

1-6

Returns the date in the following formats
1 dd/mm/yy

2 yy/mm/dd

3 mm/dd/yy

4 mmddyy

5 mm/dd/yyyy

6 yyyy/mm/dd

7 yyyymmdd

8 dd/mm/yyyy

N/A.

Write:Format("Date : %s",0,Date[1])
Date format as specified in regional settings can be obtained by omitting the

'[n]'.

13.4.116 Datum

ACTION :

DEFAULT :

Zeroes the main traverse and resets the position counter. At the datum position,
the scanning transducers will be at co-ordinate position X=0, Y=0.
N/A
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13.4.117 Datum:Axis(Axis)

Axis -

ACTION:

DEFAULT:

Motor number.

Sets a datum position by moving onto a limit switch and then stepping a given

distance off the limit switch.
N/A

13.4.118 Declare:Common_Var(Var[,Type,Value])

Var -
Type -

Value
ACTION:

DEFAULT:
EXAMPLE:

1 - 128 character name for variable and size if declaring an array.

1 = Numeric.
2 = Text.
Initial value for a numeric variable.

Declares common variables (Single or Arrays) which retain there values when
other programs are loaded by CHAIN:PROGRAM. The variable must have

identical declarations in both programs.

If 'Type' is omitted then defaults to Numeric.
Declare:Common_Var(Count) { Numeric }
Declare:Common_Var(Reading[20],1) { Numeric array }

13.4.119 Declare:Global_Var(Var|[,Type])

Var -
Type -

ACTION:
DEFAULT:
EXAMPLE:

1 - 30 character name for variable and size if declaring an array.
1 = Numeric.

2 = Text.

Declares global variables (Single or Arrays)

If 'Type' is omitted then defaults to Numeric.
Declare:Global_Var(Count) { Numeric }

Declare:Global Var(Reading[20],1) { Numeric array }
Declare:Global Var(Name[20],2) { Text array }

13.4.120 Declare:Local_Var(Var[,Type,Value])

Var -
Type -

Value -

ACTION:
DEFAULT:

EXAMPLE:

1 - 128 character name for variable and size if declaring an array.
1 = Numeric.

2 = Text.

Initial value for a numeric variable.

Declares local variables (Single or Arrays)

If 'Type' is omitted then defaults to Numeric.
Declare:Local_Var(Count) { Numeric }
Declare:Local_Var(Reading[20],1) { Numeric array }
Declare:Local _Var(Name[20],2) { Text array }
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13.4.121 Define:Dynamic(Duration[, Delay, Start Line, Stop Line])

Duration -
Delay -

Start line -
Stop_line -

ACTION:
DEFAULT:
EXAMPLE:

0 - 60 seconds.
0 - 99.9 seconds.
1-256.

1-256.

Defines the Dynamic read control signals.

N/A

Define:Dynamic_Function(1,0.5,1,-0.5,2) Define:Dynamic(4,0.5,2)
Defines function 1 as 0.5*Sensor 1 - 0.5*Sensor 2. Dynamic control is then
defined as START signal on line 2. Delay of 0.5 seconds after receiving
START before gauging. Measurement time of four seconds. Dynamic
measurement is then enabled with Read:Dynamic.

13.4.122 Define:Function( Function Name, No. Params, Expression )

Function Name -
No. Params -
Expression -

ACTION:
DEFAULT:
EXAMPLE:

1 to 12 characters.
0 to 20.
Valid Procal expression 1 - 64 characters. Parameters included as AA, BB ...

Defines a function that may be used in Procal.

N/A
Define:Function(XYDIST,4,sqrt((AA-CC)*(AA-CC)+(BB-DD)*(BB-DD)))
EVALUATE(Distance:=XYDIST(X1,Y1,X2,Y2))

13.4.123 Define:Dynamic_Function(Function, Coefl, Sensor1, [Coef2,

Sensor2, ...])

Function -
CoefN -
SensorN -

ACTION:

DEFAULT:
EXAMPLE:

Function number 1 - 128.
Coefficient for Nth sensor.
Number of Nth sensor.

Defines one of the dynamic functions. All the sensors must be one the same
physical device, and the device must have dynamic capabilities. Up to eight
sets of 'Coef,Sensor' may be entered.

N/A

Define:Dynamic_Function(1,0.5,1,-0.5,2)

Defines function 1 as 0.5*Sensor 1 - 0.5*Sensor 2.
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13.4.124 Define:10_Serial(Port,Baud Rate,Parity,Word Length,Stop
Bits,Handshake)

Port -
Baud Rate -

Parity -

Word Length -
Stop Bits -

Handshake -

ACTION:
DEFAULT:

EXAMPLE:

1=Coml, 2 =Com?2 etc...
1=110

2=150

3=300

4 =600

5=1200

6 =2400

7=4800

8 =9600

0 =None
1 = Even Parity
2 = Odd Parity

7 - 8 Bits
1 - 2 Bits

0 = None
1=RTS -CTS
2 =XON - XOFF

Defines the serial parameters for the selected Port.
Baud = 9600

Word Length = 7 bits

Parity = Even

Stop Bits = 1

Handshake = None

Define:10_Serial(1,5,1,7,1,1)
Sets up serial port 1 to 1200 baud, even parity, 7 bit word length, 1 stop bit
and RTS - CTS handshake.

13.4.125 Define:10_Start(Line,Mode)

Line -
Mode -

ACTION :

DEFAULT :
EXAMPLE :

Input line 1 - 512.

0 = Negative edge.

1 = Positive edge.

X = Any state change.

Defines the source of an external START. The external START can be used
for calibration and measurement and is the same as pressing the START
button or F2 key on the keyboard.

N/A

Define:10_Start(1,1)

When input 1 changes from LOW to HIGH (Positive edge) and the
calibration or measurement sequence is waiting for a START, then program
execution will start.
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13.4.126 Define:Meas(Label,[Description,Nominal, USL,LSL,Class, Target

value])

Label -
Description -
Nominal -
USL -

LSL -

Class -

Target value -

ACTION :

DEFAULT :

1-10 characters

1- 24 characters

-9999.9999 - 9999.9999

-9999.9999 - 9999.9999

-9999.9999 - 9999.9999

0-4

When results are displayed, a deviation figure is shown. This deviation defaults to
being from the nominal. If, however a target value has been entered, the displayed
deviation will be from this target value.

Defines the above parameters of a measurement and allows the measurement to
be referred to using its label.
N/A

13.4.127 Define:Menu_Exit(Subroutine)

Subroutine -

ACTION:

DEFAULT:
EXAMPLE:

1 to 30 characters.

Calls Subroutine when a displayed menu is exited by the Operator pressing the
ESC or F10 keys.

N/A

Define:Menu_List(Motor Menu)

Define:Menu_Header(Motor Movement Menu)

Define:Menu_Options(Move Absolute,Move_abs)
Define:Menu_Options(Relative Move,Relative)

Define:Menu_Options(Move by Cursor,Cursor_move)
Define:Menu_Options(Exit,Exit Motor)

Define:Menu_Exit(Exit_Motor)

13.4.128 Define:Menu_Header(Header Text)

Header Text -

ACTION:
DEFAULT:
EXAMPLE:

1 to 30 characters.

Defines a header for a menu.

N/A

Define:Menu_List(Motor Menu)
Define:Menu_Header(Motor Movement Menu)
Define:Menu_Options(Move Absolute,Move_abs)
Define:Menu_Options(Relative Move,Relative)
Define:Menu_Options(Move by Cursor ,Cursor_move)
Define:Menu_Options(Exit,Exit Motor)
Define:Menu_Exit(Exit Motor)
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13.4.129 Define:Menu_List(Menu name)

Menu name -
ACTION:
DEFAULT:
EXAMPLE:

1 to 30 characters.

Defines a named Menu

N/A

Define:Menu_List(Motor Menu)
Define:Menu_Header(Motor Movement Menu)
Define:Menu_Options(Move Absolute,Move_abs)
Define:Menu_Options(Relative Move,Relative)
Define:Menu_Options(Move by Cursor ,Cursor_move)
Define:Menu_Options(Exit,Exit Motor)
Define:Menu_Exit(Exit Motor)

13.4.130 Define:Menu_Options(Menu item,Subroutine)

Menu item -
Subroutine -

ACTION:
DEFAULT:
EXAMPLE:

1 to 30 characters.
1 to 30 characters.

Calls Subroutine when Menu item is selected.

N/A

Define:Menu_List(Motor Menu)
Define:Menu_Header(Motor Movement Menu)
Define:Menu_Options(Move Absolute,Move_abs)
Define:Menu_Options(Relative Move,Relative)
Define:Menu_Options(Move by Cursor ,Cursor_move)
Define:Menu_Options(Exit,Exit_Motor)
Define:Menu_Exit(Exit Motor)

13.4.131 Define:Mode(Mode,Submode,Title,Flag)

Mode -
Submode -
Title -
Flag -

ACTION:
DEFAULT:

EXAMPLE 1:

EXAMPLE 2:

1 = Calibration, 2 = Measurement

1-256

0 — 64 characters

Calibration 0 = Normal calibration
1 = Plausibility

Measurement 0 = Statistics disabled

1 = Statistics enabled

Defines a mode which a Procal program may run in.
Calibration, Measure with Stats, and Measure without Stats.
{ Program may only be run in calibration }
Define:Mode(1,1,"",0)

{ Program may be run in 2 measurement modes, both without stats }
Define:Mode(2,1,"Normal",0)
Define:Mode(2,2,"Setup",0)
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13.4.132 Define:Screen(Screen Type,Screen No.[,Flag])

Screen Type - 1 = Standard measurement.
2 = User alpha screen.
3 = Machine tool feedback.
4 = User graphics screen.
5 = ActiveX Control (e.g. schematic display)
6 = Standard Calibration

Screen No. - 1-999.
Flag - 0 = Off.
1 = On (default).
ACTION: Defines an additional screen for the program display, or sets the display status

of an existing screen. The screen is specified by the screen number and
initially set to '0' - off, or '1' - on (flag default).
DEFAULT: N/A

13.4.133 Define:Table Float(Label,Register,Initial, Min,Max)

Label - 1 - 30 characters.

Register - External register 1 - 256.

Initial - Expression -999999.999 - 999999.999

Minimum - -999999.999 - 999999.999

Maximum - -999999.999 - 999999.999

ACTION: Defines a floating point entry for a previously set up table. The label appears on

the left hand side of the table, and the initial value may be entered as an
expression. The value is stored in the specified External register.
DEFAULT: N/A
EXAMPLE: Define:Table(40,4,15,0)
Define:Table Float("Scan Length X ",13,e[13],-50.0,50.0)
Display:Table

13.4.134 Define:Table(Table Title Text, OK Button Text, Cancel Button

Text)

Table Title Text - Text that appears at the top of a table.

OK Button Text - Use of this parameter will cause two buttons to be displayed, OK and
Cancel. Ok Button Text is the text that will appear on the OK button (left
hand button).

Cancel Button Text - This is the text that will appear on the Cancel button.

ACTION: Applies a title to a table and optional OK and Cancel buttons.

DEFAULT: N/A
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13.4.135 Define:Table_Integer(Label,Register,Initial, Min,Max)

Label - 1 - 30 characters.

Register - External register 1 - 256

Initial - Expression -32768 - 32767.

Minimum - -32768 - 32767.

Maximum - -32768 - 32767.

ACTION: Defines an integer entry for a previously set up table. The Label appears on the left

hand side of the table, and the initial value may be entered as an expression. The
value is stored in the specified External register.

DEFAULT: N/A

EXAMPLE: Define:Table(40,4,15,0)
Define:Table Integer("Number of Hits ",15,e[15],0,2000)
Display:Table

13.4.136 Define:Table_Option(Label,Register,Initial,Choicel[, Choice2, ..,

ChoiceN])
Label - 1 - 30 characters.
Register - External register 1 - 256.
Initial - 1-N
Choicel - 1 - 30 characters
ChoiceN - 1 - 30 characters.
ACTION: Defines an entry in a previously set up table. The label appears on the left hand

side of the table, and the various options, shown on the right of the table, may be
'toggled’ through. At least one option must be given, and any of the possible five
entries may be the default display. The option numbers are stored in the External

register.
DEFAULT: N/A
EXAMPLE: Define:Table(40,4,15,0)

Define:Table_Option("Find",11,e[11]+1,Nothing, Thickness)
Define:Table_Option(Sensor State,8,e[8]+1,0n/On/Nor,On/On/Pro|
,On/Off/Nor,Off/On/Nor,On/Off/Pro)

Display:Table
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13.4.137 Define

Label -
Register -
Initial -
Min -
Max -

ACTION:

DEFAULT:

:Table_Text(Label,Register,Initial,Min,Max)

1 - 30 characters.
Text register 1 - 10.
1 - 30 characters.
1-30.

1-30.

Defines a text entry for a previously set up table. The label appears on the left
hand side of the table, the minimum and maximum values are the string
lengths, and the entry is stored in the specified Text register.

N/A

13.4.138 Define:Transform_Angle(Angle)

Angle -
ACTION :
DEFAULT:

NOTES :
EXAMPLE :

0-360

Defines the angle to be used during rotational correction. Transforms the data by
an angular correction, usually to align a component with the axis.

N\A

In most cases, would use Compute:Centre_Line instead of this.
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13.4.139 Define:Transform_Offset(X,Y)

X- -999 - 999
Y - -999 - 999
ACTION : Defines the shift to be used during rotational correction. After an angular correction has

been applied, a translational offset is usually required such that the effective rotation is
about a point other than 0,0.

DEFAULT: N\A

EXAMPLE:

-
|
[ R
|
[
I

See Define: Transform Angle for example rotational correction prior to this translation.
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13.4.140 Define:User Key(Screen Type, Screen No. , Fkey, Button Text,
Subroutine, Icon Number, Password Level)

Screen Type - 1 = Standard measurement.
2 = User alpha screen.
3 = Machine tool feedback.
4 = User graphics screen.

Screen No. - 1-999.

Fkey - 2,3,4,5,6,7,8,9,11,12

Button Text - Text displayed under the button.

Subroutine - 6 characters.

Icon Number - Defines the icon that appears on the function key.

1 = Blank button
2 = Left arrow button (Previous)
3 = Right arrow button (Next)

4 = Printer
5 = Dialog Box
6 = Monitor
Password Level - 1 - 4. This parameter reflects the four password levels that can be set in the Pro-

Measure software. When a password level is set, the necessary or higher
password is required to activate the button function.

ACTION: Adds a PROCAL subroutine on to a particular screen type and number. The
subroutine is started by pressing the specified function key.
DEFAULT: N/A

13.4.141 Define:User_ Window(X[,Y,Width,Height,Ink,Paper,Title])

X - Top left column position on screen.

Y - Top line position on screen.

Width - Width of window in characters.

Height - Height of window in lines.

Ink - 0-15.

Paper - 0-7.

Title - Window title.

Colour: - 0 = Black 4 =Red 8 = Dk Grey 12 =Lt Red
1 = Blue 5 = Magenta 9 =Lt Blue 13 = Lt Magenta
2 = Green 6 = Brown 10 = Lt Green 14 = Yellow
3 =Cyan 7 = Lt Grey 11 =Lt Cyan 15 = White

ACTION: Defines a user text window of given size and colour to be displayed at the
specified screen position

DEFAULT: N/A

EXAMPLE: Define:User Window(10,10,60,10,15,4, MEASUREMENTS)
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13.4.142 Define:X_Origin(Expression)

Expression - Value of origin.

ACTION: Will cause the position specified by X to become the zero position for all future
measurements. This instruction is useful if aligning the measurement system to a
feature on the component.

EXAMPLE 1: Find(1,Edge,1)

Define:X_Origin(EX[1])
All x values are now relative to the position of edge 1.

EXAMPLE 2: Define:X Origin(EX[1])

This will cause the X origin (X=0) of the measurement system to coincide with
the absolute position of the edge EX[1]. All subsequent movements will be made
relative to this edge e.g. Move:AbsXY(0,0) will cause movement so that the
transducers are positioned over the edge which may be some distance fom the
machines datum position.

EXAMPLE 3: Define:X_Origin(0)

Using an X value of 0 will cause the measurement system to revert to the
original DATUM position for any subsequent movements.

DEFAULT: 0

13.4.143 Define:Zone(Number[,X min,X max,Y min,Y max,Z min,Z max])

Number - 1-30

X min - -999 - 999

X max - -999 - 999

Y min - -999 - 999

Y max - -999 - 999

Z min - -999 - 999

Z max - -999 - 999

ACTION : Defines a region in which a measurement will be taken.

Xmin X max
B A e 1) ¢

Any omitted parameters will default to machine limits i.e. -15.5 to +15.5 for Y
limits on P30.
DEFAULT: Maximum measurement range.
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13.4.144 Desc[n]

n- 1-256

ACTION: Returns the description for the n* dimension.
DEFAULT: N/A.

EXAMPLE: Write:Format("%s = %f",0,Desc[1],M[1])

13.4.145 Display:Dims(Start,Finish)

Start - 1-256.

Finish - 0 - 256.

ACTION: Causes the measurement displays to only show the specified range of
dimensions. If Finish = 0 then no dimensions are displayed.

DEFAULT: Displays all dimension at the end of program.

13.4.146 Display:Message(Message[,Y
Position,Height,Expressionl,...,Expression6])

Message -

Y Position -

Height -
Expression -

ACTION:
DEFAULT:

Format to be displayed.

%f = Float %d = integer
%s = String. \00 = ASCII code
1-20.

0 = Centre of screen.

Height of window 1,3, or 5 lines.

Up to six expressions to be inserted in the message. Numeric expressions can
be any valid PROCAL expression. Acceptable text registers include LAB[n],
DESC[n], TEXT[n].

Opens a window and displays 'Message'.

N/A

13.4.147 Display:Table(Variable Name)

Variable Name-

ACTION:

DEFAULT:

A variable that will store a value corresponding to the button that was
pressed.

1=0K

2 = Cancel

Stores the condition of an activation of the OK or Cancel buttons within a
table.

N/A
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13.4.148 Dmax|n]

n- 1-64

ACTION: Returns maximum diameter for the following find functions.
DIA, RDIA, STRAIGHT, [L/R] THREAD

DEFAULT: N/A.

13.4.149 Dmin|[n]

n- 1-64

ACTION: Returns maximum diameter for the following find functions.
DIA, RDIA, STRAIGHT, [L/R] THREAD

DEFAULT: N/A.

13.4.150 DO[n]

n- 1- 64

ACTION: Returns average offset from centreline ( DIA ) or
Offset from centre-line at minimum diameter ( RDia ).

DEFAULT: N/A.

13.4.151 Draw:Box(Xmin,Ymin,Xmax,Ymax[,Colour,Flag])

Xmin - 0-999.

Ymin - 0-999.

Xmax - 0-999.

Ymax - 0-999.

Colour - 0-15.

Flag - 0-1
0 = Not filled
1 = Filled

Colour: 0 = Black 4 = Red 8 = Dk Grey 12 =Lt Red
1 =Blue 5 = Magenta 9 =Lt Blue 13 = Lt Magenta
2 = Green 6 = Brown 10 = Lt Green 14 = Yellow
3 =Cyan 7 = Lt Grey 11 =Lt Cyan 15 = White

ACTION: Draws a box using the specified top left and bottom right Corner co-ordinates. If
not included, the colour defaults to the screen 'ink’, and the fill flag to '0' - not
filled.

DEFAULT: N/A
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13.4.152 Draw:Circle(Rx,Ry,Radius[,Colour])

Rx - 0-999.

Ry - 0-999.

Radius - 0-999.

Colour - 0-15.

Colour: 0 = Black 4 =Red 8 = Dk Grey 12 =Lt Red
1 =Blue 5 = Magenta 9 =Lt Blue 13 = Lt Magenta
2 = Green 6 = Brown 10 = Lt Green 14 = Yellow
3 =Cyan 7 = Lt Grey 11 =Lt Cyan 15 = White

ACTION: Draws a circle using the specified centre point and the Given radius. If not
included, the colour defaults to the screen 'ink'.

DEFAULT: N/A

13.4.153 Draw:Circular_Arc(Rx,Ry,Radius,Start Angle,Stop

Angle[,Colour])

Rx - 0-999.

Ry - 0-999.

Radius - 0-999.

Start Angle - 0 - 360.

Stop Angle - 0-360

Colour - 0-15.

Colour: 0 = Black 4 =Red 8 = Dk Grey 12 =Lt Red
1 =Blue 5 = Magenta 9 =Lt Blue 13 = Lt Magenta
2 = Green 6 = Brown 10 = Lt Green 14 = Yellow
3 =Cyan 7 = Lt Grey 11 =Lt Cyan 15 = White

ACTION: Draws a circular arc using the specified centre point and the given radius. The

angles entered should be in degrees, moving anticlockwise with zero at the top.
The colour of the arc is an optional parameter.
DEFAULT: N/A
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13.4.154 Draw:Line(Xmin,Ymin,Xmax,Ymax[,Colour])

Xmin -
Ymin -
Xmax -
Ymax -

Colour

Colour:

ACTION:

DEFAULT:

0-999.
0-999.
0-999.
0-999.

0-15.

0 =Black 4 =Red 8 = Dk Grey 12 =Lt Red

1 =Blue 5 = Magenta 9 =Lt Blue 13 = Lt Magenta
2 = Green 6 = Brown 10 = Lt Green 14 = Yellow

3 =Cyan 7 =Lt Grey 11 =Lt Cyan 15 = White

Draws a line between the given co-ordinate pairs. The colour defaults to the
current screen 'ink' unless specified.
N/A

13.4.155 Draw:R_Zone(Number)

Number -

ACTION :

DEFAULT:

1-30

Draws the region of a rotational scan lying within the specified zone. The data is
drawn in polar co-ordinates.
N/A

13.4.156 Draw:Zone(Number[,Scale_Both or Disp_Points])

Number -
Scale Both-

Disp_Points-

ACTION :

DEFAULT:

EXAMPLE:

1-30

Can be set to 1 or 0. If set to 1 scales both X and Y, giving a non-square grid and allows surface
detail to be examined. If set to 0, parameter ignored, same as if not present. This parameter cannot
be used at the same time as Disp_Points.

Can be set to 1 or 0. If set to 1 causes contents of Zone PointX[ ], Zone PointY[ ], Zone PointC[
] etc. to be used to display overlaid positions on the zone. This parameter cannot be used at the
same time as Scale Both.

A complex instruction which will draw the region of a scan lying within the specified zone. A
number of menu driven options are provided for 'zooming' and performing simple differential
measurements. This instruction can be useful for 'debugging' procal programs where exact
positioning on features of a component is difficult.

N/A

(Instructions to scan and define zone)
Draw:Zone(1)

This single instruction will cause the scanned data within zone 1 to be displayed. The display will
be similar to the following.
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61.092,13.444

7.664,-13.444 / 2.000

This produces a draw:zone which does not necessarily have the x grid size the same as the y grid
size.

Draw:Zone(l, 0, 1)

This enables the Draw:Zone to highlight features or positions within the Draw:Zone window by
using Zone:Points. It is possible using this function to display the calculated X position of edges,
or radii, etc..

13.4.157 Dump:Zone[n]

n-
ACTION:

DEFAULT:
EXAMPLE:

1-64

Writes the x, y position of all the points in the specified zone to any currently
open device.

N/A.

Open:File("Zone.dat",2)

Dump:Zone[2]

Close:File("Zone.dat")

13.4.158 DX[n]

n-
ACTION:
DEFAULT:

1-64
Average x position of all points in a diameter calculation.
N/A.
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13.4.159 DXMax|n]

n- 1-64
ACTION: X position of maximum diameter.
DEFAULT: N/A.

13.4.160 DXMin|[n]

n- 1-64
ACTION: X position of minimum diameter.
DEFAULT: N/A.

13.4.161 DynAverage|n]

ACTION : Returns the average value of Dynamic function n after executing Read:Dynamic.

13.4.162 DynMaximum|n]

ACTION : Returns the maximum value of Dynamic function n after executing Read:Dynamic.

13.4.163 DynMinimum|[n]

ACTION : Returns the minimum value of Dynamic function n after executing Read:Dynamic.

13.4.164 E[n]

n- 1-256
ACTION: General purpose variable.
DEFAULT: N/A.

13.4.165 Else

ACTION: Terminates the TRUE part of an IF statement and starts the FALSE part.
DEFAULT: N/A

13.4.166 Edge Offsets[Array][1]

ACTION : VPB calibration parameter set during full calibration in order to compensate for length
errors.
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13.4.167 EMail(Address,Subject,Message)

Address - Email address

Subject - Subject of message

Message - Text of message

ACTION : Sends an email message to the specified address. The Message parameter

forms the body of the message.

13.4.168 EMail:File(Address,Subject,Filename)

Address - Email address

Subject - Subject of message

Filename - Text file to be sent

ACTION : Sends an email message to the specified address. The body of the message is

formed from the contents of the specified file.

13.4.169 End:If

ACTION: Terminates an IF statement.
DEFAULT: N/A
EXAMPLE: If(Expression)

{PROCAL Instructions here}

End:If

If(Expression)

"

{PROCAL Instructions here}

"

Else

"

{Some more PROCAL Instructions here}

End:If

13.4.170 End:Measure

ACTION: Tells the system that a measurement cycle has completed. See also
Statistics:Update.
DEFAULT: Updated at end of program.

13.4.171 End:Standard

Defines the end of the database program, and should always be placed at the bottom of the database program.
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13.4.172 End:StdTable

Defines the end of a group of nominal or grades.

13.4.173 End:Sub

ACTION : Marks the end of a subroutine.
DEFAULT: N/A

13.4.174 Evaluate(Expression)

Expression -
ACTION:
DEFAULT:

1 - 256 characters.
Evaluates the expression given. May be used to assign values to variables.
N/A

13.4.175 Evaluate:Text(Text Var,E Register,First,Last)

Text Var -
E Register -
First -

Last -
ACTION:

DEFAULT:
EXAMPLE:

13.4.176 EX[n]

n-
ACTION:

DEFAULT:

13.4.177 EY[n]

n-
ACTION:

DEFAULT:

Name of a text variable or number of a TEXT register in which to place the text.
Number of the E register in which to evaluate the string.

Position of first character to be used.

Position of last character to be used.

Reads a series of characters (bytes) from the string as a number. Up to 4 bytes
may be read from the string and are evaluated in ascending order:

The 1st byte gives bits 0-7

The 2nd byte gives bits 8-15

The 3rd byte gives bits 16-23

The 4th byte gives bits 24-31

N/A

Evaluate: Text(abcdef,4,1,1) { a=97 so 97 to e[4] }
Evaluate:Text(abcdef,5,2,3) { b=98, c=99 so 98+99*256 to e[4] }

1-64

returns X position of edge ( EDGE, IPE )
Average of max and min X values ( RUNOUT )
N/A.

1-64

returns Y position of edge ( EDGE, IPE )
Average of max and min Y values ( RUNOUT )
N/A.
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13.4.178 F[n]

n- 1-256
ACTION: General purpose variable.
DEFAULT: N/A.

13.4.179 Failed(Start,End)

Start - 1-256
End - 1-256
ACTION: Returns the none zero if any of features in the specified range have failed.
DEFAULT: N/A.
EXAMPLE: If(Failed(3,10)=5)
Display:Message("Station 2 Failed")
Else

Display:Message("Station 2 Passed")

13.4.180 File:Copy(Source,Destination)

Source - Filename to copy from.

Destination - Filename to copy to.

ACTION: Makes a copy of the specified file. Each filename may include a full DOS path.
DEFAULT: N/A

EXAMPLE: File:Copy(FILE.DAT,COPY.DAT)

Copies the file 'FILE.DAT to a file named 'COPY.DAT".

13.4.181 File:Delete(File)

File - A valid OS filename

ACTION: Deletes the specified DOS file. The file must NOT be a folder.
DEFAULT: N/A

EXAMPLE: File:Delete(FILE.DAT)
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13.4.182 File:Exist(File,Register)

File A valid DOS file or path.

Register An External register 1 - 256.

ACTION: Test for the existence of the file. Puts 1 in E[Register] if it exists otherwise puts
0.

DEFAULT: N/A

EXAMPLE: File:Exist(sysdata\\last.set, 1)
If(e[1])

Open:File(sysdata\\last.set,4)
Read:Format(%d\0d\0a%d\0d\0a%d\0d\0a,0,10)
Read:Format(%d\0d\0a%d\0d\0a,0,13) { report dests }
Close:File(sysdata\\last.set)

Else

Evaluate(e[10]:=8)

Evaluate(e[11]:=1)

Evaluate(e[12]:=1)

Evaluate(e[13]:=1)

Evaluate(e[14]:=1)

End:If

13.4.183 File:Length(File,Register)

File - 1 — 256 characters.

Register - 1 — 256 E register to place result.

ACTION: Returns the length of the specified file.

DEFAULT: N/A.

EXAMPLE: File:Length("c:\\autoexec.bat",2)
Display:Message("autoexec.bat is %d bytes long",0,0,E[2])
Wait:Key

Clear:Message
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13.4.184 Filter:Fourier(CutOff,Zone,Threshold)

CutOff -
Zone -
Threshold -

ACTION:

DEFAULT:

EXAMPLE:

1-20

1-20

A value about a nominal position on which the filter acts on the scanned data. The
filter 'cleans' any data outside the threshold level on the positive and negative position
from the nominal. Any value is valid but must be less than the max-min limits of the

scanned data to have an effect.

Filters all the data contained within the specified zone.

N/A.
Define:Zone(1,10,20,-10,10)
Filter:Fourier(2,1,0.4 )

13.4.185 Filter:Gaussian(Factor,Zone)

Factor -
Zone -

ACTION:

DEFAULT :
EXAMPLE:

1-20
1-20

Filters all the data contained within the specified zone.
N/A

Define:Zone(1,10,20,-10,10)

Filter:Gaussian(6,1)
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13.4.186 Find(Register,Feature,Zonel,Zone2,,,,)

Register
Feature -
Zone -

ACTION:

DEFAULT :

Note :

FIND also has variations:
Find:AV, Find:Av:Max,
Find:AV:MIN, Find:Max:Min,
Find:AV:Max:MIN

Number of register (1-64) to place measured value.

The feature to find.

The number of the zone (1-64) where the feature is to be found, (more than one
zone may be specified for certain features).

Performs a measurement within the specified zones, placing the results in the
specified register. The feature can be user defined or one of the following :
Conc

Conc:Gauge

Conc:Max

Dia

Edge

First Max

Fixed Rad

Form:Line

Form:Rad

Grad GT

H_Angle

I_Angle

Thread:Maj
U _Thread

U _Taper
Zone:Limits
N/A

These only find the specified measurements, if applicable.
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13.4.187 Find(n,Expression,z) - User defined functions.

n- Measurement Register

Expression - Any valid procal expression, involving the PX and PY variables for the individual data
points.

z- The number of the zone to use. The type of zone required will depend on the intended

effect of the function.

ACTION : Evaluates the expression for each data point within the zone, and returns maximum,
minimum and average.
REGISTERS : MAX][n] - maximum value of Expression

MIN([n] - minimum value of Expression
AV[n] - average value of Expression
XMAX]|n] - X position of point for which Expression had maximum value
YMAX[n] - Y position of point for which Expression had maximum value
XMIN[n] - X position of point for which Expression had minimum value
YMIN[n] - Y position of point for which Expression had minimum value
EXAMPLES: Find(1,PX[#],1) { find max / min / av X values in zone 1 }
Find(2,sqrt(PX[#]*PX[#]+PY[#]*PY[#]),1) { find closest and furthest points from origin
1

5
Find(3,(PY[#+1]-PY[#-11)/(PX[#+1]-PX[#-1]),1) { gradient between consecutive points }

13.4.188 Find(n,Conc,z)

n- Measurement register.

z- Zone to use.

ACTION: Average offset from centre-line.

Zone: Uses a single zone encompassing a complete diameter, which is then split into

upper and lower zones. Zone must incorporate rotation, and there must be data
from at least two different angular positions. (If only two, these cannot be 180°
apart).

Registers: CX|[n] - Average of x positions of all points used in concentricity
Measurement.
CY[n] - Average offset from centre-line in y direction
CZ[n] - Average offset from centre-line in z direction

13.4.189 Find(n,Dia,z)

n- Measurement register.

z- Zone to use.

ACTION: Diameter in a given zone (max min average), positions of these, and offset from
centre line.

Zone: Uses a single zone encompassing a complete diameter, which is then split into
upper and lower zones. Can be used on zones incorporating rotation.

Registers: D[n] - Average diameter in zone. (if find av)

DO[n] - Average offset from centreline of measured diameter. (if find_av)
DX[n] - Average x position of all points used. (if find_av)

DMIN[n] - Minimum diameter measured. (if find_min)

DXMIN[n] - X position of minimum diameter (if find_min)

ZMIN[n] - Rotational position of minimum diameter (if find_min)
DMAX[n] - Maximum diameter measured. (if find_max)

DXMAX][n] - X position of maximum diameter (if find_max)

ZMAX[n] - Rotational position of maximum diameter (if find max)
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13.4.190 Find(n,Conc:Gauge(Dia),z)

n -

Dia -

Z -
ACTION:

Registers:

Measurement register.

Diameter to test concentricity at.

Zone to use.

Concentricity at a given diameter on (for EXAMPLE) a chamfer.

Zone: Uses a single zone encompassing a complete diameter, which is then
split into upper and lower zones. The zone must be scanned in the x direction in
more than one rotational position.

CX[n] - Average of x positions of all points used in concentricity
Measurement.

CY[n] - Average offset from centre-line in y direction.

CZ[n] - Average offset from centre-line in z direction.

13.4.191 Find(n,Conc:Max,z)

n -

z -
ACTION:
Zone:

Registers:

Measurement register.

Zone to use.

Concentricity of the maximum diameters.

Uses a single zone encompassing a complete diameter, which is then split into
upper and lower zones. The zone must be scanned in the x direction in more
than one rotational position.

CX|n] - Average of x positions of all points used in concentricity
Measurement.

CY[n] - Average offset from centre-line in y direction

CZ[n] - Average offset from centre-line in z direction

13.4.192 Find(n,T_Conc,z)

n -

Z -
ACTION:
Zone:

Registers:

Measurement register.

Zone to use.

Concentricity of a thread.

Uses a single zone encompassing a complete diameter, which is then split into
upper and lower zones. Should be called several times with different rotational
positions of the thread.

CX[n] - Average X of all points used in concentricity measurement.

CY|[n] - Average offset from centre-line in Y direction

CZ[n] - Average offset from centre-line in Z direction

13.4.193 Find(n,Edge(e),z)

n -

e -

Z -
ACTION:
Zone:

Registers:

Measurement register.

Number of edges to find. DEFAULT =1

Zone to use.

Positions of one or more edges in the zone.

Zone including a vertical edge. For single edges, nothing other than the edge
itself should be included. For multiple edges, a zone should be defined which
includes all the relevant edges.

EX[n] - The X position of the edge

EY[n] - The Y position of the edge

If multiple edges are requested then the results will be placed in n+1 etc.
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13.4.194 Find(n,First_Max,z)

n Measurement register

zZ Zone to use

ACTION: Position of first local maximum.

Zone: A zone including a single surface, where at least one local maximum is present.
(either a bump on the surface or part of a thread).

Registers: XMax[n] -The X position of the maximum

YMax[n] -The Y position (i.e. value) of the maximum

13.4.195 Find(n,Fixed_Rad( Rad),z)

n- Measurement register.

Rad - Nominal Radius.

z- Zone to use.

ACTION: Finds the position of the specified radius within the zone.
Zone: A zone containing a radius of "Rad" scanned in the x direction.
Registers: R[n] - Radius ( This will be the value "Rad" ).

RX[n] - The X position of the centre of the radius.
RY[n] - The Y position of the centre of the radius.
MRANGE|n] -Range of deviations from best fit circle.
MSIGMA[n] - RMS deviation from best fit circle.

13.4.196 Find(n,Form:Line,z)

n- Measurement register.
z- Zone to use.
ACTION: Finds the deviation of the component form for a line feature within the

specified zone.

13.4.197 Find(n,Form:Rad,z)

n- Measurement register
Z- Zone to use
ACTION: Finds the deviation of the component form for a radius feature within the

specified zone.

13.4.198 Find(n,Grad_GT(Grad,NP),z)

n- Measurement register.

Grad - gradient (slope of line) required.

NP - number of points to measure gradient over.

z- Zone to use.

ACTION: The first position at which the gradient increases beyond a specified value.

Zone: Any zone with surfaces scanned in the x-direction.

Registers: XAV [n] - First position in zone where gradient is greater than the
stated
Amount
YAV [n] - First position in zone where gradient is greater than the stated
Amount
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13.4.199 Find(n,H_Angle,z)

n- Measurement register.

z- Zone to use.

ACTION: Half angle of line fitted to all points in the zone, and deviation from line used.
Zone: Zone including only points which are nominally in a straight line.

Registers: A [n] - Angle of line to machine axis

MRange[n] - Range of deviations from calculated line
MSigma[n] - RMS deviation from calculated line

13.4.200 Find(n,I_Angle,z)

n- Measurement register.

Z- Zone to use.

ACTION: Included angle between lines fitted to surfaces either side of the centre-line, and
deviation of the points from these lines.

Zone: Uses a single zone encompassing a complete diameter, which is then split into

upper and lower zones, each of which should only include points which are
nominally in a straight line.
Registers: A [n] - Angle between upper and lower lines
MRange[n] - Range of deviations from calculated lines.
MSigma[n] - RMS deviation from calculated lines.

13.4.201 Find(n,IPE,z)

n- Measurement register.

z- Zone to use.

ACTION: Position of a specified change of radius.

Zone: Uses a single zone encompassing a complete diameter, which is then split into
upper and lower zones.

Registers: Ex[n] - The X position of the edge

Ey[n] - The Y position of the edge
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13.4.202 Find(n,L_Taper( MidX ),z)

n-
MidX -
A

ACTION:

Zone:

Registers:

Measurement register.
Middle of the thread.
Zone to use.

Uses a single zone encompassing a complete diameter, which is then split into
upper and lower zones.

D[n] - Effective thread diameter

Dmax[n] - Average outer diameter (between tops of threads)
Dmin[n] - Average inner diameter (between bottoms of threads)
TP[n] - Average pitch of thread.

A[n] - Left flank angle

A[n+1] - Right flank angle

Ex[n] - Usable length

LA[n] - Taper Angle

Dmax[n+1] - Crest Truncation

Dmin[n+1] - Root Truncation

13.4.203 Find(n,L_Thread,z)

n-
Z -

ACTION:

Zone:

Registers:

Measurement register.

Zone to use.

Measure outer, inner and effective diameters, pitch, flank angles, root radius,
cumulative lead and taper of a thread.

Uses a single zone encompassing a complete diameter, which is then split into
upper and lower zones.

D[n] - Effective thread diameter

Dmax[n] - Average outer diameter (between tops of threads)

Dmin[n]- Average inner diameter (between bottoms of threads)

TP[n] - Average pitch of thread.

A[n] - Left flank angle

A[n+1] - Right flank angle

R[n] - Root radius (radius of best fit circle to bottom of centre trough)

LA[n] - Total length of all leading edges.

S[n] -Taper
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13.4.204 Find(n,L_Worm(Pdia,Starts),z)

n -
Pdia -
Starts -
Z -

ACTION:

Zone:

Registers:

Measurement register.

Nominal Pitch Diameter.

Number of thread starts.

Zone to use.

Measure outer, inner and effective diameters, pitch, flank angles, and, tooth
width of a thread.

Uses a single zone encompassing a complete diameter.

D[n] - Effective thread diameter

Dmax[n] - Average outer diameter (between tops of threads)
Dmin[n] - Average inner diameter (between bottoms of threads)
TP[n] - Average pitch of thread.

Al[n] - Left flank angle

A[n+1]- Right flank angle

LA[n] - Average tooth width.

13.4.205 Find(n,LS_Line,z)

n-
Al

ACTION:

Zone:

Registers:

Measurement register.

Zone to use.

Best straight line fit to all the points in the zone, and deviation from this line.
Zone including only points which are nominally in a straight line.
S[n] - Slope of line

I[n] - Intercept of line (value of y at x=0)

LA[n] - Factor for expressing line as ax+by+c=0

LB[n] - Factor for expressing line as ax+by+c=0

LCI[n] - Factor for expressing line as ax-+by+c=0

MRange[n] - Range of deviations from calculated line.
MSigmal[n] - RMS deviation from calculated line.

13.4.206 Find(n,LS_Rad,z)

n-
Al

ACTION:

Zone:

Registers:

Measurement register.

Zone to use.

Best fit circle to all points in the zone, and deviation from this circle.
Zone including only points which are nominally on a single circle.
R[n] - Radius of best fit circle

RX[n] - X position of centre of best fit circle

RY[n] - Y position of centre of best fit circle

MRange[n] - Range of deviations from best fit circle.

MSigmal[n] - RMS deviation from best fit circle.
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13.4.207 Find(n,R_Taper( MidX ),z)

n-
MidX -

YA

ACTION:

Zone:

Registers:

Measurement register.
Middle of the thread.
Zone to use.

Uses a single zone encompassing a complete diameter, which is then split into
upper and lower zones.

D[n] - Effective thread diameter

Dmax[n] - Average outer diameter (between tops of threads)
Dmin[n] - Average inner diameter (between bottoms of threads)
TP[n] - Average pitch of thread.

A[n] - Left flank angle

A[n+1] - Right flank angle

Ex[n] - Usable length

LA[n] - Taper Angle

Dmax[n+1] - Crest Truncation

Dmin[n+1] - Root Truncation

13.4.208 Find(n,R_Thread,z)

n-
Z -

ACTION:

Zone:

Registers:

Measurement register.

Zone to use.

Measure outer, inner and effective diameters, pitch, flank angles, root radius,
cumulative lead and taper of a thread.

Uses a single zone encompassing a complete diameter, which is then split into
upper and lower zones.

D[n] - Effective thread diameter

Dmax[n] - Average outer diameter (between tops of threads)

Dmin[n] - Average inner diameter (between bottoms of threads)

TP[n] - Average pitch of thread.

Al[n] - Left flank angle

A[n+1] - Right flank angle

R[n] - Root radius (radius of best fit circle to bottom of centre trough)

LA[n] - Total length of all leading edges.

S[n] -Taper
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13.4.209 Find(n,R_Worm(Pdia,Starts),z)

n -

Pdia -
Starts -

Z -
ACTION:

Zone:
Registers:

Measurement register.

Nominal Pitch Diameter.

Number of thread starts.

Zone to use.

Measure outer, inner and effective diameters, pitch, flank angles, and, tooth
width of a thread.

Uses a single zone encompassing a complete diameter.

D[n] - Effective thread diameter

Dmax[n] - Average outer diameter (between tops of threads)
Dmin[n] - Average inner diameter (between bottoms of threads)
TP[n] - Average pitch of thread.

Al[n] - Left flank angle

A[n+1]- Right flank angle

LA[n] - Average tooth width.

13.4.210 Find(n,Radius,z)

n-
A
ACTION:

Zone:

Registers:

Measurement register.

Zone to use.

Max, min, and average radius, and where this occurs. Also max, min, av X
values.

Zone completely above the machine axis. Would generally be used with
scanning in the rotational direction.

Xav[n] - Average X of all points in zone

Yav[n] - Average Y of all points in zone

Xmin[n] - Minimum x position in zone

Ymin[n] - Minimum y position (radius) in zone

Zmin[n] - Rotational position at which minimum radius occurs.
Xmax[n] - Maximum X position in zone

Ymax[n] - Maximum y position (radius) in zone

Zmax[n] - Rotational position at which maximum radius occurs.

13.4.211 Find(n,Rdia,z)

n-
Z_

ACTION:

Zone:

Registers:

Measurement register.

Zone to use.

Values and rot. positions of max and min diameter; offset from centre-line at
min.

Uses a single zone encompassing a complete diameter, which is then split into
upper and lower zones. The scan should incorporate a rotational element,
although the range of rotation may be limited.

D[n] - Average of average diameters

Dmin[n] - Smallest average diameter

Dmax[n] - Largest average diameter

Zmin[n] - Rotational position at which minimum diameter occurs

Zmax[n]- Rotational position at which maximum diameter occurs

Dx[n] - Average of X positions of all points in zone

Do[n] - Offset from centre-line at min diameter (across flats symmetry)
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13.4.212 Find(n,Runout(Cl),z)

n -

Cl-

A
ACTION:

Zone:
Registers:

Measurement register.

Measurement register containing a computed centre line.

Zone to use.

Various forms of runout in both x and y direction, and positions of also one of
(position of edge; distance between faces; offset from extrapolated position).
A rotational zone is required.

CX][n] - Runout in x direction

CY[n] - Runout in y direction

EX[n] - Average of max and min average x values

EY[n] - Average of max and min average y values

13.4.213 Find(n,Straight,z)

n-
Z -
ACTION:

Zone:

Registers:

Measurement register.

Zone to use.

Two measures of straightness, 2D centre-line and max/min diameter relative to
this.

Uses a single zone encompassing a complete diameter, which is then split into
upper and lower zones.

R[n] - Straightness - difference between maximum average deviations from
centre-line in each direction.

Dmax[n] - Max diameter

Dmin[n] - Min diameter

Rx[n] - RMS deviation from centre-line

S[n] - Slope of centre-line, Xy plane

I[n] - Intercept of centre-line, Xy plane

S[n+1] - Slope of centre-line, xz plane

I[n+1] -Intercept of centre-line, xz plane

13.4.214 Find(n,TDia,z)

n -

Z -
ACTION:
Zone:

Registers:

Measurement register.

Zone to use.

Maximum turned diameter.

Uses a single zone encompassing a complete diameter, which is then split into
upper and lower zones.

D[n] - Maximum turned diameter
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13.4.215 Find(n,TDMin,z)

n -

Z -
ACTION:
Zone:

Registers:

Measurement register.

Zone to use.

Minimum turned diameter (stock metal diameter).

Uses a single zone encompassing a complete diameter, which is then split into
upper and lower zones. Can also be used on a zone incorporating rotation.
D[n] - Minimum turned diameter

13.4.216 Find(n,Thick,z)

n-
A
ACTION:

Zone:

Registers:

Measurement register

Zone to use

Thickness of material in this zone (max min average), and positions of these.
Does not split the zone unto upper and lower sections.

Uses a single zone encompassing a complete diameter, or any other feature
which has an upper and lower surface.

Min[n] - Minimum thickness

Xmin[n] - X position of minimum thickness

Ymin[n]- Y position of minimum thickness

Max|n] - Maximum thickness

Xmax[n] - X position of maximum thickness

Ymax[n] - Y position of maximum thickness

Xav[n] - Average X of all points

Yav[n] - Average Y of all points

13.4.217 Find(n,Thread:Maj,z)

n -

Z -
ACTION:
Zone:
Registers:

Measurement register.
Zone to use.

Uses a single zone encompassing a complete diameter.
S[n] Slope of line

I[n] Intercept of line (value of y at x=0)

LA[n] Factor for expressing line as ax+by-+c=0

LBI[n] Factor for expressing line as ax+by+c=0

LC|[n] Factor for expressing line as ax+by+c=0
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13.4.218 Find(n,U_Taper(PitchNom,LFlankNom,RFlankNom[,Diameter,R
ange Plane|),z)

FindsTaper thread details on gauges without special thread measurement hardware (un-slewed).
n - Measurement register.
z- Zone to use.

13.4.219 Find(n,U_Thread(PitchNom,LFlankNom,RFlankNom),z)

FindsThread details on gauges without special thread measurement hardware (un-slewed).
n- Measurement register.
z- Zone to use.

13.4.220 Find(n,Zone:Limits,z)

n- Measurement register.

z- Zone to use.

ACTION: Scanning range to cover a given zone.

Zone: Any

Registers: Xmin[n] Minimum X position to start scanning from
Xmax[n] Maximum X position to scan to

13.4.221 Format:Display(Dimension Start,Dimension End,State,Operating

Mode)

Dimension Start - Number of first dimension.
Dimension End - Number of last dimension.
State - 0 = Not Displayed.

1 = Displayed.

2 = Display if Failed.

3 = Display if Passed.
Operating Mode - 0 = All cases.

1 = Calibration.

2 = Measurement.
ACTION : Defines which Dimensions are displayed on the

measurement displays.
DEFAULT : All Displayed
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13.4.222 Format:Numeric(Characteristic,mantissa)

Characteristic - 1-4.
Mantissa - 1-5.
ACTION : Specifies the number of digits before and after the decimal point.

13.4.223 Format:RTdisplay(Dimension Start,Dimension
End,State[,Operating Mode])

Dimension Start - Number of first dimension.
Dimension End - Number of last dimension.
State - 0 = Not Displayed.

1 = Displayed.

2 = Display if Failed.

3 = Display if Passed.
Operating Mode - 0 = All cases.

1 = Calibration.

2 = Measurement.

ACTION: Redefines which dimensions will be displayed at run time.
DEFAULT All Displayed

13.4.224 Format:Text(Text Var,Message[,Expressionl,...,Expression8])

Text Var - Text variable or number of a TEXT register.

Message - Format to be sent
%f = Float %d = integer
%s = String. \00 = ASCII code

Expression - Up to eight expressions can be inserted in the message in place of the %f,%d, and,
%s.

ACTION: Constructs a text string and passes it to a text variable.

DEFAULT: N/A

EXAMPLE: Format:Text(1,The time is %s,TIME) { Time into TEXT[1] }

Format: Text(2,Label two is %s,LAB[2]) { Label 2 into TEXT[2] }
Declare:Global_Var(DateTxt,2) { Declare a string }
Format:Text(DateTxt, The date is %s,DATE[4])

{ The DATE array holds the date in 4 different formats: }

{ DATE[1] = DD/MM/YY }

{ DATE[2] = YYMMDD }

{ DATE[3] = MM/DD/YY }

{ DATE[4] = MMDDYY }
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13.4.225 Gosub(Name[,Expressionl,...,Expression9])

Name - 1 - 30 characters.
Expression - Up to 9 valid PROCAL expressions.
ACTION: Causes program execution to jump to subroutine 'Name'.

Program execution continues until the END:SUB statement is encountered and
then returns to the line after the GOSUB. Passed expressions are evaluated and
stored in the local variables defined in the BEGIN:SUB keyword.

DEFAULT: N/A

13.4.226 Goto(Mark)

Mark - 1 - 30 characters.
ACTION: Unconditional jump to the line after the defined 'Mark'.
DEFAULT: N/A

13.4.227 Grade:Table(FeaturelD, FeatureParameterID, TableIndex)

Defines the grade table for a particular measurement parameter.

FeaturelD The feature type to which the grade table relates.
FeatureParameterID The Parameter type on the specified feature to which the grade table relates.
TableIndex A unique number to identify the grade table.

13.4.228 Helix:Abs(Angle)

Angle - 0-6
ACTION : Sets the machine helix angle to the specified value, for measuring threads.
DEFAULT: N/A

13.4.229 I|n]

n- 1-64

ACTION: Returns Intercept of line (LS _LINE ) Intercepts of zone centre-line in xy and
xz planes ( STRAIGHT ).

DEFAULT: N/A.
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13.4.230 If(Expression[,Mark])

Expression - A valid PROCAL expression.
Mark - 1 - 30 characters.
ACTION: If 'Mark' is present and 'expression' is TRUE then execution jumps to 'Mark'. If

'Mark' is present and 'expression' is FALSE then execution continues normally.
If 'Mark' is not present and 'expression' is TRUE then execution continues until
the next ELSE or END:IF. If 'Mark' is not present and 'expression’ is FALSE
then execution jumps to the next ELSE or END:IF statement.

This command can be a single statement

ie.

If(Expression, Mark)

Or a Multiple Statement
i.e.
H(Expression)
Goto(Mark)
End:If

DEFAULT: N/A

EXAMPLE 1: If(M[10]>2,Too Big) { If greater than 2 goto Too Big }
IfM[10]<1)
Display:Message(Too Small.) { If less than 1 do this }
Else
Display:Message(Just Right.) { else do this }
End:If
Stop
Mark(Too Big)
Display:Message(Too Big.)
Wait:Key
IfM[11]>3)
Display:Message(M11 is also too big.)
Wait:Key
IfM[12]>3)
Display:Message(M12 is also too big.)
Else
Display:Message(M12 is just right.)
End:If
Else
Display:Message(M11 is just right.)
End:If

13.4.231 Include:Library

ACTION: Automatically include all Procal segments which are contained in the Procal
Library folder.
DEFAULT: N/A
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13.4.232 Include:Segment(Filename)

Filename -

ACTION :

DEFAULT :

Name of segment to include.

Inserts the PROCAL program 'Filename' into the calling program. 'Filename' can
include a drive and path, otherwise the folder of the calling segment is used.
N/A

13.4.233 Init:Polynomial(Order1,[Order2,0rder3,0rder4,0OrdersS,
Order6])

Orderl -
Order?2 -
Order3 -
Order4 -
OrderS5 -
Order®6 -
ACTION:

DEFAULT:
EXAMPLE:

SO OO O
]
DB L W W

0-

Initialises the Polynomial calculations and specifies which orders are required.
See also Compute:Polynomial and Add:Polynomial.

N/A

{ Initialise for 0 and 1** orders }

Init:Polynomial(0,1)

13.4.234 Initialise:Text

ACTION:

Used to set an initial value for a text variable as a program is loaded.
Parameters and function same as Format:Text but run once at program load.

13.4.235 LA[n]

n -
ACTION:

DEFAULT:

1-64

Returns Factor for expressing line as ax+by+c=0 ( LS_LINE )
Total length of all leading edges ( [L/R] THREAD )

N/A.

13.4.236 Lab[n]

n-
ACTION:
DEFAULT:
EXAMPLE:

1-256

Returns the label for the n dimension.
N/A.

Write:Format("%s = %f", 0, Lab[1], M[1])
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13.4.237 Language:Text(LanguagelD, Var, Text)

LanguagelD -

Var -

Text -
ACTION:
EXAMPLE:

Currently supported language IDs are:

0x0809 = English / UK

0x040C = French / France

0x0407 = German / Germany

0x041D = Swedish / Sweden

1 - 128 character name for variable

Text value for this variable in the specified language.
Declares a language sensitive text variable. T
Language:Text( 0x0809, LT PleaseWait, "Please wait..." ) Language: Text(
0x040C, LT PleaseWait, "Veuillez patienter..." )
Display:Message(LT PleaseWait)

13.4.238 Last_Machine_Save

ACTION :

13.4.239 LB[n]

n-
ACTION:

DEFAULT:

13.4.240 LC[n]

n -
ACTION:
DEFAULT:

Returns a text string with the last time a Save:Machine Data was executed.

1-64
Returns Factor for expressing line as ax+by+c=0 ( LS_LINE )

N/A.

1-64
Returns Factor for expressing line as ax+by+c=0 (LS_LINE )
N/A.

13.4.241 Length:Text(Text Var,E Register)

Text Var -
E Register -

ACTION:
DEFAULT:
EXAMPLE:

Name of a text variable or number of a TEXT register
Number of the E register in which to store the length

Calculates the length of a text string and stores it in the specified E register.
N/A

Length: Text(abcdef,2) { Stores 6 in e[2] }

Declare:Local Var(UserName,2)

Format:Text(UserName,John Smith)

Length: Text(UserName,1) { Stores 10 in e[1] }
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13.4.242 Limits:Warning(Dimension,Upper,Lower)

Dimension - Dimension Number

Upper - Percentage of Upper Limit 1- 100 percent.

Lower - Percentage of Lower Limit 1 - 100 percent.

ACTION : Assigns the warning limits for the specified dimension
DEFAULT: 100 percent.

EXAMPLE: Limits:Warning(1,50,50)

Sets the limits for the warning rework, and warning reject classification of
dimension 1 to Upper limit = 10.5 and Lower limit = 9.5 in an example where
the Nominal was set to 10, USL =1 and LSL = -1.

13.4.243 Load:Machine_Data
ACTION: Reads all the machine settings in from the registry.

13.4.244 LSL[n]

n- 1-256

ACTION: Returns the Lower Specified Limit for the n' dimension.
DEFAULT: N/A.

EXAMPLE: Write:Format("%s LSL = %f",0,Desc[1], LSL[1])

13.4.245 LWL|[n]

ACTION : Sets or returns the Lower Warning Limit for the nth dimension.

13.4.246 M|n]

n- 1-256

ACTION: Returns the measured value for the n" dimension.
DEFAULT: N/A.

EXAMPLE: Write:Format("%s = %f", 0, Desc[1], M[1])

13.4.247 Machine_Type

ACTION: Returns the Profile machine as a size
20 = Profile 20
30 = Profile 30
80 = Profile 80
DEFAULT: N/A.
EXAMPLE: If(Machine Type=20)

Gosub("Calibrate Profile 20")
Else If(Machine Type = 30)
Gosub("Calibrate Profile 30")
Else

Gosub("Calibrate Profile 80")
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13.4.248 Mark(Mark)

Mark - 1 - 30 characters.
ACTION: Defines a point in the program for the IF and GOTO words.
DEFAULT: N/A

13.4.249 Mark:Try(Mark)

Mark - 1 - 30 characters.
ACTION: Defines a point in the program for the RECOVER word.
DEFAULT: N/A

13.4.250 Max|n]

n- 1-64
ACTION: Returns Maximum of a user expression Maximum thickness ( THICK ).
DEFAULT: N/A.

13.4.251 Menu(Menu Name)

ACTION: Displays named menu.
ACTION: Displays a previously defined menu.
DEFAULT: N/A

13.4.252 Mid:Text(Text Var,Source Text,First,Last)

Text Var - Name of a text variable or number of a TEXT register
in which to place the text.

Source Text - Specified source text (May also be a TEXT variable).

First - Position of first character to be used.

Last - Position of last character to be used.

ACTION: Copies a text selection from some specified text or text variable into another
text Variable.

DEFAULT: N/A

EXAMPLE: Mid: Text(1,abcdef,2,3) { Store 'bc' in TEXT[1] }

Declare:Local Var(UserName,2)
Format: Text(2,John Smith)
Mid: Text(UserName, TEXT[2],1,4) { Store 'John' in UserName }
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13.4.253 Min|[n]

n-
ACTION:
DEFAULT:

1-64
Returns Minimum of a user expression Minimum thickness ( THICK ) .
N/A.

13.4.254 MO|[n]

n-
ACTION:
DEFAULT:

1-64
Returns Machine origin for concentricity measurements.
N/A.

13.4.255 Mode

ACTION :

Returns the mode that the program is running in.
See Define:Mode

13.4.256 Move:AbsXY (X Coord,Y Coord[,Speed])

X Coord -
Y Coord -
Speed -

ACTION :

EXAMPLE :

DEFAULT:

0-999

0-30

0.001 - 999

An optional parameter used to control the speed of the carriage during the move.

Moves the carriage so that the transducers can measure at a position X axially and
Y radially from datum.

Move:AbsXY(20,5)

This will cause movement so that the transducers are positioned 20mm from
datum in X and Smm radially in Y. This example assumes units set to mm.

N/A

13.4.257 Move:Axis(Axis,Distance, Wait, Speed, Acceleration)

Axis -
Distance -

Wait -

Speed -

Acceleration -

ACTION:
DEFAULT:

The number that is mapped to the motor driver of the axis you want to move.
Distance from the datum position you want to move to (mm or degrees depending
upon the axis type.

0 = Wait, 1= Do not wait.

0 will halt program execution until motor has stopped moving. 1 will allow
program execution without waiting for motor to finish.

0.001 - 999

An optional parameter used to control the speed of the carriage during the move.
The speed at which the motor will rotate.

Sets how quickly the motor will attempt to reach top speed or slow to standstill.

Moves an absolute distance from the datum position.
N/A
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13.4.258 Move:RelXY (X Coord,Y Coord|[,Speed])

X Coord -
Y Coord -
Speed -

ACTION :

EXAMPLE 1:

EXAMPLE 2:

DEFAULT:

0-999

0-30

0.001 - 999

An optional parameter used to control the speed of the carriage during the move.

Moves the carriage relative to its current position.

Move:RelXY(-5,3) \

This instruction will cause the carriage to move -5 mm in X from the current
position and 3 mm in Y. This example assumes the units to be set to mm.
Move:RelXY(5,10,EX[1])

This will cause movement so that the transducers are positioned 5Smm beyond the
position of edge EX[1] and a radial position of 10mm. This example assumes
units set to mm.

N/A

13.4.259 MRANGE|[n]

n-
Action:

Default:

1-64 -

Returns Range of deviations from line(s) (LS_LINE, [H/I] ANGLE )
Range of deviations from circle (LS RAD)

N/A.

13.4.260 MSIGMA [n]

n_
Action:

Default:

1-64 :

Returns Sigma of deviations from line(s) (LS_LINE, [H/I] ANGLE )
Sigma of deviations from circle (LS RAD)

N/A.
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13.4.261 MZ[Zone][m]

Zone - 1-20

m - 1 =X Min
2 =X Max
3 =Y Min
4 =Y Max
5 =7 Min
6 = Z Max

ACTION: Returns information for specified zone.
DEFAULT: N/A

13.4.262 NDims

ACTION: Returns the number of dimensions defined using Define:Meas
DEFAULT: 0

13.4.263 Nom[n]

n- 1-256
ACTION: Nominal value for the nth dimension.
DEFAULT N/A.

13.4.264 NZ[n]

n- 1-64
ACTION: Returns the number of data points contained in the specified zone.
DEFAULT: N/A.

13.4.265 On:Timer(Name[, Delay, Repeat])

Name - Subroutine name,
Delay - 0 = Disable timer, else time delay in seconds
Repeat - 0 = Call subroutine once after Delay (default)

1 = Call subroutine every Delay
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13.4.266 Open:File(Name[,Specifier])

Name - File name.

Specifier - 1 = Write (append)
2= Write (new file)
3 = Read (last pos)
4 = Read (file start)

ACTION : Opens the file 'Name' in the USERDATA folder as an output device for the range
of '"WRITE:' commands & input device for Read:Format & Read:External.

DEFAULT : N/A

EXAMPLE : This section of code opens the file ProgramData.txt on the A drive (note the double
backslash \\ syntax), writes the date and time to the file and then writes all of the
dimensional data collected by the Profile system.
NOTE: When the system detects a double backslash operator it substitutes a single
backslash. Therefore, when specifying a file path in a string, make sure all single
backslash operators are replaced with double backslash's.

open:file("A:\\ProgramData.txt",1)

write:date

write:time

write:text( )

write:dimension_all(1,ndims)

write:text( )

write:text( )

close:file("A:\\ProgramData.txt")
All the generic "Write' instructions may be used with this instruction enabling customised output to a specified
filename.

13.4.267 Open:Keyboard

ACTION: Opens the keyboard as an input device.
EXAMPLE: Open:keyboard

Read:key(1)

Close:keyboard
DEFAULT: N/A

13.4.268 Open:Printer

ACTION : Opens the printer as an output device for the range of "WRITE:' commands
DEFAULT : N/A

13.4.269 Open:Serial(Port[,Operating Mode])

Operating Mode - 0 = All cases.
1 = Calibration.
2 = Measurement.
ACTION: Opens the serial 'Port' as an output device for the range of 'WRITE:'
commands, and as an input device for Read:Format commands.
DEFAULT: N/A

13.4.270 Open:User_Window(Operating Mode)

Operating Mode - 0 = All cases.
1 = Calibration.
2 = Measuring.

ACTION: Displays a previously defined user text window in which to display the
output of "WRITE:" commands.
DEFAULT: N/A
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13.4.271 Open:User_Screen(Screen Type,Screen No.)

Screen Type - 2or4
2 =Text.
4 = Graphics.
Screen No. - 1-999.
ACTION: Opens a previously defined screen.
DEFAULT: N/A

13.4.272 Poly|[n]

n- 1-6
ACTION: Returns computed polynomials. See "Compute:Polynomial”
DEFAULT: N/A.

13.4.273 Poly_Coef X[Array][n]

Array - 1 — Max Arrays

n- 1-6

ACTION: Holds the X VPB polynomial coefficients for the specified array.
DEFAULT: N/A.

13.4.274 Poly_Coef_Y|[Array][n]

Array - 1 — Max Arrays

n- 1-6

ACTION: Holds the Y VPB polynomial coefficients for the specified array.
DEFAULT: N/A.

13.4.275 Prog_Name

ACTION: Returns the name of the currently running program.
DEFAULT: N/A.

13.4.276 ProgDir

ACTION : Returns the name of the base directory from which ProMeasure is running.
e.g. "C:\Program Files\Pro-Measure"
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13.4.277 Prompt(Prompt,Operating Mode)

Prompt - Prompt a maximum length of 70 characters.
Operating Mode - 0 = All cases.

1 = Calibration.

2 = Measurement

ACTION: Displays prompt on screen and waits for a single keypress.
EXAMPLE: Prompt(Place master component in gauge & hit any key,1)
Prompt(Place component in gauge & hit any key,2)

These two instructions will be active dependant upon the MODE of operation.
The first command will cause the message 'Place master in gauge & hit any
key' to appear during calibration only. The second command will be active
during measurement and will display the 'Place component in gauge & hit any
key'. The prompt instruction will PAUSE the program execution until one of
the keys on the keyboard has been pressed.

DEFAULT: N/A

13.4.278 PStat[1]

ACTION : Returns whether the program will stop at the end of the current measurement cycle.

13.4.279 PX[ #]

ACTION: Returns the X position of a point in a zone. This may only be used in a Find
expression.

DEFAULT: N/A.

EXAMPLE: Define:Zone( 1, 0, 10, -7,7)

Find(1, Px[#],1)
Display:Message( "Av X = %f,Max X = %f,Min X = %f ",0,0, Av[1],
Max[1],Min[1])

13.4.280 PY[ #]

ACTION: Returns the Y position of a point in a zone. This may only be used in a Find
expression.

DEFAULT: N/A.

EXAMPLE: Define:Zone( 1, 0, 10, -7, 7)

Find(1, Py[#],1)
Display:Message( "Av Y = %f, Max Y = %f, Min Y = %f ", 0,0, Av[1],
Max[1],Min[1])

13.4.281 R[n]

n- 1-64

Action: Returns Radius of best fit circle (LS_RAD)
Range of deviations from zone’s centreline ( STRAIGHT )
Root radius (L_ THREAD, R THREAD )

Default: N/A.

13-91



13.4.282 Read:Dynamic(Wait)

Wait - optional parameter
0 = Do not wait for results.
1 = Wait for results (default).

ACTION: Reads the sensors dynamically as defined by Define:Dynamic and
Define:Dynamic_Function. see also Wait:Dynamic
DEFAULT: 1

13.4.283 Read:External(First,Last,Operating Mode)

First - number of first external register into which the values are to be placed
Last - number of last register
Operating Mode - 0 = All cases.

1 = Calibration.
2 = Measurement.

ACTION : Reads external values from the file currently OPEN.
DEFAULT: N/A

13.4.284 Read:File Pos(File type,Register)

File type - 1 = Write stream.
2 = Read stream.

Register - External register 1 - 128.

ACTION: Reads file position of current open file (R or W) and places the result in
E[Register].

DEFAULT: N/A

13.4.285 Read:Format(Format,Timeout,Numeric Register[,Text Register])

Format - Format to be received
? = any character
* = any characters
%f = Float
%d = integer.
%s = String
\00 = ASCII code

Timeout - 0 - 255 Seconds.

Numeric Register - External register number 1 - 256.

Text Register - Text register number 1 - 10.

ACTION: Reads in data from either a file or serial port and extracts numeric values

and places the result in the external registers starting at "Numeric Register'
and extracts strings and places these in the user text fields Starting at 'Text
Register'. Timeout applies to serial device only.

DEFAULT: N/A
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13.4.286 Read:Inputs[n,m,Var]

n- 1-256

m- 1-32

Var - Numeric Variable.

ACTION: Reads inputs n to n+m-1 and stores the results in Var. See device mapping for
an explanation of how inputs map to real devices.

DEFAULT: N/A.

EXAMPLE: Declare:Local_Var(Input)

Read:Inputs(2,1,Input)
Display:Message("Input 2 state = %d",0,0,Input)

13.4.287 Read:Key(Register)

Register - External register 1 - 128.

ACTION: If a key is being pressed then the key code is stored in E[Register]. If no
key is pressed then -1 is stored.

EXAMPLE: Open:keyboard
Read:key(1)
Close:keyboard

DEFAULT: N/A

13.4.288 Read:Keyboard(Register,Upper Limit,Lower
Limit,Text, Type,Default,Operating Mode)

Register - 1-256.

Upper Limit - -99999.999 - 99999.999.
Lower Limit - -99999.999 - 99999.999.
Text - Prompt 1 - 60 characters.
Type - 1 = Integer 2 = Float.
Default - Expression.

Operating Mode - 0 = All cases.

1 = Calibration.
2 = Measurement.

ACTION : Opens a window, Displays 'Prompt' and accepts a number between 'Lower
Limit' and 'Upper Limit' typed in on the keyboard. The value is then placed
in E[Register]. If the default expression is entered then this is evaluated and
displayed in the window.

EXAMPLE : Read:Keyboard(1,11,9, Enter Micrometer Reading,2)

The instruction will display the message 'Enter Micrometer Reading' and

will permit a floating point value to be typed in from the keyboard in the

range 9 to 11. The value will be placed in the EXTERNAL register E[1].
DEFAULT : N/A

Note : This command does not need prior instructions to have been called before it is used.
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13.4.289 Read:Scan(Format)

Format - 1 =Read a scan from a DOS Profile Gauge

2 = Read a scan from a DOS Converted End Gauge
ACTION : Reads a previously saved scan from disk.
DEFAULT: N/A
EXAMPLE: Open:Files(example.scn,4)

Read:Scan

Close:Files(example.scn)

13.4.290 Read:Sensors[n,m]|

n- 1-256
m - n—256
ACTION: Reads sensors n to n+m and stores the results in Sensor[n] to Sensor[n+m].

See device mapping for an explanation of how sensors map to real devices.

DEFAULT: N/A.

EXAMPLE: Read:Sensors( 2, 4 )
Display:Message("Sensor 2 -4 = %f, %f,
%f",0,0,Sensor[2],Sensor[3],Sensor[4])

13.4.291 Recover(Mark:try)

i\//[-ark:tr 1 - 30 characters.

ACTIO Unconditional jump to the line after the defined 'Mark:try' and puts the PROCAL stack back to
N: the same state as at the 'Mark:try' entry.

DEFA

ULT: N/A

13.4.292 Release:Scan_Memory

ACTION : Releases memory used to scan a component, so that it may be reused for further
scans.
DEFAULT: N/A

An optional numerical parameter is available for this command which allows a specified number of scans to be

released.
e.g.. Release:Scan_Memory(2) {This releases memory from last two scans}
If no parameter is included, it releases all scans.

13.4.293 Repeat

ACTION: Marks the start of a REPEAT - UNTIL loop
DEFAULT: N/A

13.4.294 Rotate: Abs(Angle)

Angle - -720 - 720
ACTION : Rotates a component to the specified angle.
DEFAULT: N/A
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13.4.295 Rotate:Rel(Angle)

Angle - -720 - 720

ACTION : Rotates a component relative to the current angle, or relative to a feature if
specified.

DEFAULT: N/A

13.4.296 Rotate:Reset

ACTION : Sets the current angular position to be the Datum.
DEFAULT: N/A

13.4.297 Rotate:Scan(a,p[,Speed])

a- Angle to scan through —360 to 360
p- Number of points ( 1 —20000 )
Speed - An optional parameter used to control the speed of the carriage during the scan.

Value = degrees/s

ACTION: Performs a rotational scan of the component at the current X position.
DEFAULT: N/A.
EXAMPLE: Move:AbsXY(102,0)

Rotate:Scan(360,3600)

13.4.298 Rpos

ACTION: Returns the current rotation position of machine
DEFAULT: N/A.

13.4.299 RX[n]

n- 1-64
ACTION: Returns X position of a radius.
DEFAULT: N/A.

13.4.300 RY|n]

n- 1-64
ACTION: Returns Y position of a radius.
DEFAULT: N/A.
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13.4.301 S[n]

n-
ACTION:
DEFAULT:

1-64
Returns slope of a line.
N/A.

13.4.302 Save:Machine Data

ACTION:
DEFAULT:

Writes all the machine settings out to the registry.
N/A.

13.4.303 Scan:X( Distance,No. Hits [,Speed] )

Distance -

No. Hits -

Speed -

ACTION :

DEFAULT:
EXAMPLE 1:

EXAMPLE 2:

999 — 999

This is the length over which a scan is to be taken. It can have a positive or
negative direction.

1 - 100000

The number of data frames to be read by the measurement system.

0.001 - 999

An optional parameter used to control the speed of the carriage during the scan.

Scans a component for a distance left or right, taking 'No. Hits' readings at a rate
of 'Speed' units per second ( as specified in Units:All).

N/A

Scan:X(5,100)

This will scan a component in a positive direction over Smm, taking 100 hits.
Scan:X(-100,1000,5)

In this example, 1000 hits will be made over a distance of 100mm traversing in a
negative direction at a speed of Smm per second.

13.4.304 Select:Screen(Screen Type,Screen Number)

Screen Type -

Screen Number -

ACTION:
DEFAULT:

1 = Standard measurement.

2 = User alpha screen.

3 = Machine tool feedback.

4 = User graphics screen.

5 = ActiveX control (e.g. Schematic display)
6 = Standard calibration

1-999.

Make active (i.e. visible) the selected screen.
N/A

13.4.305 Sensor[n]

n-
ACTION:
DEFAULT:
EXAMPLE:

1-256

Returns the value of the specified Sensor. See Read:Sensors
N/A.

Read:Sensors( 2, 4 )

Display:Message("Sensor 2 -4 = %f, %f,
%f1",0,0,Sensor[2],Sensor[3],Sensor[4])
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13.4.306 Sensor.Check(Flrst Last,Lower,Upper)

First -

Last -
Lower -
Upper -
ACTION:
DEFAULT:

First sensor number.

Last sensor number.

Upper limit for sensor value.

Lower limit for sensor value.

Sets the maximum and minimum value for a particular set of sensors.
Upper - 99999

Lower - -99999

13.4.307 SeriallD

ACTION :

Returns the Serial ID of the machine, as configured when ProMeasure was installed.

13.4.308 Set:DefaultClipping

ACTION:

Sets the array clipping limits to their default values for the gauge.

13.4.309 Set:Error(Group,Error Number,Qualifierl,Qualifier2)

Group -

Error Number -
Qualifier1 -
Qualifier2 -

ACTION:
DEFAULT:

1-2.

1-255.
-9999 - 9999.
-9999 - 9999.

Forces the specified error to be set. NB: Only trappable errors may be set.
N/A

13.4.310 Set:Error_Text(Text)

Text-
Action:

Default:
Example:

User error text

Defines a line of text to be added to an error message box if none trapped error
occurs.

N/A. :

Set:Error_Text("Measurement Stage 1")

13.4.311 Set:File_Pos(File type,Offset[,Orlgm])

File type -
Offset -

Origin -

ACTION:
DEFAULT:

1 = Write stream.

2 = Read stream.

Any required offset entered in bytes or as an expression.

1 = Start of file.

2 = Current position (use file write append or file read last pos).
3 = End of file.

Sets file position of current open file (R or W)

N/A :
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13.4.312 Set:Outputs(n, data [, mask])

n -
data -

mask -

ACTION:

DEFAULT:
EXAMPLE:

1-256

Decimal equivalent of binary number to be output as data.

i.e. Binary 0110 = Decimal 6

Decimal equivalent of binary number used to mask the output data to leave specified bits in their
current state.

Sets the output bits to the specified condition starting with the LSB of the pattern as Output n.

See device mapping for an explanation of how outputs map to real devices.
N/A.

The EXAMPLE below will set bits as follows :

bit 1 = Off,

bit 2 =On

bit 3 will be left in its current state

bit 4 set to On.

13.4.313 Set:System_Diameter(Dia)

Dia -

ACTION:
DEFAULT:

13.4.314 Spos

ACTION:
DEFAULT:

Profile 20 No ACTION

Profile 30 No ACTION

Profile 80 0=0-30
1=20-80

Changes the measurement diameter of the Profile machine.
N/A.

Returns the current slew position of the main slide.
N/A

13.4.315 Statistics:Update

ACTION:
DEFAULT:

Updates the statistics of the SPC application (optional) for all the dimensions.
N/A

13.4.316 Statistics:Update

ACTION:
DEFAULT:

Updates the statistics of the SPC application (optional) for all the dimensions.
N/A
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13.4.317 Std:A_Grade(''Grade', USL, LSL)

Grade An alpha-numeric description of the associated grade i.e. 3h4h
USL/LSL Defines the ABSOLUTE upper and lower tolerances for the grade i.e. 20.01/20.02

13.4.318 Std:Apply(FeaturelD)

This command should be included in the block immediately after the 'Begin:Standard' keyword to define which
other feature types the database is to be applied to.

13.4.319 Std:Display(FeaturelD, FeatureParameterlD)

Defines a parameter to be displayed within the 'Standards Database' page in the Measurement Properties dialog
box. Each parameter requiring display should have a separate Std:Display word, with the order in which the
parameters are defined indicating the order in which they appear. Note that it is necessary to display all the
parameters a database needs to determine the grade, otherwise searches for the grade may fail.

13.4.320 Std:Global(Value, USL, LSL)

Can be used to define a fixed 'global' nominal and tolerance for a specified measurement type.
Value Defines the value of a fixed nominal to be defined in the database.
USL/LSL Defines the relative upper and lower tolerances and lower tolerances.

13.4.321 Std:Nominal(Value,NumberOfSubOptions) OR
Std:Nominal(Value,TableIndex)

Value Nominal value or start/end value in a band parameter

NumberOfS When a SubFeatureTypelD exists in the Begin:StdTable instruction, this parameter defines how
ubOptions many sub-options are related to this particular nominal value.

When no SubFeatureTypelD exists in the Begin:StdTable instruction, this parameter defines the

TableIndex grade table number related to this particular nominal value.

13.4.322 Std:R_Grade("'Grade", USL, LSL)

Grade An alpha-numeric description of the associated grade i.e. 3h4h
USL/LSLDefines the RELATIVE upper and lower tolerances for the grade in 1/1000mm or 1/1000 inch

13.4.323 Stop

ACTION: Stops the execution of a program and does NOT update stats on disk or the
measurement displays.
DEFAULT: N/A

13.4.324 Stop:Axis(Axis)

Axis - Motor Number
ACTION: Stops an axis that is currently moving.

13-99



13.4.325 SubMode

ACTION : Returns the submode that the program is running in.
See Define:Mode

13.4.326 System_Diameter

ACTION: Returns the current system diameter as the value of the maximum diameter
20 = Profile 20
30 = Profile 30 or Profile 80 in 0 — 30 range
80 = Profile 80 in 20 — 80 range
0 = Profile 80 in 0-30 range, or machine with no slide mechanism
1 = Profile 80 in 20-30 range
DEFAULT: N/A.

13.4.327 Target[n]

n- 1-256
ACTION: Target value for the nth dimension.
DEFAULT: N/A.

13.4.328 Text|n]

n- 1-10
ACTION: General purpose text registers.
DEFAULT: N/A.

13.4.329 Text_Input(Field no., Max Length, Label, Operating Code)

Field no. - Field into which the entered text is placed.

Max Length - Max length of string entered.

Label - A string of characters displayed when the field is output.
Operating Code - 0 = All cases.

13.4.330 1 = Calibration.

2 = Measurement.

ACTION : Opens a window on the VDU. Text is accepted via the keypad or keyboard.
The entered text is displayed on the cumulative stats display.
DEFAULT : N/A

13.4.331 Time[n]

n- 1-2

ACTION: Returns the time in the following formats.
1 hh:mm:ss
2 hhmmss

DEFAULT: N/A.

EXAMPLE: Write:Format("Time : %s",0,Time[1])

13-100



13.4.332 TP[64]
ACTION : Average pitch of thread ( [L/R] THREAD )

13.4.333 Trace[n]

ACTION : Returns or sets the nth traceability value.

13.4.334 Trace_Title[n]
ACTION : Returns or sets the name of the nth traceability field.

13.4.335 Trap:Error(Group,Error Number,[Mark])

Group - 1-3.

Error Number - 1-255.

Mark - 1 - 30 characters.

ACTION: Traps the specified error and causes program execution to jump to the specified

Mark. If Mark is not specified then normal error handling is resumed.
DEFAULT: N/A

13.4.336 Units:All(Units)

Units - MM = Millimetres.
INCHES = Inches.

ACTION : All dimensions are assigned the value of [Units].
All Probe readings are converted to [Units].
EXAMPLE : Units:AlI(MM)
or
Units:AlI(INCH)
DEFAULT : MM

13.4.337 Until(Expression)

Expression - A valid PROCAL expression.

ACTION: If the Expression evaluates to FALSE then program execution jumps back to the
corresponding REPEAT. Otherwise execution continues.

DEFAULT: N/A
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13.4.338 USL[n]

n- 1-256

ACTION: Returns the Upper Specified Limit for the n™ dimension.
DEFAULT: N/A.

EXAMPLE: Write:Format("%s USL = %f",0,Desc[1],USL[1])

13.4.339 UWL[n]

ACTION : Sets or returns the Upper Warning Limit for the nth dimension.

13.4.340 Version|n]

ACTION : Returns the nth field of the version number of the ProMeasure application.

13.4.341 VPB:Dark Reference

ACTION: Switches all VPB’s into dark reference mode.
DEFAULT: N/A.

13.4.342 VPB_Data[Array][n]

ACTION: Returns the nth Data value from specified Array.
DEFAULT: N/A.

13.4.343 VPB_FailFrames[Array]

ACTION : Returns the number of frames which have failed during a Dark Reference or Light
Reference.

13.4.344 VPB_Header|[Array]

ACTION: Returns the Header word for the specified Array.
DEFAULT: N/A.

13.4.345 VPB:1dle

ACTION: Switches all VPB’s into idle mode.
DEFAULT: N/A.

13.4.346 VPB:Load_Data

ACTION: Loads all data (Poly coefficient’s, edge offsets, Scale resolution) into the VPB’s.
DEFAULT: N/A.
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13.4.347 VPB:Measure

ACTION:
DEFAULT:

Switches all VPB’s into the DEFAULT measurement mode.
N/A.

13.4.348 VPB:Measure_Edge

ACTION:
DEFAULT:

Switches all VPB’s into the edge specific measurement mode.
N/A.

13.4.349 VPB_PassFrames[Array]

ACTION :

Returns the number of frames which have passed during a Dark Reference or Light

Reference.

13.4.350 VPB:Reset_Counter

ACTION:
DEFAULT:

Resets all VPB’s internal counters.
N/A.

13.4.351 VPB:Reset_Status

ACTION:

DEFAULT:

Resets all VPB’s Status. Used to clear down the VPB’s before a new
calibration.
N/A.

13.4.352 VPB_Status[Array][n]

ACTION:
DEFAULT:

Returns the nth Status word for the specified Array.
N/A.

13.4.353 VPB:White_Reference

ACTION:
DEFAULT:

Switches all VPB’s into white reference mode.
N/A.

13.4.354 Wait: Axis(Axis)

AXIs -
ACTION:

Motor Number
Waits for an axis to finish a movement started by Move:Axis.
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13.4.355 Wait:Dynamic

ACTION: Waits for a dynamic result. see also Read:Dynamic
DEFAULT: N\A

13.4.356 Wait:Input(Markl,Mark2,Mark3,Type,Line[,Mode,Mark4])

Mark1 - 1 - 30 characters.
Mark?2 - 1 - 30 characters.
Mark3 - 1 - 30 characters.
Type - 1 = Keyboard.

2 = Input line (via device mapping).
3 = Input line (via device mapping)..

Line - 1-64.
Mode - 0 =Line LOW.
1 = Line HIGH.

2 = Negative Edge.
3 = Positive Edge.
Mark4 - 1 - 30 characters.

ACTION: Pauses the PROCAL program until
START is pressed - Program jumps to Mark1.
STOP is pressed - Program jumps to Mark2.
ANNUL is pressed - Program jumps to Mark3.
Input line condition is satisfied - Program jumps to Mark4.
If 'Type' is 1 then 'Line' is a keyboard character code and the program jumps to
Mark4 if that key is pressed.
DEFAULT: N/A

13.4.357 Wait:Key(|Register])

Register - External register 1 - 256.

ACTION: Waits for a key to be pressed and stores the key
code in E[Register] if required.

DEFAULT: N/A

EXAMPLE: Display:Message(PRESS ANY KEY TO CONTINUE)
Wait:Key

13.4.358 Wait:Time(Time,Operating Mode)

Time - 0 - 255 Seconds
Operating Mode - 0 = All cases.

1 = Calibration.

2 = Measurement.

ACTION : Pauses the Procal program for the specified 'Time'.
DEFAULT: N/A
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13.4.359 Write:Char(Code)

Code -
ACTION

ASCII code of character to write.
Outputs a single character to all open output devices.

13.4.360 Write:Colour(Ink,Paper)

Ink -
Paper -

Colour:

ACTION:
DEFAULT:

0-15.

0-7.

0 = Black 4 =Red 8 =Dk Grey 12 =Lt Red

1 =Blue 5 = Magenta 9 =Lt Blue 13 = Lt Magenta
2 = Green 6 = Brown 10 = Lt Green 14 = Yellow

3 =Cyan 7 =Lt Grey 11 =Lt Cyan 15 = White

Sets the foreground and background colours for output to the screen.
N/A

13.4.361 Write:Date(Operating Mode)

Operating Mode -

ACTION :
DEFAULT:

0 = All cases.
1 = Calibration.
2 = Measurement.

Outputs the current date to all of the open output devices.
N/A

13.4.362 Write:Dimension(First Dimension, Last Dimension, Mode)

First Dimension -
Last Dimension -
Mode -

ACTION:

The first dimension in the range of results to be output.
The last dimension in the range of results to be output.
1 = Calibration

2 = Measurement

Writes the measurement results to an open device.
1\i\‘;;;ite:Dime:nsion( 1,3,2)

Outputs the following :-

4.998

10.003
14.995
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13.4.363 Write:Dimension_All(First Dimension, Last Dimension[, Mode,

Colourl])

First Dimension - The first dimension in the range of results to be output.

Last Dimension - The last dimension in the range of results to be output.

Mode - 1 = Calibration
2 = Measurement

Colour - 1 = Colour
2 = Black and White
Default = 1

ACTION: Writes all measurement details for a specified range of results to an open device.
i.e.

Write:Dimension _All(1,3,2)
Outputs the following :-

Description Actual Deviation = USL LSL Class
D01 Average 4.998 -0.002 0.050 -0.050 Pass
D02 Average 10.003 0.003 0.050 -0.050 Pass
D03 Average 14.995 -0.005 0.050 -0.050 Pass

13.4.364 Write:Field(Field, Op Mode)

Field - 1-10.
Operating Code - 0 = All cases.
1 = Calibration.
2 = Measurement.
ACTION : Outputs the specified field (Enter via TEXT INPUT) to all of the open output devices.
DEFAULT: N/A
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13.4.365 Write:Format(Message,Timeout[,Expressionl,...,Expression8])

Message -

Timeout -
Expression -

ACTION:

DEFAULT:
EXAMPLE:

Format to be sent.
%f = Float %d = integer
%s = String. \00 = ASCII code

0 - 255 Seconds

Up to eight expressions can be inserted in the message in place of the %f,%d, and,
%%s.

%d & %f Can be any valid numeric expression. %s Can be any valid string
expression.

Sends "Message' out on all of the currently open devices. Timeout applies to the
serial device only.

N/A

Write:Format(The 1st text register holds: %s,0,TEXT[1])
Write:Format(Current program is: %s,0,prog_name) { The string variable
prog_name holds the name of the program }

Write:Format(Todays date is: %s,0,DATE[1])

{ The DATE array holds the date in 4 different formats: }

{ DATE[1] = DD/MM/YY }

{ DATE[2] = YYMMDD }

{ DATE[3] = MM/DD/YY }

{ DATE[4] = MMDDYY }

Declare:Global_Var(Foo)

Declare:Global Var(Bar)

Evaluate(Foo:=1.1)

Evaluate(Bar:=2.2)

Write:Format(Result is %f,0,Foo*Bar)

13.4.366 Write:Page

ACTION :
DEFAULT:

Sends a Form Feed to all open drivers.
N/A

13.4.367 Write:Position(X,Y)

X -
Y -

ACTION:
DEFAULT:

0-999.
0-999.

Sets the current cursor position.
N/A

13.4.368 Write:Scan Write:Scan(Count)

Count -
ACTION :

DEFAULT:
EXAMPLE:

If supplied, ignore this many scans, and then write the next one.
Writes the most recent scan to disk, or an earlier one if
specified.

N/A

Open:File(example.scn,2)

Write:Scan

Close:File(example.scn)
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13.4.369 Write:Size(Width[,Height])

Width - Width of character (1 = normal size)
Height - Height of character (1 = normal size)
ACTION: Changes the size of text output to the Printer. If the Height

parameter is omitted, the same value as Width is used. The size is relative

to the default size, which is selected such that 80 characters fit per line.
DEFAULT: 1
EXAMPLE: Open:Printer

Write:Size(2) {double size text for title}

Write: Text("Results")

Write:Size(0.75,1) {narrower text for results to fit more columns on

the page}

13.4.370 Write:Text(Text,Operating Mode)

Text - 1 - 78 characters.
Operating Mode - 0 = All cases.

1 = Calibration.

2 = Measurement.

ACTION : Outputs 'Text' to all of the open output devices.
DEFAULT: N/A

13.4.371 Write:Time(Op Mode)

Operating Code - 0 = All cases.
1 = Calibration.
2 = Measurement.

ACTION : Outputs the current time to all of the open output devices.
DEFAULT: N/A

13.4.372 Xav|[n]

n- 1-64
ACTION: General purpose average X register.
DEFAULT: N/A.

13.4.373 Xmax|n]

n- 1-64
ACTION: General purpose maximum X register.
DEFAULT: N/A.
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13.4.374 Xmin|[n]

n- 1-64
ACTION: General purpose minimum X register.
DEFAULT: N/A.

13.4.375 XOrigin

ACTION : Returns the current X Origin (as set by Define:X_Origin for Reference edges)

13.4.376 Xpos

ACTION: Returns the current X position of the main slide.
DEFAULT: N/A

13.4.377 Yav|n]

n- 1-64
ACTION: General purpose maximum Y register.
DEFAULT: N/A.

13.4.378 Ymax|n]

n- 1-64
ACTION: General purpose maximum Y register.
DEFAULT: N/A.

13.4.379 Ymin|n]

n- 1-64
ACTION: General purpose minimum Y register
DEFAULT: N/A.

13.4.380 YOrigin

ACTION : Returns the current Y Origin (not currently used - will always be zero)

13.4.381 Ypos

ACTION: Returns the current Y position of the main slide. This is a simulated positions.

DEFAULT: N/A
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13.4.382 Zmax|n]

n- 1-64
ACTION: General purpose maximum Z register.
DEFAULT: N/A.

13.4.383 Zmin|n]

n- 1-64
ACTION: General purpose minimum Z register.
DEFAULT: N/A.

13.4.384 Zone|[n]

n- 1-4
ACTION: Returns values of last zone displayed by Draw:Zone
Zone[1] = X Min
Zone[2] = X Max
Zone[3] =Y Min
Zone[4] =Y Max
DEFAULT: N/A.

13.4.385 Zone PointC[n]

n- 1-20
ACTION: Sets the colour used to draw an object on a zone. See Zone_PointX.
DEFAULT: N/A

13.4.386 Zone PointH|[n]

n- 1-20
ACTION: Sets the height of a rectangular object on a zone. See Zone_PointX.
DEFAULT: N/A

13.4.387 Zone_PointR[n]

n- 1-20
ACTION: Sets the radius of a circular object on a zone. See Zone_ PointX.
DEFAULT: N/A

13.4.388 Zone_PointW|n]

n- 1-20
ACTION: Sets the width of a rectangular object on a zone. See Zone_PointX
DEFAULT: N/A
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13.4.389 Zone PointX[n]

n- 1-80

ACTION: Sets the y position of the centre of an object on a zone. See Zone_PointX.
DEFAULT: N/A

EXAMPLE: { Draws a yellow cross on edge 1 }

Define:Zone(1,Ex[1] — 2,Ex[1] + 2,Ey[1] — 2,Ey[1]+2)
Evaluate(Zone PointX[1] := Ex[1])

Evaluate(Zone PointY[1] := Ey[1])

Evaluate(Zone PointC[1] :=14)

Draw:Zone(1)

{ Draws a red circle on for a best fit radius }
Define:Zone(1,Rx[1] — R[1]-4,Rx[1]+R[1]+4,Ry[1] - R[1]-4,Ry[1]+R[1]+4)
Evaluate(Zone PointX[1] :=Rx[1])

Evaluate(Zone PointY[1] :=Ry[1])

Evaluate(Zone PointC[1] :=2)

Evaluate(Zone PointR[1] :=R[1])

Draw:Zone( 1)

13.4.390 Zone PointY|[n]

n- 1-80
ACTION: Sets the y position of the centre of an object on a zone. See Zone_PointX.
DEFAULT: N/A

13.4.391 Zone:Text(Text)

Text - 1 — 80 characters

ACTION: Sets the title for the next Draw:Zone
DEFAULT: "

EXAMPLE: Define:Zone(1,2,4,-10,+10)

Zone:Text("Diameter One")
Draw:Zone(1)
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14 BPI - Probe Boxes
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14.1 BPI - Interface Introduction

The BPI interface is an electronic device that enables readings from a number of probes and gather static or
dynamic measurements. The BPI (Intelligent Probe Box) is connected to the Profile Machine via COM port 1.

A - 8 Port BPI Box
B - Connection to COM Port 1
C-PSU

The BPI box must be plugged into the mains supply via a built in or stand alone power supply unit. It is then
connected to the PC via a serial cable which connects to COMMS 1. Once the COMMS cable has been
connected, the BPI box can be switched on. Promeasure for Windows NT will detect the box on startup, for this
reason the BPI box must be attached prior to starting the Promeasure software.

WARNING:
Do not disconnect the serial connection from the BPI box to the PC Tower whilst the BPI is switched on. The

BPI box has very sensitive electronic serial interface chips which can be damaged if the serial cable is
disconnected while power is applied. ALWAYS switch off the power to the BPI first.

14.2 BPI - Programming the box

There are several different types of BPI probe box. Some types are ‘stackable’ in order to accommodate more
probe ports. Before using a probe box it is important to program it in order for it to communicate correctly with
the Promeasure software.

1. Select ‘Properties’ from the Pluginmanager icon to display a list of software plugins.

2. Highlight the BPI plugin and press the ‘Setup’ button.

3. Three dialog pages will be available, ‘Serial’, ‘Sensors’ and ‘Program’. Click on the ‘Program’ page to
display the following window.
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Serial port
Set to the serial port that the BPI is connected to (usually COM 1).

Function:
There are three options : Standalone, Master, and Slave.
1. STANDALONE is used for BPI's that cannot be stacked or for a BPI that can be stacked but which is
on its own.

2. MASTER is used for a BPI that is stackable and that has 1 or more BPI's connected to it.
3. SLAVE is used for a BPI that has been connected to a 'Master' BPI.

Address:

This window is only available when the ‘Slave’ setting has been chosen. The address is really the position of the
BPI in a stack. If the slave is the second BPI, it should have the address ‘2. If it is the third in the stack, the
address will be 3’ ...

When the appropriate settings have been made, selecting the button ‘Program’ will download information to the
BPI and set it up according to the information that has been entered.

TIPS:

If a BPI is programmed as a ‘Master’ before any ‘Slaves’ have been programmed the BPI box can become
confused. This is due to attempted communication with the slaves which have yet to be programmed. For this
reason you must program slaves before the master.

It is not possible to program a series of BPI’s through one BPI. This means that boxes must be programmed one
box at a time. Each time the serial cable connection must be removed from the last BPI programmed, and
reconnected to the next box to be programmed. Please ensure that before the serial connection is moved, the
BPI that is being disconnected and the BPI that is to be connected are switched off. This protects the sensitive
serial chips that the BPI’s contain. Once the cable has been re-connected the relevant BPI can then be switched
on.
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14.3  BPI - Configuring the Software

To confirm that the BPI box has been detected, select ‘Properties’ from the PluginManager icon at the bottom
right hand side of the screen display.

o=y B
* ]

* Plugin Manager Icon

A window will display all of the Plugins that have been initialised. Select the BPI plugin and select
‘Diagnostics’.

Plugin Haaer

w# StdDatabase

[~ Scan

The Diagnostics screen will display the model of the BPI box detected, the BPI software version number and
the number of probes that can be attached to the BPI box. The bottom half of the window will display
communications information sent and received by the software and the BPI box.
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Once it has been confirmed that the BPI has been detected, the diagnostics window can be closed and the
‘Setup’ button selected. The setup window will display a list of all the available ports to be found on the BPI
box. Here the range of each probe and any scaling factor that may or may not be required to adjust the probe
reading can be selected. Two ranges can be chosen, coarse and fine. A course setting (which is the default
setting) indicates that the relevant probe has a range of +/- 2mm. A fine setting will indicate that the relevant
probe has a range of +/- 200 um.

Coarse

Coarse 1.000000
Coarse 1.000000
Coarse 1.000000
Coarse 1.000000

Coarse 1.000000
Coarse 1.000000
Coarse 1.000000
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144 BPI - Using in measurement programs

As with using Gageports, each probe port has to be mapped to a ‘sensor number’. The sensor number is used by
the software as a unique address from which it can interrogate the attached probes. To map each probe port, the
PluginManager windows must be closed down and the following Promeasure menus selected, Tools > Gauge

- Device Mapping.

Fil '

Tools

From the Device Mapping window, select the ‘Sensors’ page. This page will display a list of devices in the right hand
window which have not been mapped. The left hand window will display mapped devices. Select a BPI port from the right
hand side window and press the ‘Map’ button. This will map the BPI port to a ‘sensor number’ and will now be displayed
in the left hand side window. Do this for each BPI port that has a probe connected to it.

| Device Mapping
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Device Mapping

u hméﬁpéd

‘:  Cancdl |

For dynamic measurements the rotation motor must be mapped. To do this, select the ‘Motors’ page. This page will have a
similar layout to the Sensors page but will list the motor drivers in the right hand window. Map the rotation driver to sensor
number 1. The rotation driver is named Sdmxp 003 (for P20 and P80) or GSC200S 003 (for P30).

NOTE: P30 driver ‘GSC200S will be replaced by SDMxP eventually

Once the BPI box has been connectecd and the the port numbers mapped to the software, a program can be created to read
from the probes.
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14.4.1 Example programs

Example 1 : Static probe measurements
Assuming 3 probes are attached to BPI ports 3, 4 and 5. The probes have been mapped to sensor numbers 3,4 and 5
respectively

Units: All("mm"

Format:Numeric(4,3)

Define:Meas(Bpl,"static 1",2,0.050,-0.050,1,0)

Define:Meas(Bp2,"static 2",2,0.050,-0.050,1,0)

Define:Meas(Bp3,"static 3",2,0.050,-0.050,1,0)

Read:Sensors(3,5) { Read from sensor 3 to sensor 5 }
Compute:Meas(Bp1,Sensor[3]) { The readings from the probe are stored in a register/array }
Compute:Meas(Bp2,Sensor[4]) { called Sensor. The array number held in [ ] brackets }
Compute:Meas(Bp3,Sensor[5]) { reflects the probe sensor number set when ‘mapping’ }

Example 2: Dynamic probe measurements
Assuming 1 probe connected to port 1 of the BPI and it has been mapped as sensor number 1.

Units:All("mm")

Format:Numeric(4,3)
Define:Meas(Bp1,"Average",2,0.050,-0.050,1,0)
Define:Meas(Bp2,"Maximum",2,0.050,-0.050,1,0)
Define:Meas(Bp3,"Minimum",2,0.050,-0.050,1,0)

Move:Axis(1,1440,0,40) { Moves axis 1 by 1440 degrees with 0 delay at 40%second }
Define:Dynamic(25) { Take dynamic readings for 25 seconds }
Define:Dynamic_Function(l1, 1, 5) {Sets function ID to 1, sets a scale factor of 1 for probe 5}
Read:Dynamic { Initiates the dynamic read of the probe }
Stop:Axis( 1) { Stops the motor axis from rotating }
Rotate:Abs( 0) { Reset the rotation axis }
Rotate:Reset { Confirm position as Rotation Datum }
Compute:Meas(Bp1,Dynaverage[1]) { Dynamic readings return three results, Average, Max, }
Compute:Meas(Bp2,DynMaximum[1]) { and Min. These are stored in registers called Dyn- }
Compute:Meas(Bp3,Dynminimum([1]) { average/Dynmaximum and Dynminimum. The number}
{ in [ ] brackets reflects the function 1D number set in }
{ the Define: Dynamic_Function line }
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15 Gageports
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15.1 Gageports (NT) with Pro-Measure software

Gageports are connected to the Profile machine system via a computer serial port. They use a 'Cable - Gageport to Profile'
(Part Number 30.909005/6), this is a 3 way lead which incorporates a separate power supply for the Gageport device(s). The
lead has connections to the power supply, computer serial port and Gageport, in the fashion illustrated below.

EXPANDER BOX
30.909004 PROFILE SERIAL PORT

PROBE / \

GAGEPORT

30.909003 \‘ O O O

2 DIGITAL 1 1 D “I I MAIN POWER

GAGEPORTS

30.909001 o —
CABLE — GAGEPORT
TO PROFILE.
30.909005 / 6

It is possible to stack Gageports in a 'Gageport Expander' box (Part Number 30.909004). Each expander box can
accommodate up to 4 Gageport devices. (Maximum of 32 Gageports per COM Port).

Once the Gageport equipment has been set up, the Pro-Measure software must also be configured so that it will recognise
the type of instruments that are to be connected to each Gageport device.

15.2  Gageports - Configuring the software

Once the equipment is setup and plugged in, reboot Windows NT, and start the Pro-Measure software.

To enter the required Gageport information, access to the Gageport Plugin control is required. This is achieved
by ‘right-clicking’ the mouse button when the cursor is placed over the Plugin Manager icon. This is found at
the right hand side of the Windows NT Task Bar across the bottom of the screen. The icon is shown in the
screen shot below marked as *.

From the menu that appears, select the Properties option. This will display the Plugin Manager window which
will show all available Plugins. (If there is no Plugin entry called Gageport, please contact your local Brown &
Sharpe agent for advice). On selecting the entry called ‘Gageport’ with the mouse, the two buttons Diagnostics
and Setup will become available for selection.
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«f Vpb MNone
\( StdDatabase MNone
«f Gsc200s None

Gageport MNone
Mot Calibrated
Nane

Upon selecting the Setup button, the Gageport Setup window will be isplayed hich will allow the serial port
communication parameters to be set and also the type of gauges that are connected to the Gageport ports.
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Millimeters
Millimeters
Millimeters

Millimeters

Serial Page

The serial page shows the current communication settings for the serial port. As these settings are by default, the
optimum setup for Gageports, they should not need to be altered. The serial port box can be set to ‘Auto-detect’
or ‘Manual-detect’. As default, the Auto-Detect should be enabled, but if Manual Detect has been selected the
user must tick the appropriate COM port to signify which port the Gageport is connected to.

Gage Setup

The Gage Setup page is where we the software is configured with the type of measuring device that has been
attached to a particular port of a Gageport. As can be seen from the previous illustration, there is a table with 6
columns.

Sensor: The software allocates sensor numbers to each external device that it detects. In this case a
sensor number is assigned to each Gageport port.

Port: This is a list of the ports on each Gageport that have been detected.

Gage #: This is the numerical identifier which describes the gauge type connected to a Gageport port.
Units: The units of measurement, that the associated Gauge # will be measured in. (None / Inch /
MM / Kelvin / Centigrade / Grams / Microns / Kg)

Factor: This allows the user to set a scaling factor to modify the reading, if necessary.

These settings are edited by selecting a Sensor number with the mouse and entering information into the three
boxes at the bottom of the Gage Setup page. The settings that are chosen are then displayed in the table.

Once all of the appropriate settings have been completed, selection of the ‘OK” button will save your settings
and return to the Plugin Manager screen. Selecting OK again will return the system back to the Pro-Measure
software.

Configuration of the software to communicate with the Gageport device(s) is now complete.

Note : If there is no Gage Setup page available, it means that the software has not detected any Gageports
connected to the PC. Check all Gageport connections and reboot machine. If problems persist, contact your
local Brown & Sharpe agent.
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15.3 Gageport Measurement Programs

To obtain readings from a Gageport device, one of three subroutines included in the measurement libraries must be used.
These subroutines are:

Before these subroutines can be used, each Gageport port requires a unique sensor number Sp (ports that will not be
used do not have to have a sensor number). To do this, select 'Tools' from the Pro-Measure menu, and select 'Gauge',
then ‘Device Mapping’

The Device Mapping window contains four pages. The ‘Sensors’ and ‘Inputs’ pages are required for this
configuration.

eice Mppi )

Gageport 01

Gageport 04

Gageport 05
Gageport 06
Gageport 07

Sensors
The Sensors page contains two windows. One window will display the unmapped devices, whilst the second will display

mapped devices. To map a Gageport port select a port in the ‘Unmapped’ window and click on the Map button. This will
cause the following dialog box to be displayed.
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|Mapping

The box displays the device name (Gageport), the element or port number (1) and the sensor number to map to (01). The
sensor number ("To element”) can be changed by the user. Selecting 'OK' in the example above, will map Gageport port 1 to
Sensor 1.

When all of the appropriate Gageport ports have been mapped the Device Mapping window will look similar to the
following.

01 -» Gageport 01 » Gageport 03
02 -» Gageport 02 Gageport 04
03 -> Gageport 05 : Gageport 07
04 -> Gageport 06 : :

If any mistakes are made then it is possible to highlight a selection in the ‘Mapped’ window and click on the 'Unmap'
button.

Inputs

The ‘Input’ page is identical in layout to the ‘Sensor’ page. This is where inputs can be mapped to the ‘sensor numbers’ and
interact with these inputs during program execution. It is only necessary to edit this page if the Gageport is to be triggered
by a footswitch or gage key switch. If this is the case, select the Gageport port as normal from the list in the ‘Unmapped’
window, and then select the Map button. Ensure the Gageport port in the Inputs page is mapped to the same sensor number
that it was mapped to on the Sensor page. This will then associate an external trigger to the Gageport.

When all of the required ports that are to be triggered externally have been mapped, click on the ‘OK’ button. This will
return the control back to the Pro-Measure screen.

NB: The list of possible inputs may not just contain entries for Gageports. For

instance there will also be a list of motor driver inputs. These should not be selected.
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evice Mapping

01 -> Gageport 01 . Gageportﬂé
02 -> Gageport 05 ‘ Gageport 03

Gsc200s M
Gsc200s 02
Gsc200s 03
Gsc200s 04
Gsc200s 05

A ra~a0n. ne

The software is now configured to recognise the connection of the Gageports and their measuring devices, and have mapped
the Gageport ports to ‘sensor numbers’. The Gageport subroutines can now be used in a PROCAL program and collect data
from the Gageport devices.
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15.4 Gageport Program Examples

Example 1:

The program will call the ‘Read Gageport — RGP’ subroutine to read from Port 1 of a Gageport. The Gageport
will be activated in ‘read immediate’ mode. The device connected to the Gageport is a B&S DigitCal (Gage
number 1), and the port has been mapped to ‘Sensor 1’

Include:Library

Units:All("mm")

Format:Numeric(3,4)

Define:Meas(DO01, Cal_Diameter, 12.800, 0.050, -0.050, 1, 0)
Set:Error Text("DO01 Cal_Diameter [ DO1 — @ Cal]™)
CALL("RGP", 1, 0, "", E[64], 0)

Compute:Meas(D01, E[64])

Set:Error Text( )

Example 2:
This program will read a transducer probe that has been calibrated. The probe has been mapped to Sensor
number 1, and has a factor of 0.001 set in the Gageport Setup screen (via the PluginManager).

Probe.pcl

{This program calls a segment that contains calibration data from the probe. The file that contains }
{The calibration data 'CalData’ is called by the RCGP command and modifies the subsequent }
{Readings of the probe by adding the calibration data to the probe reading }

Include:Library
Include:Segment("Cal Master")

Units:All
Format:Numeric(3,4)
Define:Meas(B01, Bore Diameter, 7.750, 0.050, -0.050, 1, 0)

Set:Error_Text("BO1 Bore Diameter [ BO1 — © Bore]")

CALL("RCGP", 1, 2, CalData,"Press SPACE to capture probe reading", E[60], 0)
Compute:Meas(B01, E[60])

Set:Error_Text( )

Cal_Master.pcl

{ This segment is called from the program Diameter.pcl and takes a reading from the probe and }
{ then prompts for the Calibrated Bore diameter that it has just measured. The 'master }

{ diameter' value then has the probe reading subtracted from it and the result stored in the }

{ 'CalData' file which is created in the Userdata directory }

CALL("RGP", 1, 2, "DiaTest = %]1.4f Press SPACE to store", E[1], 0)
CALL("WCGP", CalData, "Enter Master Value", E[1])
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15.5 Gageports - Digital NT and Probe NT

The GP-2102NT has two ports and has been set up to emulate the Gageport it replaces (GP 2220). A list of gage
numbers/codes representing different gauge types are listed in the Gageport manual and in the Gageport
Number Table. However if your particular instrument is not listed, contact your Brown & Sharpe Profile agent
for assistance.

Probe (LVDT) NT Gageport

The GP-0602NT probe Gageport has 8 ports allotted to it. The Gageport can read up to 8 probes individually or
4 pairs of differential probes. The type of reading it takes depends on the gauge type number/code entered.

The Gageport itself has 2 probe ports and an expansion port. If more than two probes are required then an
LVDT expansion unit (Part Number 30.909012) can be used with an expansion cable, which will connect to the
expansion port of the Gageport. The expansion unit has 8 probe ports, which is why each Probe NT Gageport
have 8 ports allotted to them.

Probe Gageport

O 6—-“”"_’ Port 2 Ports
@ 12345678
/

8 Port Expansion Unit

When an 8 port expansion unit is connected to the expansion slot of a probe Gageport it deactivates the two
ports on the Gageport itself.

Note:

When using differential probes the port number to use is that of the first probe, the second probe must be
connected to the adjacent port. Differential probes are associated as follows, Port 1 with Port 2, Port 3 with Port
4, Port 5 with Port 6, and Port 7 with Port 8.
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15.6 Gageport Gage Number Table GP2102-NT
Gage N° Description

0 No Gage
1 B&S Digit-Mike plus, Forced
2 B&S Digit-Mike plus, Allowed
3 B&S DigitCal plus, Forced
4 B&S DigitCal plus, Allowed
5 No Gage
6 Starret, Forced and Allowed (Caliper must use G-1300 cable)
7 Sylvac Mark III Forced
8 Sylvac Inches (ST Industries), Forced
9 Chicago Dial indicator (Ultra Digit III), Forced
10 Federal Maxum, Forced
11 John Bull Indicator (Ultra Digit 1), Forced (Use G-0201-B or GS-0201)
12 Ono Sokki EG-225 (Digit Dial plus), Forced
13 NSK Inches (MaxCal, Digitrix), Allowed
14 Mitutoyo, Both Forced and Allowed
15 Master Auto Detect, includes Mitutoyo
16 RS232 1200, N, 8, 1, field 1 (Customisable)
17 RS232 1200, E, 7, 1, Field 1
18 RS232 1200, N, 8, 1, Field 2
19 RS232 1200, E, 7, 1, Field 2
20 RS232 9600, N, 8, 1, Field 1
21 RS232 9600, E, 7, 1, Field 1
22 RS232 9600, N, 8, 1, Field 2
23 RS232 9600, E, 7, 1, Field 2
24 Sylvac Metric (ST Industries), Forced
25 Chicago Dial Indicator - 0.00005 resolution (Ultra Digit III), Forced
26 Federal Maxum - 0.00005 resolution, Forced
27 1200, N, 8, 1, Primary field= Field 1, Buffer A=field 2
28 1200, N, 8, 1, Primary field= Field 1, Buffer A=field 2, Buffer B=field 3
29 9600, N, 8, 1, Primary field=Field 1, Buffer A=field 2
30 RS232, Buffer A
31 RS232, Buffer B
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LVDT Probe Gageport Gage Number Table GP0602-NT

Gage N° Res](3)liflstion Frequency Gain Delta Min Max Avg
Half Bridge
0 11 . 5.1Khz 1X +A 0000 2048 8
1 11 5.1Khz 1X +A+B 0000 4096 8
2 11 5.1Khz 1X +A-B 0000 4096 8
3 11 5.1Khz 1X -A-B 0000 4096 8
4 11 5.1Khz 10X +A 0000 2048 16
5 11 5.1Khz 10X +A+B 0000 4096 16
6 11 5.1Khz 10X +A-B 0000 4096 16
7 11 5.1Khz 10X -A-B 0000 4096 16
Full Bridge
8 11 12.8Khz 1X +A 0000 2048 16
9 11 12.8Khz 1X +A+B 0000 4096 16
10 11 12.8Khz 1X +A-B 0000 4096 16
11 11 12.8Khz 1X -A-B 0000 4096 16
12 11 12.8Khz 10X +A 0000 2048 32
13 11 12.8Khz 10X +A+B 0000 4096 32
14 11 12.8Khz 10X +A-B 0000 4096 32
15 11 12.8Khz 10X -A-B 0000 4096 32
Half Bridge
16 16 5.1Khz 1X +A -32768 32768 8
17 16 5.1Khz 1X +A+B | -32768 32768 8
18 16 5.1Khz 1X +A-B | -32768 32768 8
19 16 5.1Khz 1X -A-B -32768 32768 8
20 16 5.1Khz 5X +A -32768 32768 16
21 16 5.1Khz 5X +A+B | -32768 32768 16
22 16 5.1Khz 5X +A-B | -32768 32768 16
23 16 5.1Khz 5X -A-B -32768 32768 16
Full Bridge
24 16 12.8Khz 1X +A -32768 32768 16
25 16 12.8Khz 1X +A+B | -32768 32768 16
26 16 12.8Khz 1X +A-B | -32768 32768 16
27 16 12.8Khz 1X -A-B -32768 32768 16
28 16 12.8Khz 5X +A -32768 32768 32
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29 16 12.8Khz 5X +A+B | -32768 32768 32
30 16 12.8Khz 5X +A-B -32768 32768 32
31 16 12.8Khz 5X -A-B -32768 32768 32

KEY:

Bits Resolution:

The A/D resolution selected by the associated gage. Gage numbers 0 to 15 select 11 bit operation for backwards
compatibility with the GP-0629. The remaining Gage numbers select 16-bit operation.

Frequency:

The excitation frequency supplied to the probe

Gain:

The gain setting essentially trades increased resolution for reduced range. For example, a gain setting of 1X
indicates that the resolution of the Gageport can handle the probes entire range of travel; a gain setting of 5X
indicates that the resolution of the Gageport can handle 5 times the standard resolution over one fifth of the
probes entire range of travel.

Delta:
The mode (+A,+A+B,+A-B,-A-B) associated with the probe

Min:
The smallest A/D unit reported in the selected configuration. For Gages 0 to 15, 0 is the smallest A/D unit
reported. For the remaining Gages, the full range of +/-32768 A/D units is available.

Max:

The largest A/D unit reported in the selected configuration. For Gages 0 to 15 configured as single probes, the
largest A/D unit reported is 2048. For Gages from 0 to 15 combining two probes the largest unit reported is
4096. For the remaining Gages, the full range of +/-32768 A/D units is available.

Avg:
The number of samples averaged to generate the reported reading.
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15.7 Gageport Diagnostics

This is a useful tool if the Gageport does not appear to be working as expected, or to test that the Gageport(s)
have been set up correctly. The option can be accessed from the Plugin Manager screen. Select the Gageport
plugin from the Plugin Manager window. This will activate the Diagnostics and Setup buttons at the bottom of
the page. Upon selecting the Diagnostics button the following dialog box will be displayed.

3.0000

2059.0000
2051.0000
1022.0000
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Upper Window
This can be used to check how the Gageport has been configured.

Sensor: A number is given to every Gageport port that has been detected.
Port: This is a list of ports on each Gageport that have been detected.
Model:  Lists the actual Gageport model that has been detected.

Version: The Gageport software version of the Model.

Gage #: The Gage number of the device connected to the Gageport.

Reading: This column displays the last reading taken from the Gageport ports.

Lower Window

This window displays the communications between the software and the Gageport device. It will be apparent
from this window whether the software is talking correctly to the Gageports. By selecting the Reading button, a
reading can be forced from all of the connected ports. The readings will be displayed in the Reading column in
the upper window.

Note :
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The page title is Stack 1. This refers to all of the devices connected to COM port 1. Devices connected to COM
port 2 will be on page Stack 2, etc ...

15.8 Gageport Port Assignments

The following table is a guide to how the Gageports assign port numbers to themselves. This is useful
information when used in conjunction with the Device Mapping screen which lists all of the ports it has
detected. Under normal circumstances, Gageport port assignments are worked out automatically by the
software. However if the Gageports do not appear to be operating as expected, and there is no obvious fault, it is
worth comparing the list shown in the Device Mapping window to the table provided to check for any
mismatch.

Expansion Slot Port Number (by GagePort type)
Box N®. Number I Port 2 Ports 4 Ports 8 Ports
16 31 31-32 29 -32 25-32
4 15 29 29-30 29 -32 25-32
14 27 27-28 29 -32 25-32
13 25 25-26 29 -32 25-32
12 23 23-24 29 -32 25-32
3 11 21 21-22 29 - 32 25-32
10 19 19-20 29 —-32 25-32
9 17 17-18 29 -32 25-32
8 15 15-16 29 -32 25-32
. 7 13 114 25-28 25-32
- 6 11 11-12 21-24 25-32
5 9 9-10 17 -20 25-32
4 7 7-8 13-16 25-32
| 3 5 5-6 9-12 17-24
2 3 3-4 5-8 9-16
1 1 1-2 1-4 1-8

Example:

You are placing a 2 port Gageport in the 3™ slot of a second expansion box.
1. Move to the rows that apply to expansion box 2
2. Move to the specific row that represents the expansion box’s 3 slot (in the example this is labelled 7)
3. Move to the column that represents a 2 port Gageport
4. The values held in this row and column combination are the port numbers assigned to your Gageport —
port 13 and port 14.
Note :
Whenever multiple Gageports are being stacked, those Gageports that have the fewest ports must be placed at
the bottom of the stack. The number of ports available to stacked Gageports must be in ascending order else
invalid assignments will occur.
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16 Pro-Composer Introduction
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16.1 Pro-Composer Introduction

Pro-Composer is a graphics based method of creating measurement programs used by the range of Profile
Measuring systems. The dimensional data of the component to be measured is embedded into a measurement
program that the software generates.

The software is designed to facilitate simple customisation of the measuring system by providing a means to
create measurement programs in a graphical Cad-like environment.

The programs created, when saved can be used by Pro-Measure software for actual component measurement. It
is also possible to edit the program using Pro-Composer if modifications are required at a later date.

16.2 Profile Measurement - Basic Concepts

Information about the component being measured is gathered by moving the component through the measuring
position and recording the readings from the CCD arrays at a number of points along the component. This
process is known as 'Scanning' the component. The readings obtained during a scan are stored as XY co-
ordinates of the surfaces of the component. As an alternative to Scanning, the component data can also be
entered by importing a CAD drawing.

A picture of all, or part, of the component is then displayed on the computer screen with the co-ordinate axes in
the conventional arrangement of +X to the right and +Y upwards. This picture is known as a SCHEMATIC and
the area that it appears on the screen is known as the WORKSPACE WINDOW.

The equivalent axes on the projector screen and at the component itself are as shown in the diagram.
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Following the data gathering and generation of the schematic, one or more MEASUREMENT ZONES are
defined. This is done by marking up the location of the zone on the schematic picture and setting the properties
and conditions of each particular measurement.

All of the information about the component, measurement zones and measurement properties are combined
together to create a Measurement Program. This is known as a PROCAL program. This program contains all of
the information required to carry out the measurement routine. When the program is run (using the Pro-Measure
Software) and the data for the component under inspection has been gathered, data within a zone is then
examined to compute the specified features, e.g. a diameter or an edge position. These computed measurements
can then be output to the VDU or can be combined before output in cases where a measurement is determined
from more than one feature, e.g. two edges are needed to compute a length.

Once the measurement results are displayed on the computer screen, the information can be stored for archive,
input into an SPC application or Printed onto hardcopy.

There are several configurations of Profile machines available. The machine could be of a horizontal (i.e. P180)

or vertical ( i.e. P20, P30, P80) configuration. Also, some machines will not have a projector screen. Although
the machine configuration can vary, the relationship between the component axis and XYZ does not.
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17 Overview of Pro-Composer User
Interface
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17.1  Overview of Pro-Composer Design

When you start Pro-Composer, you see the main window and all of its working components.
The display is split into several areas.

1. Main Menu 5. Features Toolbar

2. Standard Toolbar 6. Schematic Workspace Window
3. Zoom Toolbar 7. Title Bar

4. Edit Toolbar 8. Status Bar

000032._sch
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17.2  Workspace Window

The largest window area of the screen is the Workspace Window. This is where the schematic of the component
is displayed.

The standard windows controls for re-shaping and re-sizing apply to this window and also it is directly affected
by the display 'Zoom' commands.

All work relating to the schematic is carried out in this window.

Note :

You may use the New Window command (Window Menu) to open another copy of the workspace window.
This will allow you to have multiple views of the same schematic.

You can also have multiple schematics open at a time, each with multiple workspace windows.

17.3 Schematic Overview Window

The Schematic Overview window is a small window that can be opened when viewing a schematic. It shows the
component outline of the currently active Workspace window. The component is displayed to its extents and
can indicate several conditions of the Workspace.

These are as follows :
It the Workspace window is shown to its extents then the whole area of the Overview window will be shaded.

If the Workspace window is zoomed into a particular area, then this area will be shaded in the Overview
window.
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If the Workspace window is zoomed in such that the detail cannot be shown in the Overview window, it will
display a cursor in the vicinity of the current Workspace view.

The Overview window will also display 'Best Fit' lines.
Note : The Schematic Overview window can be toggled on or off using the Overview command (View menu)

17.4 Status Bar

The status bar is displayed at the bottom of the Pro-Composer window. To display or hide the status bar, use the
Status Bar command in the View menu.

The left area of the status bar describes actions of menu items and toolbar buttons as the cursor is moved over
the options.

The central area of the status bar shows information about the current workspace area settings.

The right areas of the status bar indicate which keys are latched down.
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Indicator Description

The X and Y indicators show the current position of the cursor in the workspace area. This will automatically
update as the mouse moves the cursor about the screen. The values displayed are in the current schematic units.
The units type can be changed in the Schematic Properties Dialog box.

The Grid indicator shows the setting for the pitch of the workspace area guideline grid. This will change
automatically depending upon the zoom ratio.

The Zoom indicator shows the current display zoom ratio of the workspace area.

The Units indicator shows the dimensional unit setting for the current session. i.e. MM or Inch.

CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.

17.5 Title Bar

70 .. i

The title bar is located along the top of a window. It contains the name of the application and document.
To move the window, drag the title bar.

A title bar may contain the following elements:
Q Application Control-menu button
Document Control-menu button

Maximise button

Minimise button
ﬁj Restore button

Close button

Note: You can also move dialog boxes by dragging their title bars.

17.6 Scroll Bars

These are the shaded bars along the right side and bottom of a document window. To scroll to another part of
the document, drag the box or click the arrows at either end of the bar. If a document is being viewed to its
extents, either or both of the scroll bars will not be visible.
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18 Pro-Composer Menu Commands
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18.1 Main Menu Commands

This is the main control menu bar which contains the major system functions and operations.
Commands

File menu

Edit menu

View menu

Scan menu

Tools menu

Window menu

Help menu

18.2 File menu commands

The File menu offers the following commands:

New Creates a new document.

Open Opens an existing document.

Close Closes an opened document.

Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Delete Deletes a specified document.

Print Prints a document.

Print Preview  Displays the document on the screen as it would appear printed.

Print Setup Selects a printer and printer connection.
1,2.3.4.... Option to re-load one of the four most recent schematics.
Exit Exits Pro-Composer.
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18.3 New command (File menu)

Use this command to create a new document.

You can open an existing document with the Open command.
Shortcuts

Keys: CTRL+N

184 Open command (File menu)

Use this command to open an existing document in a new window. You can open multiple documents at once.
Use the Window menu to switch among the multiple open documents. See Window 1. 2. ... command.

You can create new documents with the New command.

Shortcuts

Keys: CTRL+O

18.5 Close command (File menu)

Use this command to close all windows containing the active document. The program will suggest that you save
changes to your document before you close it. If you close a document without saving, you lose all changes
made since the last time you saved it. Before closing an untitled document, the application will display the Save
As dialog box and suggest that you name and save the document.

You can also close a document by using the Close option on the document's window control menu. This menu
is accessed by selecting the icon that appears in the top left corner of the document window.

18.6 Save command (File menu)

Use this command to save the active document to its current name and folder. When you save a document for
the first time, the program displays the Save As dialog box so you can name your document. If you want to
change the name and folder of an existing document before you save it, choose the Save As command.
Shortcuts

Keys: CTRL+S

18.7 Save As command (File menu)

Use this command to save and name the active document. The program displays the Save As dialog box so you
can name your document.
To save a document with its existing name and folder, use the Save command

18.8 Delete command (File Menu)

This option allows you to delete a schematic document. When selected, the file selector dialog box will be
presented. Select the file you wish to delete and then press the 'Ok’ button. You will be asked to confirm that
you really want to delete the selected file. Press the 'Ok’ button to proceed or 'Cancel' to abort the operation.

18.9 Print command (File menu)

Use this command to print a document. This command presents a Print dialog box, where you may specify the
range of pages to be printed, the number of copies, the destination printer, and other printer setup options.
Shortcuts

Keys: CTRL+P
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18.10 Print Preview command (File menu)

Use this command to display the active document as it would appear when printed. When you choose this
command, the main window will be replaced with a print preview window in which one or two pages will be
displayed in their printed format. The print preview toolbar offers you options to view either one or two pages
at a time depending upon the application; move back and forth through the document; zoom in and out of
pages; and initiate a print job.

18.11 Print Setup command (File menu)

Use this command to select a printer and a printer connection. This command presents a Print Setup dialog box,
where you specify the printer and its connection.

18.12 1,2,3,4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the most recently used documents.
Choose the number that corresponds with the document you want to open.

18.13 Exit command (File menu)

Use this command to end your current session. You can also use the Close command on the application Control
menu. The program prompts you to save documents with unsaved changes.

Shortcuts

Mouse: Double-click the application's Control menu button. This is the icon at the top left corner of the
application window.

Keys: ALT+F4

18.14 Delete All Measurements command (Edit Menu)

This option will remove all of the Features that have been defined on the Schematic. Once selected, you will be
prompted to confirm that you want to delete all the features.
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18.15 View menu commands

The View menu offers the following commands:
Toolbar Shows or hides the toolbar.
Feature Shows or hides the measurement features on the schematic

Status Bar Shows or hides the status bar.
Overview Shows or hides the Overview window.

Properties ~ Opens the Schematic Properties setting dialog box.

18.16 Toolbar command (View menu)

Use this command to display and hide the Toolbars. When this option is selected, a sub menu appears which
lists the four toolbars. A check mark appears next to the menu item when the Toolbar is displayed. If you wish
to hide a specific toolbar, click the name on the sub menu and the toolbar should disappear. To display the
toolbar, select the option again and click the name of the toolbar.

The last option on the sub menu is 'Large Buttons'. Selecting this causes all the toolbar buttons to be displayed
in a larger format. Toggle this option to switch between large and small buttons.

See Toolbars for help on using the toolbar.

18.17 Feature command (View menu)

Use this command to display and hide specific measurement Feature types displayed on the schematic in the
workspace area. A check mark appears next to the menu item when the feature type is displayed.
See Features Toolbar for help information on the specific features.

18.18 Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the selected
menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to the menu item
when the Status Bar is displayed.

See Status Bar for more detailed status information.

18.19 Overview command (View menu)

Use this command to display the Schematic Overview window. This window shows an outline view of the
schematic at its extents. If an area of the schematic in the workspace window has been enlarged using the zoom
commands, this region will be indicated in the overview window by a shaded area. In addition, zones and best
fit markings will also be shown in this window if active in the workspace window. The measurement labels will
not be shown in this window.

Shortcuts

Alt, V, O.
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18.20 Properties command (View menu)

Use this command to display the Properties Dialog box where you can set global schematic properties such as
Units (mm or Inch), etc.

Shortcuts
Move mouse into an open space in the workspace window and press the right hand mouse button. A small
floating menu will appear with a 'Properties’ option. Select this option.

18.21 Scan menu commands

The Scan menu offers the following commands:

Scan Component Scans the component and inputs dimension data in the computer.
Region Sets the component scan region.

Set Component Sets the component position relative to a datum.

Position

Import Imports component data into a schematic from an external source.

Exports component schematic data for use with other applications.

‘:J
X
e
=

18.22 Component command (Scan menu)

Use this command to scan the entire component with the gauge between user defined 'start' and 'end' positions
to create an image for programming. The separation between measured points depends on the length of scan :

;Scan Length (mm) Spacing (micron)
L<10 D
10 <L <100 IL/5
100 <L 20
Shortcuts
Keys: ALT+S, then C
Note :

This option will only be available if the gauge is calibrated.
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18.23 Region command (Scan menu)

Use this command to scan a region of the component. This option allows additional data to be gathered in fine
detail areas of the component. Upon selection you will be able to define a window on the component in the area
of interest. This area will then be scanned.

Shortcuts

Keys: ALT+S, then R

Note :

This option will only be available if the gauge is calibrated.

18.24 Set Component Position (Scan menu)

This command scans the component position between user defined 'start' and 'end' positions and then permits
the re-definition of a measurement zone for reference edge EO1. This is needed to define the location of EQ1
relative to machine datum if the image has been imported from a CAD drawing or the position needs re-
defining. Before you can use this command, you must have a reference edge defined on the schematic with the
label EO1.

Shortcuts
Keys: ALT+S, then S

Note :
This option will only be available if the gauge is calibrated.

18.25 Import command (Scan menu)

Use this command to import a DXF CAD file into Pro-Composer to create a schematic.

Shortcuts
Keys: ALT+S, then I, then D

18.26 Export command (Scan menu)

Use this command to export a Pro-Composer schematic into other formats.

Shortcuts
Keys: ALT+S, then E.

Tools Menu commands

The Tools menu offers the following commands:
Language Changes the language of the application, in a limited manner.

Machine Settings Options for manual control of the gauge.

Options General settings for Pro-Composer, inc. folder Paths, File selector options and Password Setup.
Backup Saves Machine specific data to disk for use in future Software re-installations.
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18.27 Language command (Tools menu)

Use this command to change the language text used within the program. All the languages available will be
shown as options.

Notes :

This option is provided as a quick means to switch languages and only changes the text language specific to the
application. Where standard Windows functions are used by the application i.e. the standard windows File
Selector or Print dialog boxes, the language of these will be that of the installed Windows version. If you
require the program to be 100% localised with regards to language text you must install a localised version of
the Windows operating system of the Language you desire.

This language change is not permanent and will revert to the Windows Operating system language when you
begin the next session.

Changing the language with this option will change the corresponding Help file language also. The Advanced
Procal Keyword reference section (Pro-Measure On-line Help) will only be available in English.

18.28 Machine Settings command (Tools menu)

Use this command to display the Machine Settings Dialog box where you can manually control the machine
connected to the computer. You can datum or move any of the axes available.

Note : The options available will vary depending upon machine type.

18.29 Options command (Tools menu)

Use this command to display the Options Dialog box where you can set global environment options for the
software such as default folder paths, passwords and file selector options.

18.30 Backup command (Tools menu)

This command is used to Backup machine specific data. It can be saved to floppy disk for use in future re-
installations.
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18.31 Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

New Window Creates a new window that views the same document.
Cascade Arranges windows in an overlapped fashion.

Tile Arranges windows in non-overlapped tiles.

Arrange Icons Arranges icons of closed windows.

Window 1,2, ... Goes to specified window.

18.32 New command (Window menu)

Use this command to open a new window with the same contents as the active window. This enables you to
display parts or different views of a document at the same time. If you change the contents in one window, all
other windows containing the same document reflect those changes. When you open a new window, it becomes
the active window and is displayed on top of all other open windows.

18.33 Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion.

18.34 Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.

18.35 Arrange Icons Command (Window menu)

Use this command to arrange the icons for minimised windows at the bottom of the main window. If there is an
open document window at the bottom of the main window, then some or all of the icons may not be visible
because they will be underneath this document window.

18.36 1,2,...command (Window menu)

The application displays a list of currently open document windows at the bottom of the Window menu. A
check mark appears in front of the document name of the active window. Choose a document from this list to
make its window active. If there are more than 9 windows to choose from, a 'More Windows' option will be
available. This option provides a 'Select Window' dialog box to choose the window from.
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18.37 Help menu commands

The Help menu offers the following commands, which provide you assistance with this application:

Help Topics Offers you an index to topics on which you can get help.
About Displays the version number of this application.

18.38 Help Topics command (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can jump to step-by-
step instructions for using the software and also reference information.

18.39 About command (Help menu)

Use this command to display the copyright notice and version number for your copy of this application.

18.40 Floating Menu Commands

These are menus that appear at the mouse pointer location when the right hand mouse button is clicked inside
the schematic workspace window.

If the right hand mouse button is clicked on a blank area of the schematic, general schematic options will be
available.

If the right hand mouse button is clicked on a feature label, options specific to the selected feature will be
available.

18.41 Label Floating Menu

Zones
This option will display the Zone for the selected feature. Once the zone is visible, it can be edited .

Dependants
If the selected feature has other features dependant on it, this option will display a list of all the dependant
features.

Delete
This option deletes the selected feature from the schematic. If a feature has dependants, it cannot be deleted, A
list of dependants will be displayed if a feature is attempted to be deleted that has dependants

Properties
This option will open the measurement properties dialog box for the selected feature.

18.42 Schematic Floating Menu

Delete All Measurements
This option as Delete All Measurements command (Edit menu).

Properties
This option as Properties command (View menu)
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19 Pro-Composer Toolbars
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19.1 Toolbars

The toolbars are displayed across the top of the application window, below the menu bar and also down the left
hand side of the screen as default. The toolbars provide quick mouse access to many tools used in Pro-
Composer.

There are four separate toolbars each relating to different aspects of the application.

The four toolbars are as follows :-

Standard - This provides the basic file and print functions.

Features - This provides the different measurement feature selection.
Zoom - This provides the workspace display zoom controls.

Edit - This provides the accept, cancel and best fits buttons for use when defining or editing the measurement
zones, regions and component positions etc.

Note :

To hide or display the Toolbar, choose 'Toolbar' from the 'View' menu (ALT, V, T).

All of the toolbars can be relocated on the screen. Each can be dragged by holding down the mouse pointer in
the area that surrounds the toolbar buttons and then dragging. All toolbars can be 'docked’ on the four sides of
the Pro-Composer Application window with the exception of the Features toolbar which can only 'dock’ on the
left hand edge of the window. All toolbars can be left 'floating' on the display.

The toolbar buttons can be set to be displayed large or small. The 'Large Buttons' option on the Toolbar
command (View Menu) toggles the size of the toolbar buttons.

19.2 Edit Toolbar

Accept the option or details as shown.

Cancel the selected option and any
changes made.

Toggle the best fit options for the
measurement zone.
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19.3

Zoom Toolbar

Zoom Select button. This button has several functions which affect the display of the schematic
within the workspace window.

Zoom Extents button. This will make the schematic fit the workspace window such that the whole
schematic is within view. It is automatically sized to fit the display.

Note : The Zoom options only affect the current active window. This allows you to control the display
magnification ratio within separate windows.

Hint : Have the same schematic open in two windows, use one window for a close up zoom and the other for a
complete overview

19.4

19.5

Zoom Extents Button

This will make the schematic fit the workspace window such that the whole schematic is within view.
It is automatically sized to fit the display.

Zoom Select Button

This button has several functions which affect the display of the schematic within the workspace
window. Select the Zoom button from the Zoom toolbar to make the function active.

Once the Zoom button is active (i.e. depressed), by clicking the left hand button of the mouse at a point
on the schematic, the image of the component will be magnified by a predefined ratio. Each subsequent
click will enlarge the image further. The magnified image is centred about the point on the schematic of
the mouse click.

If you wish to make the image smaller and zoom away from the schematic, click the right hand mouse
button at the point you wish to zoom away from.

A further feature is to zoom into a user defined region as opposed to selecting a point. This can be done
by pressing the left hand mouse button to select the first corner of the region, hold this button down and
drag the pointer across the workspace to the opposite corner of the region you desire. A dashed line
indicates the region you have selected. When you release the mouse button, the contents of the defined
region will be displayed magnified in the workspace window.

19-3



19.6 Standard Toolbar

Open a new document.

Open an existing document. Pro-Composer displays the Open dialog box, in which you can locate
and open the desired file.

Save the active document or template with its current name. If you have not named the document,
Pro-Composer displays the Save As dialog box.
Print the active document.

Displays the Name and Version of this application.

Activate the context sensitive help system.

19.7 Features Toolbar

Diameter

Radius

Groove Depth
Form Deviation
Centre-Line
Thread
Concentricity
Run Out

Rotation Diameter

Straightness

Across Flats

Angular Positions

Offset Diameter
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Note :
These buttons show the GROUPS of measurement types supported.
Certain features may only be available if the particular hardware option is fitted e.g. Thread measurement.
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20 Pro-Composer Dialog Boxes
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20.1 Dialog Boxes and their settings

A dialog box is a window which requires the user to enter data and information used for settings within the
application. Each of the parameters are shown in the dialog box window with a default condition. They can
remain in this state or changed to suit a specific requirement.

Depending upon the type of parameter, the option will be presented in different ways. They are as follows :-

Input Box Click the mouse cursor into box and then use keyboard to !Text 123

modify the value.

Drop-down Menu

Click the mouse on the

button to show more options, then | Option 1.

Box click the mouse onto the option of your choice.
Check Box Click inside the box to select or de-select the option. -
Option Buttons Click inside the button to select that option. e’ ®

The options can be changed by using the mouse or the keyboard. The TAB key on the keyboard can be used to
move the cursor to the next option setting. The space bar can be used to select check box options. The cursor
keys can be used to select 'drop-down menu' and 'option button' options.

Some input boxes may have predefined options selectable using the ke or Leud buttons. The content of the text
box should change when either of these buttons are pressed. These are usually numeric inputs and the direction
of the arrow will increase the number accordingly in that direction.

It may be that some settings cannot be modified. In this case, the setting will be shown but only in a 'greyed out'
form. You will not be able to modify these settings.

There may be several pages of setting information within a dialog box denoted by folder like tabs at the top of
the dialog box window. By clicking the mouse onto the tab, the corresponding setting page will be displayed.
Once all the parameters are as desired, click the mouse onto the 'OK' button to accept the changes and close the
dialog box. If you want to apply the changes but not close the dialog box, press the 'Apply' button.

If a previously defined measurement is being edited, any setting changes can be discarded by pressing the
'Cancel' button.
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20.2 Options Dialog Box

There are a set of parameters that apply to the general operation of Pro-Composer. These items include the
folder paths for files, file selector control and password control. These settings are specific to the Pro-Composer
environment and not document specific. Any changes made to these settings will be remembered in future
sessions of Pro-Composer and may be changed at any time.

The Options dialog box is obtained by selecting 'Options...' from the 'Tools' menu. The dialog box has four
Pages each accessible by pressing the corresponding tab at the top of the window.

The Pages are as follows :-

Folders Folder Path settings for program files.

Advanced Advanced options.

Passwords Password settings and control. Passwords can be used to restrict access to certain parts of the Program.
If they have been set and a restricted area is selected, the password will be requested.

Selector  File selector settings.

20.3 Options - Advanced Page

Use Windows File Selector

This option allows you to change between the standard Windows file selector or the custom Brown & Sharpe
file selector. The Brown & Sharpe File selector allows more secure access to files including the ability to Hide
folders and set folder Backstops. A tick in this option means the Standard Windows file selector will be used, no
tick against the option means the Brown & Sharpe file selector will be used.

20.4 Options - Folders Page

This page contains the file paths for the various types of files used by Pro-Composer. The locations will be set
to default positions and it is not recommended that you deviate from these. The facility is provided to allow
flexibility for installations that may wish to store/retrieve files using a PC Network.

Schematic
This is the file folder path where the Pro-Composer schematics are located.

Import DXF
This is the file folder path where the DXF files for import are located.

Reference Standards Databases
This is the file folder path where the Reference Standards Database files are located.

User PROCAL Headers & Footers
This is the file folder path where the User PROCAL files used for Headers and Footers are located.

Use the button to activate the file selector to choose the folder for the specific setting. Alternatively you
may type in the full path manually.
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20.5 Options - Passwords Page

Level 1 : Full Access
This password setting allows Full access to the software environment, no restrictions apply to the password
holder.

Level 2 : Program Creation and Editing
This password setting allows the password holder access to the Program Creation and Editing Functions.

Level 3 : Calibration
This password setting allows the password holder access to Calibration functions

Level 4 : Measurement
This password setting allows the password holder access to the measurement functions.

Set

The 'Set' button presents the '"New Password' Dialog box. This is where you enter the password. Click the mouse
into the text boxes and type in the password you have chosen. You will notice that the password isn't displayed
on the screen. Press the 'OK' button to accept your changes. If you don't use the same password in each box, a
warning message will be displayed.

If you wish to remove a password, select the 'Set' option and use the mouse to highlight the password *'s in the
text box and then press the 'Delete’ key on the keyboard. Do this for both password text boxes and then press the
'OK' button.
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[ New Password

Note :
You do not have to set all the passwords, but must follow the convention that all levels below the level you are
setting have to be set first. i.e. To set password Level 3, you must set Level 1 and 2 first.

Warning :

It is important that you do not lose or forget your passwords. There is no way of retrieving them from the
software. If you forget the passwords for Level's 2,3 and 4 then they may be reset by someone with Level 1
access rights. If you lose or forget the password for Level 1 then you will have to re-install the software to reset
the password settings.

Note : If passwords are set, they will affect all Brown & Sharpe installed programs. i.e. Passwords set in Pro-
Measure will be active in Pro-Composer (if installed) and vice versa.

20.6 Options - Selector Page

Hidden Folders/Backstops drop-down menu

This menu gives you the choice setting the Hidden folders or folder Backstops. The Hidden folders are those
which will not be visible in the file selector. This can make finding and selecting files easier since any folders
that aren't relevant can be hidden. The folder Backstops are a locking mechanism that prevents the operator
from moving backwards out of a folder. This prevents access to unauthorised areas of the filing system. Any
folders that have already had attributes set will be displayed in the window just below the drop-down menu. The
contents of this window will change depending upon whether the 'Hidden folders' or 'folder Backstop' option is
selected.

New

This option allows you to select a new folder to be affected by the option chosen in the drop-down menu
(Hidden or Backstop). When this option is selected, the file selector will be opened. You can select the drive
from the drive icons at the top of the file selector. You can select the folder of interest by double clicking on the
folder icons in the main central window area. Alternatively you may type the full path in the text box at the
bottom of the window. If you select the folder by clicking on the folder icons ensure that the correct path
appears in the text box before you accept the settings by pressing the 'OK' button.

Delete

This option allows you to delete a folder 'Hidden' or 'Backstop' attribute that has been set. Click the mouse in
the folder listing window on the folder you wish to delete the attribute for and then press the 'Delete’ button.
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20.7 Schematic Properties Dialog Box

These are a set of parameters that apply to all component schematics. Items include the Units type (mm, inch).
Before any measurement features are defined on the schematic the Schematic Properties must be set first.

These global schematic parameters are set within the Schematic Properties dialog box.

This dialog box is obtained from the 'Properties' option on the 'View' menu. Alternatively the right hand mouse
button can be pressed in an empty area of the workspace window. From the menu that appears, select the
'Properties' option.

The dialog box has two Pages each accessible by pressing the corresponding tab at the top of the window.

The Pages are as follows :-
Measurement Global Parameters relating to measurements

User Procal Header and Footer Options

| 5 chematic Properties

C:\Program Files\Brown and Sharpe‘Dragon
di

20.8 Schematic Properties - Measurement Page

Units

Metric (mm) or Inch Units can be selected. Default Units setting is MM. If the Units are altered after definition
of one or more measurements, all dimensional and measurement data will be automatically converted though
some precision may be lost during the conversion process for certain measurement parameters. In addition, any
selected databases will be switched off. It the units are altered in this way it is recommended that the
measurement properties for each feature are checked.

Printout

This can be toggled on (tick) to print the results after each measurement cycle or off (no tick) if no automatic
printout is required. Default Printout setting is OFF.
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Rounding
This is the value in current measurement units (i.e. mm or inches) to which default Nominal' values will be

rounded. Default USL/LSL values are equal to the value selected in rounding and Xbar UCL/LCL are based on
80 percent of the rounding. Select the rounding value from the drop down rounding menu. Default Rounding
setting is 0.05.

SPC Defaults - On

This tick box sets the default condition for the SPC On/Off option in the 'SPC' page in the Measurement
Properties dialog box. If it is 'ticked', the default condition for all new measurement features will be ON. For
SPC charts to be displayed, the appropriate SPC software must be running on the Profile Measuring system.
Default SPC Defaults setting is OFF.

20.9 Schematic Properties - User PROCAL Page

This page allows you to add Procal code as a Header or Footer to the Pro-Composer Program.

HEADER/FOOTER Drop-down menu
Use the drop-down menu to select the type you want to add.

ADD FILE
This option allows you to select the Procal file to be used as the Header or Footer.

ADD MESSAGE
This option allows you to add a single line message as a Header or Footer. The message will be displayed at the
appropriate point in the program according to the position it is inserted in the Header and Footer list.

DELETE
This option will delete the highlighted file or message from the Header or Footer.

Note :

Headers are always executed before the main measurement code; Footers are always executed after the main
measurement code.

The order in which the Procal files are included is the order in which they will be executed.

Default setting, nothing defined.
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20.10 Measurement Properties Dialog Box

When a measurement zone has been specified and accepted, a measurement properties dialog box window will
appear in which default values for the measurement parameters are displayed.

The parameters which are defined within this window will depend on the measurement type selected and also
the type of Profile Gauge system used.

The window has up to four property pages. Each page is identified by the tab at the top of the window. The
Measurement property page will appear as default. Other pages can be made visible by clicking on the
corresponding tab.

The Page options are as follows :

Measurement
Standards Database
Reference

SPC

When the measurement properties have been accepted, the window will disappear and a feature label will be
displayed. This label can be dragged to a new position if required to make the picture clearer when many
measurements have been defined. The Feature command (View menu) also enables you to control which
features are displayed on the schematic.

| Measurement Properties

Centre-Line:
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20.11 Measurement Properties - Measurement Page

At the top of the window is a drop-down menu box with the Main Measurement type of the selected feature
shown as default. The settings shown on this dialog page relate to this feature. If there are sub-features
available, they will be listed in this menu. When you select a different option from the menu, the page will
display the corresponding parameters for the feature.

The following options are available in the Measurement Page. The options available will vary depending upon
the feature type.

Opens the Sub Measurement Properties window which shows the status of sub features i.e. included or not
included in the actual measurement. A set of tick-boxes control the sub feature status. This option is only available
when sub features are available.

Description

Feature Type

Label

Scan Increment
Edge Increment
USL/LSL

Nominal
Class-Type

'X' Position
Reference Plane 'X'
Number of Starts
Number of Axial hits
Number of hits /360
Diameter

Radius

Angle

Helix Angle

Pitch Diameter
Filter

Warning Limits
Thread Size

Surface Type
Surface Percent
Number of Interruptions
Wire Radius

20.11.1 Description

This is a name which is displayed when the measurement program is run and can be up to 20 characters in
length.

20.11.2 Feature Type

This is a drop-down menu that contains the main feature type name and a list of any sub feature types if
available. Whichever feature is selected in this menu, the dialog box page will show the corresponding
parameter values. i.e. If a thread feature has been defined, upon entry into the Measurement Properties dialog
box, the parameters shown will be those of the main thread feature. If you wish to view specific parameters of
the sub feature 'Pitch Diameter', select this feature type from the drop-down menu and the parameter details
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shown will be now be specific to this feature type. All sub feature type parameters can be viewed in this
manner.

20.11.3 Label

This is a 3 digit identifier which must be either one letter followed by two numerical digits or two letters
followed by one numerical digit.

20.11.4 Scan Increment

This can be set to 'Normal' or 'Fine' and it represents the increment at which measurements are taken axially
along the component length.

'Fine' should be used for small features and 'Normal' for larger features. The actual increment settings are
defined as a length between measurements, or as the number of measurements within the zone.

FINE NORMAL
Diameter-average, max. form, min. form, min metal, 0,020 mm 0,100 mm
turned, diameter at X,
Centre-line, straightness, concentricity average. 0,020 mm 0,100 mm
Concentricity, max. form and gauge diameter. 0,005 mm 0,020 mm
Normal edge and incremental edge 0,002 mm 0,010 mm
Gauge diameter, diameter at intersect, line-line 100 hits 20 hits
intersect, angle, radius, radius centre and radius
intersect.
Angular 0.1 Degree 1 Degree

Note : Not all measurement types require a SCAN INCREMENT parameter.

20.11.5 Edge Increment

This is the Y radial value which is used by the 'Incremental Edge' measurement feature. The value can be either
positive or negative.

20.11.6 USL/LSL

These are upper and lower tolerances relative to the nominal value. The default values are the current 'rounding
value but can be edited to the values shown on the part drawing. Positive, negative and zero values are
permitted but the value for USL must be greater (i.e. more positive or less negative) than the value for LSL.
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20.11.7 Nominal

The value shown is the rounded value from the component scan. This can be edited to the correct value as
shown on the part drawing if required.

20.11.8 Class-Type

The following classifications are available :

20.11.9 Pass/Fail

Fail if outside either tolerance limit.

20.11.10 External

Fail if below lower limit, Rework if above upper limit.

20.11.11 Internal

Fail if above upper limit, Rework if below lower limit.

20.11.12 Pass/Rework

Rework if outside either tolerance limit.

20.11.13 None

No classification based on this dimension.

20.11.14 'X' Position

This value defines the axial position at which a particular measurement is calculated.

20.11.15 Number of Starts

Defines the number of starts on a thread. The value can be toggled between 1 and 4.

20.11.16 Number of Axial Hits

Defines the number of axial locations at which rotational scans are to be taken over the specified zone. The
value can be toggled between 1 and 4.

20.11.17 Number of Hits / 360

Defines the number of angular positions used during a single rotational 360 degree scan.

20.11.18 Diameter

Defines the diameter at which a particular measurement is calculated.
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20.11.19 Radius

Defines the reference radius used for certain measurement calculations.

20.11.20 Angle

Defines the reference angle used for certain measurement calculations.

20.11.21 Helix Angle

Defines the slew angle of the slide to be used during a thread measurement.

20.11.22 Pitch Diameter

Defines the reference diameter at which worm thread dimensions are to be calculated from.

20.11.23 Filter

This is a filter function applied to scanned data to filter out dirt. Options are Heavy, Medium, Light and OFF.
Default setting is OFF.

20.11.24 Warning Limits

This is a threshold level for a warning given at a defined percentage of the Upper or Lower specified limits. If
the measured value is within the drawing specification but outside the warning limits, a warning classification
will be displayed. The range can be set between 50 and 100 percent.

20.11.25 Thread Size

The nominal size of a thread. This appears only in the standards database. It is used by the DIN228Inch,
DIN228mm, DIN3858 Inch, DIN3858 MM, DIN40430Inch, DIN40430MM, NPT MM, NPT Inch standards
databases, and the modified Whitworth. e.g. for taper threads, the internal dimension of the pipe it is used with
would be entered here.

20.11.26 Surface Type

For Interrupted surface features (Diameter, Runout and Concentricity of interrupted surface). The Surface Type
is either "Pointed' or 'Constant'. Pointed would be used for e.g. a cutter, and Constant for a surface that is mostly
constant but has regular equi-spaced interruptions as it is rotated.

20.11.27 Surface Percent

For a Constant surface type "% of Surface" selects the percentage of the surface that will be used in the
calculation, so if it is 25% then 75% of the surface around each interruption is discarded.
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20.11.28 No. of Interruptions

The number of interruptions on a component with an interrupted surface. Interruptions are assumed to be evenly
spaced as the component is rotated. The setting has a minimum of three interruptions.

20.11.29 Wire Radius

For Over Wire Diameter and Edge, this gives the radius of the best fit theoretical wire that is fitted against the
surfaces.
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20.12 Measurement Properties - Standards Database Page

At the top of the window is a drop-down menu box with the Main Measurement type of the selected feature
shown as default. The settings shown on this dialog page relate to this feature. If there are sub-features
available, they will be listed in this menu. When you select a different option from the menu, the page will
display the corresponding parameters for the feature.

The following options are available in the Measurement Page. The options available will vary depending upon
the feature type.

_iOpens the Sub Measurement Properties window which shows the status of sub features i.e. included or not
included in the actual measurement. A set of tick-boxes control the sub feature status. This option is only available
when sub features are available.

Feature The features applicable to the standard will be listed with a default parameter. This value will initially be
Types the rounded value obtained from the component scan, which is also displayed as the nominal value on the
'Measurement' page.
If the value is displayed with green text, then it is a valid value according to the selected standard.
If the value is displayed with black text then it is not exactly represented in the chosen database and must
be modified.

Use the or
value manually.
This page is designed such that the values are listed in order of importance from top to bottom. Therefore
for features which have dependants, set the parameters in this order, i.e. the top parameter first working
down the page.

buttons to scroll through the available options for each parameter or type in a new

Grade The 'Grade' drop-down menu box will have the available grading options applicable to the standard,
feature and units type. Select the option from the drop-down menu.
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20.13 Measurement Properties - Reference Page

At the top of the window is a drop-down menu box with the Main Measurement type of the selected feature
shown as default. The settings shown on this dialog page relate to this feature. If there are sub-features
available, they will be listed in this menu. When you select a different option from the menu, the page will
display the corresponding parameters for the feature.

The following options are available in the Measurement Page. The options available will vary depending upon
the feature type.

Reference Edge
Centre-Line
Angular Reference
Offset Angle
Measure From
Start Angle

End Angle

20.13.1 Reference Edge

This can be any reference edge (identified by its label) that has been defined, or 'None' if no reference edge is to
be used.

If a feature is defined and a reference edge is active i.e. other than "None' is displayed, the location of the
measurement zone is defined relative to that edge. This is important if the zone refers to a small feature (e.g. a
radius) the position of which depends on a large feature (e.g. a length) with a large tolerance.

By defining a local reference edge, possible measurement problems are reduced.

The default reference edge is the one most recently defined.

20.13.2 Centre-Line

If a centre-line has been defined then a correction for component misalignment can be made before other
dimensions are calculated. More than one 'centre-line' can be defined, using different reference points on the
component and the appropriate centre-line, or 'None' can be selected.

20.13.3 Angular Reference

This can be any angular position in the rotation axis (identified by its label) that has been defined or '"None' if no
angular position is to be used. If a defined position is chosen (e.g. Z01) then the location of the Measurement
zone is defined relative to that angular position.

If one of the angular position measurements is defined (e.g. MIN. ANGLE), a facility exists for all types of
measurements, (i.e. diameter, angles, lengths etc.) to be defined relative to this position.

Note :

This is applicable to angular measurements only on machines which have Rotation hardware installed. If this
hardware is not present, the option will be 'greyed' i.e. unavailable for selection.
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20.13.4 Offset Angle

This defines the angular position at which the measurement will be made.
A value can be entered (-360, +360).

Note :

This is applicable to angular measurements only.

20.13.5 Measure From

Used for Taper Thread features, this allows the Gauge Length to be measured relative to any edge on the part.
Normally, it will be measured relative to the start of the thread and should be set to that edge number. This
requires, of course, that this edge is measured before the thread. To ensure that the measuring cycle is
performed in this sequence, it is a good idea to set this edge up as a reference edge and to use it as the reference
edge for the thread measurement function.

20.13.6 Start Angle

This is the angular position at which the scan STARTS.

Notes :
This is applicable to angular measurements only.
The START angle value is relative to the machine datum unless defined to an Angular Reference.

20.13.7 End Angle

This is the angular position at which the scan ENDS.

Note :
This is applicable to angular measurements only.
The END angle value is relative to the machine datum unless defined to an Angular Reference.
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20.14 Measurement Properties - SPC Page

At the top of the window is a drop-down menu box with the Main Measurement type of the selected feature
shown as default. The settings shown on this dialog page relate to this feature. If there are sub-features
available, they will be listed in this menu. When you select a different option from the menu, the page will
display the corresponding parameters for the feature.

The following options are available in the Measurement Page. The options available will vary depending upon
the feature type.

Opens the Sub Measurement Properties window which shows the status of sub features i.e. included or not
included in the actual measurement. A set of tick-boxes control the sub feature status. This option is only available
when sub features are available.

SPC On/Off

20.14.1 SPC On/Off

On
This toggles the SPC feature ON or OFF, denoted by a tick in the tick box. If there is no tick, none of the other
options on this page are available.
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21 Using Pro-Composer






21.1  Principle of Operation

The Pro-Composer program captures the component data either by scanning a component or importing a CAD
Drawing of the component into the system.

A picture of the component known as the Schematic is then displayed on the screen in the workspace area.
The required measurements are defined by marking up the picture.

Once all the measurement details have been entered, the computer will automatically create the measurement
program (Upon selecting the 'File Save' option). This operation is known as Program Compilation and when
carried out, optimisation routines are used to minimise the cycle time of the actual measurement routine.

The schematic of the component which contains the image and measurement definitions is stored with the
program and can be re-loaded for editing if a program modification is required.

21.2 Program Making - Stages

There are several stages to making a Pro-Composer program.

e  Make a Picture of the component either by scanning a sample component on the gauge or by importing
a CAD Drawing.

e Setting the Schematic Properties

o  Define the measurements that are required.

e  Define the component position relative to the gauge datum.

e  Save the schematic.

21.3 Making a Component Picture - Principle

In order for the system to create a measurement program for the component under test, the specific details of the
component have to be input into the system.

This can be done by either IMPORTING A CAD DRAWING of the component or by SCANNING the
component.

The end result of this input of data is a component picture known as the SCHEMATIC which is used for
defining the specific measurement details.



21.4 Import a CAD Drawing

CAD drawings of the DXF file standard can be used as the source for a component picture.
1. Select the 'Scan' option from the main menu.

2. Select the 'Import' option from the 'Scan' menu.

3. Select the 'DXF' option.

4. When the Dialog box appears, press th
import.

to invoke the file selector and select the file you wish to

5. Inthe 'Layer Names' text boxes, type the corresponding names for the 'Profile' and 'Centre-Line' layers.
Alternatively, layers contained within the DXF file can be selected in the corresponding dropdown
menus.

6. Pressthe Ll k. button to begin the import process.

7. In the dialog box, beneath the name of the file to be imported, you should see a bar graph progress
indicator which shows how much of the drawing has been imported. This graph indicator expands

from left to right, far right being completed import.

8. The file should now be imported and the component picture will appear in the schematic workspace
window.

Note :

Press the ancel button if you want to abort a CAD import operation.

Ensure the schematic units are set to those defined for the drawing co-ordinates.

The component outline on the schematic is coloured Dark Grey when generated from an Imported CAD
drawing.

21.5 CAD Drawing Format Specifications

The DXF file to be imported must be configured in a way which is compatible with the Pro-Composer software.
The following rules must be observed:-

ENTITIES Only Line, Polyline, LWPolyline, Arc, and Circle as defined in the DXF language are permitted.

SHAPE The 'PROFILE' of the component must be continuous and represent only the outline of the part.
There must be no overlapping of entities and no breaks at corners or points of intersection. No entities
such as cross - holes should appear within the outer profile. Non-symmetric features which cross over
the centreline are not allowed.

The 'CENTRELINE' must be a horizontal line which extends beyond the ends of the component
"PROFILE".

LAYERS  The 'PROFILE' and 'CENTRELINE' must be present in 2 separate layers. Nothing, other than that
defined in 'SHAPE' above, must be present in these two layers.

NAMES It is convenient but not mandatory, if these two layers have the names 'PROFILE' and
'CENTRELINE' as these are the default names used in the conversion program.
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The figure below gives an indication of the correct appearance of a drawing suitable for importing.
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Notes :

'PROFILE' Layer

Other features, such as dimensions, may be present in the DXF file. It is important though that the additional
features are held in different layers i.e. not layers 'CENTRELINE' and 'PROFILE".

If there is a problem during importing of a CAD drawing, the appropriate error message will be displayed.

21.6 Scan a component

1. Select the 'Scan' option from the Main menu.

2. Select the 'Component' option from the 'Scan' menu. The Scan Component control window should

appear.

3. Ifyou have a gauge which has multiple measuring modes, select the appropriate component range and
projector range by selecting the appropriate range options from the drop-down menu boxes.

4. Define the start position of the component scan range by selecting and holding the 4

and moving the component to the desired start of scan position.

5. Accept the position by pressing the

6. Define the end position of the component scan range by selecting and holding the _*

until the component is at the opposite end of the desired scan.

7. Accept the position by pressing the

button.

The component will now be scanned automatically and the component outline will be displayed on the screen
when the scan is complete. The outline of the component is shown in black.

Notes :

To ensure a complete picture, it is important that the set component range will scan the complete profile of the

component.

The component can be scanned in either direction but to ensure a complete picture, the scan range must be

defined with the top of the component below the measuring line and the bottom of the component above the

measuring line.
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Measuring Line Illustration

Bottom of component ABOVE Measuring line.

Top of component BELOW measuring line.




21.8 Scan Region - Principle

After a schematic has been generated by scanning a component, it may be that some fine detail areas of the
component profile are not cleanly defined. This will consequently lead to measurement problems because there
is not enough data points in these areas. The Scan region facility enables you to re-scan a defined area again, to
obtain further detail.

21.9 Scan a Region

1. Select the 'Scan' option from the Main menu.
2. Select the 'Region' option from the 'Scan' menu.

3. Using the mouse, drag a window about the region on the component that you wish to scan. This can be
done by pressing the left hand mouse button and dragging the mouse across the workspace window
whilst still holding down the button. The window will be defined once you release the mouse button.

4. Adjust the zone to the desired shape and location. To change the size of the zone, move the cursor onto
one of the four sides of the zone (indicated by the double arrow cursor) and then drag the mouse to
move the boundary. To move the entire zone, position the cursor anywhere within the zone (single
arrow cursor) and then drag the mouse to the new position.

button. You may abort the operation by pressing

5. Accept the zone for the region by pressing th

the button.

6. The region will now be scanned by the gauge and additional data gathered.

Note : It is recommend to allow additional space within the region zone to be scanned to ensure all data is
gathered for the region of interest.

21.10 Setting the Schematic Properties - Principle

Once a component picture has been scanned and a schematic generated, there are some global parameters which
need to be set before defining the measurement features. These are the Schematic Properties.

The Schematic Properties include the Units Type i.e. mm or Inch, Printer control, Intelligent Profile analyser
rounding value and the Procal Header and Footer management.

Notes :

Though these settings can be changed at anytime, it is recommended that they are routinely set before you
define any measurement features. This will ensure that all the global variables are set correctly.

Changing these settings once measurement features have been defined will result in Standards Database
information being reset.
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21.11 Defining the Measurements - Principle

The required measurements are defined by 'marking up' the schematic that has been scanned or loaded into the
computer.

A MEASUREMENT FEATURE is assigned to the area of interest on the component picture. The area for the
measurement is defined by a window called a MEASUREMENT ZONE which can be moved and modified to
suit the requirement.

When a feature has been defined, it is assigned a feature label. This label will indicate the feature type and its
unique reference number.

Each measurement feature has a set of PROPERTIES which contain options applicable to that specific feature.
The computer uses this information when it creates the measurement program.

21.12 Geometric Best Fits

This facility, when available (usually on RADII, ANGLES, FORM and INTERSECTION Features), provides a
graphic representation of the best fit circle or straight line applied to the scanned data within the specified
zone(s) together with relevant data values in a workspace window status bar.

When a zone is defined manually or by the intelligent profile analyser, the 'Best Fit' option on the Edit Toolbar

will be available for the features identified above. This option is activated by pressing the button.

When selected, the best fit 'picture' will be displayed together with the Best Fit Status Bar which is displayed in
the top left corner of the workspace window. The graphic and numeric outputs are computed from the data
defined by the measurement zone(s). The numeric values will be computed relative to the machine or a
Reference edge and or Centre Line if defined.

The size and/or position of the zone(s) can be modified and the best fit circle or line will be updated
automatically. To change the size of the zone, move the cursor onto one of the four sides of the zone (indicated
by the double arrow cursor) and then drag the mouse to move the boundary. To move the entire zone, position
the cursor anywhere within the zone (single arrow cursor) and then drag the mouse to the new position.

The screen shot shows a best fit example. The component profile is shown in black, the zone is red and the best
fit circle is green.

000032.sch
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21.13 Feature Labels

When a feature has been defined on the schematic, it will be assigned a label. The label contains a symbolic
icon of the feature type and the assigned reference number, e.g. EO1, D02 etc.

The label is linked to the point on the component by a line. The label is positioned on the schematic
automatically when a feature is defined. its position on the schematic can be moved by pressing the left hand
mouse button over the label and dragging the label to the new desired position. When the button is released, the
label will be fixed at the new location.

It is possible to hide the labels from view on the schematic. This is useful if you only want to view features of
the same type or there are many features defined and the schematic becomes congested. Use the 'Feature' option
from the 'View' menu to hide or display label types. A tick next to the menu option denotes that the feature is

visible.
The label types are as follows :

J@ Diameter
4

Edge

Reference Edge

Length

Angle

Radius

Groove Depth

Form Deviation

Centre-Line

Thread

Concentricity

Run Out
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Rotation Diameter

Straightness

Across Flats

Angular Positions

Symmetry (Offset Diameter)

Eccentricity (Offset Diamater)
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21.14 Define the Features

1. Select the desired feature type of the measurement by pressing the corresponding button on the
Features Toolbar.

2. If applicable, select the specific feature type from the options present on the menu that appears. The
selected item is indicated by a check.

3. Most Measurements are defined with zones. EITHER move the cursor to the required position on the
component picture within the workspace window and click the left hand mouse button, OR define the
zone manually by clicking and dragging a zone box over the area of interest.

4. The built in Intelligent Profile Analyser will then indicate with a red rectangle the proposed zone(s) of
measurement. This can be edited and accepted or cancelled.

|

. button on the Edit Toolbar.

5. The proposed zone can be accepted by selecting the -

If necessary however, the size and/or position of the zone can be modified before it is accepted. To
change the size of the zone, move the cursor onto one of the four sides of the zone (indicated by the
double arrow cursor) and then drag the mouse to move the boundary. To move the entire zone, position
the cursor anywhere within the zone (single arrow cursor) and then drag the mouse to the new position.

Notes :

The current feature selection, indicated by an activated toolbar button and check next to the specific feature of
the feature menu, remains valid until another choice is made. It is therefore possible to define all measurements
of a particular type without re-selecting each time.

The type of zone defined by the system will vary depending on the type of measurement. Some measurements
will require more than one zone.

Some measurements are defined by selecting labels of existing measurements. The Status Bar will provide
instructions of what is required for these measurement types.

The current measurement/zone definition can be aborted by pressing the button on the Edit Toolbar.

If the default zones produced by the Profile Analyser are modified incorrectly, an error message will be
displayed.
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21.15 Features Available

Diameter
Edge

Length

Angle

Radius
Groove Depth
Form Deviation
Centre-Line
Thread
Concentricity
Run Out

Rotation Diameter

Straightness
Across Flats

Angular Positions

Offset Diameter

Note :
These buttons show the GROUPS of measurement types supported.
Certain features may only be available if the particular hardware option is fitted e.g. Thread measurement.
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21.16 Across Flats Feature

This option selects the ACROSS FLATS measurement feature

The across flats features available are as follows.

Dimension Across-flats dimension within the specified zone.
Symmetry Symmetry of the A/F dimension within the specified zone.
Maximum Maximum across-flats dimension within the specified zone.

— — | A/F SYMMETRY | &

:
r _ _ — —

AJF DIMENSION

AF MAXIMUM

All of the A/F features use the axial scanning method.
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21.17 Angle Feature

This option selects the ANGLE measurement feature

The angle features available are as follows :

Half Angle of a surface of the component to the machine axis using a vertical edge as the origin.
Vertical a

Origin ‘>/

Half Angle of a surface of the component to the machine axis using a horizontal edge as the origin or to the
Horizontal component axis as defined by ‘Centre-Line’.
Origin

=)

Included  Included angle of two surfaces of the component.

©
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21.18 Angular Position Feature
Hle|  This option selects the ANGULAR POSITION measurement feature

The angular position features available are as follows :

Min Radius Value of minimum radial co-ordinate.

Max Radius Value of maximum radial co-ordinate.

Min Angle Angular position of minimum radial co-ordinate.

Max Angle Angular position of maximum radial co-ordinate.

Across Flats Angle Angular position for an across flats dimension.

Angle A-B Angular difference between two angular positions.
MIN RADIUS

MAX RADIUS

ol

ANGLE A-B

MIN ANGLE
MAX ANGLE /
T
M/C
DATUM

All of the Angular positions features use the axial scanning method with the exception of the Angular Position
A-B feature.
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21.19

Centre-Line Feature

This option selects the CENTRE-LINE feature

The centre-line features available are as follows :

Static

Dynamic
Turned

Dynamic
Average

Defines the component axis between the centre points of the component as measured in each of two
zones. This centre line cannot be applied to dynamic measurements.

Defines the component axis between the centre points of the component as measured in each of two
zones and utilises rotation of the component to derive a centre-line. This is useful if a dynamic
measurement (e.g. concentricity) is defined relative to the component axis.

This position is calculated using the maximum diameter in the zones taking into account the 'thread'
nature of a turned surface.

A dynamic centre-line correction can also be applied to static measurements (e.g. edges) as the value
appropriate to the current component orientation will be calculated and used.

Defines the component axis between the centre points of the component as measured in each of two
zones and utilises rotation of the component to derive a centre-line. This is useful if a dynamic
measurement (e.g. concentricity) is defined relative to the component axis.

This position is calculated using the average diameter in the zones specified.

A dynamic centre-line correction can also be applied to static measurements (e.g. edges) as the value
appropriate to the current component orientation will be calculated and used.

This feature type uses the radial scanning method.

[ | @2
1

]

L |
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21.20 Concentricity Feature
@ This option selects the CONCENTRICITY measurement feature

The concentricity features available are as follows :

Average Concentricity of the average diameter within the specified zone.
This feature type uses the radial scanning method.

O] |

Turned Concentricity of the turned diameter within the specified zone.

O] |

Ll

Max Form Concentricity of the maximum diameter within the specified zone.

Gauge Diameter ~ Concentricity of a specified diameter value on a taper within the specified zone.
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Thread Diameter Concentricity of a thread within the specified zone.

Interrupted Concentricity of the average diameter within the specified zone for a component with an
Diameter interrupted surface of at least three equispaced interruptions.
ie.
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21.21 Diameter Feature

This option selects the DIAMETER measurement feature

The diameter features available are as follows :

Average Average diameter in the specified zone.

Max. Form Maximum diameter in the specified zone.

Min. Form Minimum diameter in the specified zone.

Turned Maximum diameter in the specified zone taking into account the ‘thread’ nature of a turned
surface.
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Min. Metal Stock material diameter in the specified zone.

Line-Line Diameter calculated at the intersection of two lines.
Intersection

At'X' Diameter calculated at a specified 'X' position.

t—-——‘

Line-Edge Diameter calculated at the intersection of a line and a vertical edge.
Intersection

@ ——
Sphere Diameter of a spherical form.

|

=3}

1
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Over Wire Diameter across the best fit theoretical wire.

Wire Centre

Note : Some of these features are only available when certain hardware options are installed on the gauge.
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21.22 Edge Feature

This option selects the EDGE feature

The edge features available are as follows :

Normal Position of a vertical edge.
Incremental Position of a defined increase or decrease in component radius.

* —ciY

N

Line-Line Intersection Position of an intersection of two lines.

Line-Radius Intersection Position of an intersection of a line and a non-blending radius.

|
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Gauge Diameter

Radius Centre

Max Form Diameter

Min Form Diameter

Position of a specified diameter value.

Position of the centre of the radius.

Position of the Max Form diameter.

Position of the Min Form diameter.

s

e

21-22



Spherical End

Thread Line Intersection

Thread Radius Intersection

Wire Centre

Position at the end of a spherical form.

.

Position of an intersection of a line and a thread.

Position of an intersection of a radius and a thread

Edge location of a best fit theoretical wire.
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21.23 Form Deviation Feature
This option selects the FORM DEVIATION measurement feature

The form deviation features available are as follows.

Line The deviation of the component form for a line feature.

Radius The deviation of the component form for a radius feature.

21.24 Groove Depth Feature

This option selects the GROOVE DEPTH measurement feature

The depth of a groove on the component.
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21.25 Length Feature

This option selects the LENGTH measurement feature

Lengths are defined as the separation between two edges. These can be of any type and one or both can be
reference edges

21.26 Offset Diameter Feature
@] This option selects the OFFSET DIAMETER measurement feature

The features available are as follows :

Eccentricity Dynamic measurement which calculates the radial distance between two axes (ie
Concentricity/2 ).
Symmetry: Static measurement which calculates the symmetry of a parallel diameter relative to a

previously defined centre-line. The axis of the diameter is calculated from the upper and
lower surfaces.
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21.27 Radius Feature

This option selects the RADIUS measurement feature

The radius features available are as follows.

Normal The radius of a component feature.
Y Centre The Y position of the centre of a radius.

21.28 Rotation Diameter Feature

71 This option selects the ROTATION DIAMETER measurement feature

The rotation diameter features available are as follows :

Average The average diameter as the part is rotated.

Maximum The maximum diameter as the part is rotated.

Minimum The minimum diameter as the part is rotated.

Ovality Ovality of a diameter as a part is rotated.

Interrupted The average diameter of a component with an interrupted equi-spaced surface.
ie.

All of these feature types use the radial scanning method.
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21.29 Run Out Feature

This option selects the RUN OUT measurement feature

The run out features available are as follows :

Radial Run out of the diameter within the specified zone.

/1]
—
—

Interrupted Radial Run out of the diameter within the specified zone for a component with an interrupted surface
of at least three interruptions.
ie.

Face Run out of a face within the specified zone.

T
L
=

—
=

Face-Face Run out of one face to another.

%‘ I

All of these feature types use the axial scanning method.
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21.30 Straightness

This option selects the STRAIGHTNESS measurement feature

Straightness of a diameter or taper within the specified zone.

21.31 Thread Feature

#=!  This option selects the THREAD Measurement feature
ﬁ‘i p

The thread features available will vary depending upon the gauge hardware.
For gauges with special thread measurement hardware, the features available will be as follows :

RH Parallel Measurement of a right hand parallel thread.
This feature type uses the radial scanning method.
LH Parallel Measurement of a left hand parallel thread.
This feature type uses the radial scanning method.
VAVAVAVE VAN
RH Worm Measurement of a right hand worm thread.
LH Worm Measurement of a left hand worm thread.

NSNS

RH Taper Measurement of a right hand taper thread.
LH Taper Measurement of a left hand taper thread.

At

For gauges without special thread measurement hardware, the options available will be as follows :
LH/RH Parallel = Measurement of a left/right hand parallel thread using a calculated slew.
LH/RH Taper Measurement of a left/right hand taper thread using a calculated slew.
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21.32 Define Feature Properties

1. Select a measurement type and position the zone(s) as described in Defining Features.

2. After acceptance of the measurement zone by clicking on the green tick, the user will be presented
with the Measurement Properties Dialog box for the purpose of setting up the measurement
parameters. The parameter fields will display default values. A complete list of parameter fields and
definitions can be found in the Page links from the Measurement Properties Dialog Box.

easurement Properties

ﬁight Flank .f;.nﬁle)
i .

3. Set the parameters of the Measurement page.
4. [Ifapplicable, set the parameters of the Reference page.
5. Ifapplicable, set the parameters of the Standards Database page.

6. Enable any Sub Measurement features as desired.

7. Set the parameters of the enabled Sub Measurement Features. These can be configured by selecting the
Sub Measurement feature from the drop-down menu. The parameter fields in the dialog box pages now
correspond to the Sub Measurement Feature.

Thread: Right Flank Angle

Thread: Right Flank Angle
|Thread: Included T aper Angle
L Thread: Gauge Length

[Thread: Usable Thread Length
\ Thread: Crest Truncation
[Thread: Root Truncation
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8. When the main feature type and all sub measurement feature parameters have be set, press the
button to define the feature properties and close the dialog box.

Notes :

The parameters/settings shown on the Measurement page of the dialog box apply to the feature that is active in
the dropdown Feature/Sub Measurement Feature menu. If a different feature is selected from this menu, the
settings for that feature will be shown. The settings can be changed as desired.

The displayed parameter fields within the other pages of the Measurement properties dialog box will vary
depending upon the Feature type and the Sub Measurement Feature type that is selected within the measurement
page. i.e. The parameters on the Reference page will only be visible when the main feature type heading is
selected in the feature type drop-down menu.

21.33 Enable Sub Measurement Features

The status of Sub Measurement features can be toggled from within the Sub Measurement Status Window.

1. Click the | button.

2. Select the desired Sub Measurement Features from the list. All of the available features are listed and
have a corresponding tick box. A tick in the box means the feature will be output, no tick in the box
means the feature will be ignored.

3. Pressthe I button to accept the changes or the ancel button to abort any changes.

Sub Measremnt Status

hread: Pitch
iv: Thread: Left Flank Angle
Thread: Right Flank Angle

‘Thread: Included T aper Angle
W T hiead Gauge Length
hread: Usable Thread Length
hread: Crest Truncation
uncation
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21.34 Reference Edge - Principle

This is a defined edge on the component relative to which subsequent moves are made. It is not essential but
always advisable to define such a reference. This can compensate for variations in position between components
of the same type due, for example, to differences in size of centre holes.

The reference edge is often, (but not necessarily) at one end of the component.

If the component is thin walled and held in male centres it can be more reliable to choose a more prominent
feature as a reference edge.

If there are small features, such as a fillet radius, it is helpful to define the nearest edge as a reference edge for

the measurement of the small feature. This will reduce measurement problems for small features next to an edge
which may have a relatively large tolerance on its position.

Note :
More than one reference edge can be used.

21.35 Define a Reference Edge

1. Any EDGE that has been defined on the schematic can be used as a Reference Edge.

2. Move the mouse cursor over the label of the Edge you wish to define as a Reference. Click the right-
hand mouse button whilst over the label.

3. From the menu that appears, select the properties option.

4. The Measurement Properties Dialog Box will now appear. Select the option 'Use as reference’.

5. Close the dialog box by pressing the - button.

6. This edge is now defined as a reference edge.

When you define or modify subsequent measurements, you may use this reference edge. You can select the
reference edge from the drop-down menu on the measurement page of the measurement properties dialog box.
The default will be 'NONE'. The last defined edge will be the next option and all other available reference edges
will be listed afterwards.

Note:
The label of the reference edge will be that of the defined edge used as the reference.
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21.36 Defining the Component Position - Principle

The component position is the reference relative to the gauge datum that the computer uses to identify where the
component is located along the axis of the gauge.

If a new schematic is being created, the component position is defined automatically during the scan component
procedure.

If a component picture has been imported from a CAD drawing, there is no information as to the position of the
component relative to the machine datum and so a program cannot be compiled. The component position must
be defined in order to compile the program.

Similarly, if a schematic has been re-loaded after a tooling change and the position of the component relative to
machine datum has altered then again the component position must be re-defined.

The position is defined by scanning the area of the component of the intended reference position. A reference
edge must be defined on the schematic prior to scanning and then the edge zone re-defined after scanning. The
computer can then adjust all points on the schematic accordingly using this reference edge.

Note :

The schematic must be re-saved to enable use of the new reference edge location.

21.37 Define the component position

1. Once a drawing has been imported or re-loaded into Pro-Composer, insert the component into the
gauge.

2. Define a Reference Edge on the schematic.

3. Select the SCAN option from the Main menu.

4. Select SET COMPONENT POSITION from the SCAN menu. The Scan Component Position window
should be displayed.

5. If you have a gauge which has multiple measuring modes, select the appropriate component range and
projector range by selecting the range options from the drop-down menu boxes.

6. The component needs to be positioned such that the edge defined as the reference edge on the
schematic and which has the label EO1 is just above or just below the measurement line on the

Projector screen. Use the .22 and _¥ | buttons to move the component into the first position either

above or below the measurement.

7. Record this position by pressing the __ button.

8. Now re-position the component such that the reference edge is on the other side of the measurement

and

line again using the respectively. Accept this position by clicking on the L

button.
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10.

11.

12.

13.

The gauge will now scan the component and once complete, an enlarged view of the scanned area will
be displayed in the workspace window.

A measurement zone for the reference edge must be defined. Click the mouse where the reference edge
is to be.

A zone should now appear. Adjust the zone to the desired shape and location. To change the size of the
zone, move the cursor onto one of the four sides of the zone (indicated by the double arrow cursor) and
then drag the mouse to move the boundary. To move the entire zone, position the cursor anywhere
within the zone (single arrow cursor) and then drag the mouse to the new position.

Accept the zone position by pressing the button.

The component position is now set

21.38 Define a Centre-Line

4000032 sch

Click the button on the features Toolbar.
Define two zones at each end of the component axis.

The Measurement Properties dialogue box will now appear, set the parameters as desired.

Close the dialog box by pressing the button.

The Centre-Line is now defined.
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21.39 Define a Length

1. Define two EDGE features on the schematic that correspond to the position of the Length you require
measuring.

2. Click the mouse selection button on the labels for the two existing edges, one after the other (the labels
are highlighted when selected).

3. Click the button from the Edit Toolbar.

4. The Measurement Properties dialogue box will now appear, set the parameters as desired..

5. Close the dialog box by pressing the

6. The length is now defined.

Note:
When you right click the mouse cursor over a Length label, there will be no 'Zones' option since there are no
zones associated with the Length feature.

21.40 Define an Angular Position A-B

1. Define two Angular Position Features using Min Angle, Max Angle or Across Flats Angle on the
schematic that correspond to the position of the Angular Position A-B you require measuring.

2. Click the mouse selection button on the labels for the two features you have just defined, one after the
other.

3. Click the button from the Edit Toolbar.

4. The Measurement Properties dialogue box will now appear, set the parameters as desired.

5. Close the dialog box by pressing the

6. The Angular Position A-B is now defined.

Note:
When you right click the mouse cursor over an Angular Position A-B label, there will be no 'Zones' option since
there are no zones associated with this feature.
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21.41 Saving the Schematic - Principle

The SAVING of a schematic serves two purposes.

Firstly, this is the process that creates the PROCAL MEASUREMENT PROGRAM from the data contained
within it. This is known as program compilation and is done automatically each time the schematic is saved.

Secondly, it allows future re-loading of the schematic for editing purposes.

21.42 Save a document

1. Select the 'Save' option from the File menu.
2. Ifyou are saving the document for the first time, you will be prompted to give it a filename. Once a
document has a name, any subsequent saves will be made by over writing the existing document of

that name.

3. The file will now be saved.

Note : Use the 'Save As' option if you want to save the document under a different name or location.
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21.43 Program Making - Hints

Pro-Composer provides a fast, easy to use programming medium and offers comprehensive functionality. To
ensure that accurate and reliable programs are created it is recommended that the following points are observed.
e Ifusing a Centre-Line reference, define it before any other features.
e  Use Reference Edges where possible, this can compensate for part variation.
e  Ensure that the size and position of zones are suitable for the feature to be measured.

e  Set the Scan Increment to suit the feature. A general guideline is that any feature less than 1mm should
have the Scan Increment set to FINE.

e  Zoom into the schematic when defining zones on Small features. This will ensure accurate zone
positioning.

e If small features are associated with a Reference Edge, the edge should be as close to the feature as
possible.

e  Use the Best Fit system to ensure a zone doesn't include data that is not required. Un-necessary data
contained with a zone can affect the repeatability of a program.
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21.44 Modify the Measurement Properties

1. Move the mouse over the label for the specific feature you wish to edit.
2. With the pointer over the label, click the right-hand button of the mouse.
3. From the menu that appears by the label, select the 'Properties' option.

4. The measurement properties dialog box will now appear and the parameters can be modified.

21.45 Modify Measurement Zones

1. Move the mouse over the label for the measurement you wish to edit.

2. With the pointer over the label, click the right-hand button of the mouse.
3. From the menu that appears by the label, select the 'Zones' option.

4. The measurement zones will now appear in the workspace window.

5. To change the size of the zone, move the cursor onto one of the four sides of the zone (indicated by the
double arrow cursor) and then drag the mouse to move the boundary. To move the entire zone, position
the cursor anywhere within the zone (single arrow cursor) and then drag the mouse to the new position.

G

6. When the zone(s) have been set to the desired position, accept the changes by pressing the ' button
on the Edit Toolbar.

Note :

The zone modifications can be aborted by pressing the w utton on the Edit Toolbar.

If you encounter difficulty in editing or moving a zone, use the Zoom controls to magnify the schematic.
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21.46 Delete Individual Measurements

1. Move the mouse over the label for the measurement you wish to delete.
2. With the pointer over the label, click the right hand button of the mouse.
3. From the menu that appears by the label, select the 'DELETE' option.

4. The measurement definition including label and zone will now be deleted.

Note :

It is NOT possible to delete a measurement that has DEPENDANTS. i.e. you cannot delete an edge used for a
length measurement; the length feature must be deleted first.

21.47 Delete All Measurements

1. Move the mouse to an open area of the workspace window, i.e. not on a measurement label.

2. Click the right hand button of the mouse.

3. From the menu that appears, select the 'Delete All Measurements' option.

4. A warning window will now appear asking if you really do want to delete all measurements. Select the

'YES' button to continue the operation and delete all the measurements within the current schematic. If
you have changed your mind, press 'NO' to abort this process.

Notes :
You can also use the 'Delete All Measurements' option from the 'Edit' Menu.
If all measurements are deleted, the schematic name will become 'Untitled'.
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22 Pro-Composer Thread Measurement
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22.1 Thread Measurement

The Profile machine is capable of measuring various types of threads depending upon the type of gauge and
hardware installed. There is limited thread measurement functionality on all gauges, with further feature types
available on gauges that have a 'Slew' axis and 'Rotation’ hardware fitted.

The available thread type features are as follows :

Parallel Vee Form Threads

Tapered Vee Form Threads

Worm Threads

22.2 Parallel Threads

Parallel vee form threads can be measured with flank angles between 50 and 70 degrees. The following features

can be determined :
Pitch Diameter
Pitch

Major Diameter
Minor Diameter
Left Flank Angle
Right Flank Angle
Root Radius
Taper

Lead Error

Run Out

Circularity

Functional Diameter

The diameter across the thread form perpendicular to the thread axis.

Separation between the two intercepts of the nominal pitch diameter on like flanks.
Maximum diameter of the thread profile.

Minimum diameter of the thread profile.

The average value of the left flank angle perpendicular to the thread axis.

The average value of the right flank angle perpendicular to the thread axis.

The Radius at the root of the thread profile.

The difference in pitch diameter over the length of engagement.

The calculated deviation between the distance X1 X2 and the nominal size. X1 X2 are
two points where the pitch diameter line intersects the first full thread flanks, one at

each end of the measurement zone at the same thread helix.

Defined as the runout (TIR) of the pitch diameter relative to the major diameter of the
thread.

The calculated ovality of the Pitch Diameter.

The calculated effective diameter of the thread compensating for pitch and/or flank
angle errors.

22.3  Default features output for a Parallel Thread.

Pitch Diameter
Pitch

Major Diameter
Minor Diameter
Left Flank Angle
Right Flank Angle
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22.4 Additional features available for a Parallel thread but not
selected as default.

Root Radius

Taper

Lead Error

Run Out

Circularity
Functional Diameter

Note : Minor Diameter, Root Radius, Taper, Lead Error, Run Out, Circularity and Functional Diameter are not
available on machines without 'Slew' and 'Rotation' hardware.

22.5 Defining Measurements Thread Zones.

The zone width for a thread feature should be a minimum of 2.5 times the Pitch of the thread (200 data
points per pitch).

22.6  Special Notes about Safety Critical Features.

These six sub features (Root Radius,Taper, Lead Error, Run Out, Circularity, Functional Diameter) are
disabled as default since they are only required for Safety Critical threads with controlled root radii for
aerospace applications. (Military Specification MIL-S-8879C). In addition, the last three dimensions (Run
Out, Circularity, Functional Diameter) will require the hardware Rotation option to be fitted to the
machine.
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22.7

Taper Threads

Taper vee form threads can be measured. The following features can be determined :

n TLII

lell
n GLII

n MJ n
n T A n n P Dll
n TR n n MN LU
"TA" Included Taper Angle - The included angle of the thread as projected by the pitch diameter.
"GL" Gauge Length - The length at which the pitch diameter has a specified value as defined by the appropriate
thread standard.
"TL'" Useable Thread Length - The maximum length at which the thread profile is still fully formed. This
requires a gauge with Rotation hardware and uses the radial scanning method.
"PI'"  Pitch - The average value of pitch over the complete measuring zone.
"LA" Left Flank Angle - The average value of the left flank angle perpendicular to the thread axis.
"RA" Right Flank Angle - The average value of the right flank angle perpendicular to the thread axis.
"TC" Crest Truncation - The amount by which the actual crest of the thread profile is reduced below the
theoretical crest height as calculated from the intersection of both flanks.
"TR" Root Truncation - The amount by which the actual root of the thread profile is increased above the
theoretical crest height as determined by the intersection of both flanks.
"X Reference Plane - This is an axial location at which Major Diameter '"MJ", Pitch "PD'" and Minor

Diameter "MN'" can be measured. The position of this plane can be chosen by the operator, but it may
also be defined by some thread Standards. These features are described as Pitch Diameter at 'X', Major
Diameter at 'X' and Minor Diameter at 'X' respectively.

Note : Root Truncation and Minor Diameter at 'X' are not available on machines without thread measurement
hardware.
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22.8 Default features output for a Taper Thread.

Pitch

Left Flank Angle
Right Flank Angle
Included Taper Angle
Gauge Length

Usable Thread Length
Crest Truncation
Root Truncation
Pitch Diameter at 'X'
Major Diameter at 'X'
Minor Diameter at 'X'

22.9 Special Notes on Taper Thread Parameters

Special Notes for Gauge Length.

The Measurement Properties Dialog box for Gauge Length requires additional parameters. Gauge Length
determines the axial location of a fixed Pitch Diameter along the taper of the thread. The value of this fixed
Diameter that is obtainable from the appropriate thread Standard must be entered in the Diameter parameter
field. The other parameter is Measure from which allows the Gauge Length to be measured relative to any
edge on the part. Normally, it will be measured relative to the start of the thread and should be set to that edge
number. This requires, of course, that this edge is measured before the thread. To ensure that the measuring
cycle is performed in this sequence, it is a good idea to set this edge up as a reference edge and to use it as the
reference edge for the thread measurement function.

Special Notes for Useable Thread Length.

Useable Thread Length requires that the part is rotated and checked in different planes to find out where the
thread profile changes from a complete form to a reducing form produced by withdrawal of the cutting tool.
The operator can choose at which resolution and hence accuracy this is achieved by setting the function Number
of Axial Hits. The default value is 8 hits which provides a resolution of one eighth of the thread pitch. This is
adequate for most circumstances where the tolerance on Useable Thread Length is typically 2 x Pitch. However,
if needed the resolution can be improved by setting a higher number of Angular Hits. This action will of course
increase the measurement time.

Note: If Useable Thread Length is switched "Off", or if the Number of Axial Hits is set to "0", no rotation of the
part will take place.

Special Notes for Reference Plane 'X'.

The Taper Thread function allows for the measurement of Major, Pitch and Minor diameters at any location
along the thread length. This location is defined by entering the distance in the field Reference Plane *X’. The
value entered here is relative to the reference edge number appearing in the main edit window. A negative value
will be needed, if the reference plane is between the machine datum and the reference edge.

22.10 Special Notes for Defining Taper Thread Measurements

For Taper Threads, the chosen measurement zone must conform to certain criteria.
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The Measurement Zone should not include chamfers or incomplete thread forms at the start of the thread
(smallest diameter). If the Useable Thread length is to be measured, then some of the incomplete thread forms at
the larger end of the thread should be included in the zone. If the thread terminates in a flange, as shown in the
above illustration, the flange must not be included in the zone.

Correct positioning of the zone may be difficult on a schematic produced from an imported DXF file as the
thread profile will not be fully represented. For this reason it is recommended that only schematics obtained by
scanning the component are used for programming taper threads.
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22.11 Worm Threads

The Profile machine is capable of measuring worm threads on gauges with 'Slew' hardware. The following
features can be determined :

"a"

"b"

"c'l

"d"

"e'l, "f"

"g"
"h"

nin
1

22.12

Nominal Pitch Diameter

Major Diameter
Minor Diameter

Pitch

Tooth Thickness

Pressure Angles

Addendum
Dedendum

Thread Depth

Pitch Diameter
Major Diameter
Minor Diameter
Tooth Thickness
Left Pressure Angle
Right Pressure Angle

Addendum
Dedendum
Thread Depth

A reference diameter used for calculation of the pitch, tooth
thickness, addendum, and dedendum.

Maximum diameter of the thread profile.
Minimum diameter of the thread profile.

Separation between the 2 intercepts of the nominal pitch diameter on
like flanks.

Separation between the 2 intercepts of the nominal pitch diameter on
the opposite flanks on a single tooth.

Tooth angle measured relative to a plane perpendicular to the thread
axis.

Radial depth between nominal pitch diameter and thread crest.
Radial depth between nominal pitch diameter and thread root.

Radial depth of thread.

Default features output for a Worm Thread.
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22.13 Special Notes about Parameter fields for worm threads.

The following parameter fields are specific to worm threads:-

Nominal Pitch Diameter defines the reference diameter used for specific worm thread dimensions i.e. tooth
thickness. When the measurement parameter window is displayed the cursor defaults to this parameter field,
which displays a value of 0.000. The user must then type in the specified size.

Number of Starts defines the number of thread starts, which is important for the calculation of the pitch. The
value can be toggled between 1 and 4.

Helix defines the angle to which the machine slide will align in order to view at right angles to the worm
profile, when the worm thread is scanned during measurement. The default value is calculated from the scanned
profile. This can be modified by typing in a different value. The value will also be re-calculated if the nominal
pitch diameter or pitch values are changed.

Note:- The helix angle can be calculated as follows:-

Pitch
o x Pitch Diameter

ATANG =
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23 Pro-Composer Headers and Footers
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23.1 Headers and Footers

The Headers and Footers facility allows you to add custom Procal segments to the programs that are created by
Pro-Composer. This means additional functionality or enhancements can be added .

The custom Procal coding can be created using the Pro-Measure Procal Editor and then attached to the Pro-
Composer program as a HEADER or a FOOTER.

Code attached as a Header will be placed in the program before the main Pro-Composer Measurement code and
will be executed first.

Code attached as a Footer will be placed in the program after the Pro-Composer Measurement code and will be
executed once the measurement section is complete.

The Procal code used for a Header or a Footer can be a one line command or a larger section of Procal.
There are no limits to the amount of Headers or Footers that can be attached to a Pro-Composer program. The
order in which the attachments are selected for inclusion is the order in which they are executed when the

program is run.

There is also an option to add a one line message as a header or a footer. This message will be displayed on the
screen when executed. This is useful to add prompts or identifiers as to what stage the program is at.

23.2 Include Files as Headers or Footers

1. Right click the mouse in an empty area of the workspace window.
2. From the menu that appears, select the 'Properties' option.

3. The Schematic Properties dialog box should now appear.

4. Select the 'User PROCAL' page tab.

5. From the drop-down menu select the Header or Footer option depending upon what you want to
include.

6. Press the 'Add File' button.
7. Select the procal file that you wish to use as a Header or Footer from the File selector.

8. Press the 'OPEN' button of the file selector to accept the file.

9. The file should now be shown in the Header/Footer listing. The file should be identified with a Elicon.

10. Press the '"APPLY" button to accept the new setting but leave the dialog box open. Or press the 'OK'
button to accept the new setting and close the dialog box.

11. The Header or Footer is now set.

Notes :
Press the 'CANCEL' button to abort the process at any time.

There are no limit to the amount of Headers or Footers used with a program.
The order in which files are selected is the order in which they will be executed.
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23.3 Include Headers or Footers Messages

1. Right click the mouse in an empty area of the workspace window.
2. From the menu that appears, select the 'Properties' option.

3. The Schematic Properties dialog box should now appear.

4. Select the 'User PROCAL' page tab.

5. From the drop-down menu select the Header or Footer option depending upon what you want to
include.

6. Press the 'Add Message' button.

7. A new item identified with a EBlicon is now added to the list with its text highlighted.
8. Click the mouse cursor into the highlighted area of text.

9. Type your message in this box.

10. Press the 'Return’ or 'Enter’ key.

11. Press the 'APPLY" button to accept the new setting but leave the dialog box open. Or press the 'OK'
button to accept the new setting and close the dialog box.

12. The Header or Footer is now set.

Notes :
Press the 'CANCEL' button to abort the process at any time.

There are no limit to the amount of Headers or Footers used with a program.
The order in which messages or files are inserted is the order in which they will be executed.
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24 Pro-Composer Definitions
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24.1  Axial Scanning

This is where scans are taken along the axis of a component at six equispaced radial positions. A scan is taken
along the axis, the component is then rotated to the next radial position and scanned again. This is repeated until
all the radial positions have been completed. The scan direction alternates for each radial position.

/
o

24.2 Radial Scanning

This is where the component is rotated a complete revolution during a scan. The number of radial data points
can be set by the Number of Hits/360 feature parameter. In addition, the number of axial scan positions can be
set using the Number of Axial Hits feature parameter. This will be a value between 1 and 4.

24.3 Component Range

This defines the Diameter range of the gauge in the appropriate units i.e. 0-80mm, 20-80mm etc. for the
subsequent scan to be performed.

244 DXF

A Standard file type used by most leading CAD packages for cross program transfer of drawing data.

24.5 Multiple measuring modes

Some gauges with increased measuring ranges such as the P80 and P80L have adjustable diameter measuring
ranges that can be matched appropriately to the component under test.

24.6 Projector Range

This facility enables the operator to view all sizes of components (within the gauge capacity) via the projector
screen. Only available on gauges that have a projector screen.
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25 Error Messages and Trouble Shooting
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25.1 Trouble Shooting

Profile gauging systems have been designed for ease of use and trouble-free operation. This section details
problems that might occur at start-up and also a list of error messages which can be reported by the system
when running.

25.2  Start-Up Problems

1. System shows no signs of life:

- check the power source and connections, including to the computer and monitor.
- check the computer and monitor are switched on.

2. Computer starts but the lamp does not light:
- check the cable connection.

- replace the lamp.

3. System starts but will not calibrate:

- clean the setting piece with a clean, dry cloth.
- check that the setting piece is located correctly in the tooling.

- check that the setting piece serial number requested matches that being used.
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25.3 Error Messages

Error messages are displayed in a window in the centre of the screen display. If an error message is displayed
while a part program is being run, the program will usually be halted.

25.4 Pro-Measure Error Messages

’ Attempt to move beyond maximum limit.

A motor move command has attempted to drive the motor passed its maximum travel.

} Attempt to move beyond minimum limit.

A motor move command has attempted to drive the motor passed its datum point.

’ BEGIN:SUB without END:SUB.

A Begin:Sub keyword has been found inside a subroutine definition.

> Break : Sequence aborted

The key combination 'Alt+F9' has been pressed while a Procal program was running.

} Calculation : Invalid value for ACOS

An invalid value (> 1 or <-1) has been passed to the function Acos( ).

’ Calculation : Invalid value for ASIN

An invalid value (> 1 or <-1) has been passed to the function Asin().

} Calculation : Negative number (SQRT / *)

An attempt has been made to do a Sqrt of a negative number.

’ Calibration file damaged or invalid. Please re-calibrate.

There is a problem with the calibration file. It could be damaged, programmed incorrectly or the wrong file.

’ Cannot open file.

The specified file could not be opened.

’ Cannot pass variable name by reference.

An attempt to pass a variable by reference to a subroutine is not possible for the specified variable.
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} Delimiter.

A delimiter was expected and did not exist or a delimiter was found and was not expected. A comma must be
present between all parameters passed to a Procal word.

’ ELSE without IF.

An Else keyword has been executed without a preceding If.

} Emergency stop hit.

The emergency stop button has been activated.

’ END:IF without IF.

An End:If keyword has been executed without a preceding If.

’ END:SUB without BEGIN:SUB.

An End:Sub keyword has been found outside of a subroutine definition.

} Expression : Division by zero.

An attempt has been made to divide a number by zero. Check the logic of the expression.

’ Expression : Invalid variable.

A variable has been used with the wrong number of indexes.

’ Expression : Not present.

A required expression is empty. Check the syntax of the word in question.

’ Expression : Parenthesis.

The expression contains a different number of left hand brackets '(' to right hand brackets ')'.

} Expression : Syntax.

There is a general syntax problem with the expression.

’ Expression : Variable overflow.

The index value is incorrect for the variable.

’ program name contains syntax errors. Continue save ?.

The Procal program you are saving contains syntax errors.
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’ Function or Variable name undefined.

The specified function or variable has not been declared.

} GOSUB Stack overflow.

20 Gosub's have been executed without an End:Sub.

} IF without END:IF.

An If keyword has been found without a following End:If.

’ Incomplete IF within REPEAT - UNTIL.

An incomplete If-[else]-End:if block has been found within a Repeat-Until block .

> Incomplete REPEAT within IF - END:IF.

An incomplete Repeat - Until block has been found within an If - Else, Else-End:If, or If-End:If block.

’ Incorrect number of parameters.

An insufficient number of parameters or an incorrect combination of parameters have been passed to the Procal
Word. Check the syntax of the word in question.

’ Invalid calculated limits, dimension name.

The LSL for the specified dimension is greater or equal to the USL.

’ Insufficient data points for operation.

A measurement function cannot be completed due to insufficient scanned data or incorrect data.

} Invalid keyword.

The Procal keyword has not been recognised, either the word has been typed incorrectly, or a required Plugin is
not present or has not initialised correctly.

’ Invalid parameter.

An incorrect parameter type has been passed. Check the syntax of the word in question.

’ Left hand bracket missing.

There must be a left hand bracket '(' between a Procal keyword and the first parameter.
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Limit switch hit.

A motor move command has hit a travel limit switch.

MARK(name) undefined

An attempt has been made to Recover and Goto a Mark which does not exist.

No edge found.

The Find Edge measurement function cannot find an edge due to insufficient scanned data or incorrect data.

Numeric overflow.

A numeric parameter is too large or too small. Check the syntax of the word in question.

Out of memory.

The system or program has used too many of the available memory resources and cannot continue.

Parameter magnitude error.

The relationship of two parameters is incorrect. Check the syntax of the word in question.

Parameter values equal.

Two parameter values are equal which is not allowed. Check the syntax of the word in question.

Plugin locked by another system

Another program is currently using the specified plugin. Only one application can use a plugin at any one time.

Procal Runtime Error\ Program '"%s'' Line %d%s.

An error has occured during execution of a Procal program. Use the debug commands to aid troubleshooting

Program Error\n'" %s'"\nProgram ' %s""

An error has occurred in a system file.

This program can not be run in the selected mode.

A program written for calibration has been selected for measurement or vice versa.

RECOVER : Invalid context

An attempt has been made to recover to a Mark which does not exist in the current stack frame.
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Register index out of range

The index used for a variable is out of range for the variable.

REPEAT without UNTIL

A Repeat word has been found without a following Until.

Right hand bracket missing.

All Procal words with parameters must finish with a right hand bracket ")'.

Segment name already included.

The specified Procal segment has been included in the program more than once.

Segment name not found.

The specified Procal segment could not be found.

Serial port portnumber is either in use or does not exist.

An attempt has been made to open a serial port which is either in use by another application or does not exists
on the computer.

Serial Timeout. Port %d.

A timeout has occured on the specified Serial port. Ensure the device is connected and functioning correctly.

String overflow.

A string parameter is too long or too short. Check the syntax of the word in question. .

Subroutine or mark name re-defined.

A Begin:Sub with the same name has been found twice in the same program.

Syntax : Comment.

A comment start '{' or comment end '}' has been found without its partner.

System Busy.

The system is currently busy executing a program or task. All programs or tasks must be stopped before any
other operation can be carried out.

System variable name re-defined.

The specified variable has been defined but already exists as a system variable.
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The system name system is currently in use by another application.

Another program is currently using the specified system. Only one application can use a system at any one
time.

Too many parameters.

Too many parameters have been passed to the Procal Word. Check the syntax of the word in question.

Undefined subroutine name.

The name of the subroutine has not been defined with Begin:Sub .

Unknown Error %d.

An error has occured with the system or program that cannot be identified. If the problem persists, contact your
local Brown and Sharpe agent.

UNTIL without REPEAT

An Until word has been found without a preceding Repeat.

Variable name re-defined

The specified variable has been defined more than once.
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25.5 Pro-Composer General Error Messages

’ System is not calibrated. A successful calibration is required before scanning.

In order to perform a component scan, the system must be calibrated. This is done using the Open Calibration
command of the Pro-Measure software.

’ filename Schematic contains non registered Feature Types.

A schematic was loaded which contained features not active on this Pro-Composer installation.

’ No more than X features of this type may be defined.

The number of measurements definable for a particular feature type is limited (normally to 9 or 99). This
constraint is due to the Label size of three.

} No more than X measurements may be defined.

The maximum number of definable measurements for a schematic has been reached.

} System is in use by another application.

The system is being used by another application for scanning/measuring. Either wait for the other application
to complete it's task or stop the task.

’ Schematic has been successfully saved but the program cannot be compiled until the Component
Reference Position is set.
Although the Schematic has been saved, the Procal program cannot be generated for this schematic until the
'Set Component Position' routine has been completed.

’ Failed to open filename file.

For some reason the selected file failed to load. This could be a general file access problem or because the
file is locked. The file or disc could be damaged or corrupt.

’ Failed to create filename file.

For some reason the selected file failed to create. This could be because you do not have the correct access
rights for the folder. It may also be because the file already exists and has read only attributes.

} File filename is corrupt or not a Pro-Composer Schematic file.

A problem occurred trying to convert a DOS version schematic for use with this version of Pro-Composer.
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25.6  Pro-Composer Defining Measurements Error Messages

’ Measurement Zone(s) not suitable for Feature Type.

The zone doesn't contain the specified feature, or if it is a two zone intersection, the zones don't cause an
intersect point.

’ Standards Database Error. Insufficient Data.

A standard has been chosen, but not all the fields have been selected (turned green) on the Standards
Database page or the Measurement Properties dialog box..

} Standards Database Error: Parameter name not in FeatureType name.

A Standards database table has been defined which tries to use a non-existent parameter in the specified
Feature Type.

’ Parameter out of range.

A specified parameter value is incorrect for the measurement.

’ Upper Limit must be greater then Lower Limit.

For Min-Max parameters, the max must be bigger than the min.

’ Label must be either 1 letter followed by 2 digits, or 2 letters followed by a digit.

Labels must be of the correct format.

’ Label already used.

Labels must be unique. You have chosen one that is already in use. The label in question could be for a Sub
Measurement Feature and so not visible on the schematic drawing.
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25.7 Pro-Composer Import DXF Error Messages

> Failed to find link name in DXF file. Correct problem in CAD application and retry.

Problem with the profile layer. The profile must be a fully connected outline.

’ Unrecognised DXF entity or corrupt filename file. Correct problem in CAD application and retry.

Invalid DXF file, or unsupported DXF entity was used in drawing. See DXF property specifications for a list
of valid entities.

’ Either both or none of the layer names must be specified.

You must specify the a name for each layer or no name for both layers. You cannot specify a layer name for
one of the options, it must be all or nothing.

’ Profile and Centre-Line layers must have different names.

You cannot use the same name for both the layers. They must each have a unique name.

} Centreline is missing or incorrect. Correct problem in CAD application and retry.

There is a problem with the Centreline layer. Check the details of the layer to ensure it conforms with the
DXF Import specifications.

’ Profile missing or incorrect. Correct problem in CAD application and retry.

There is a problem with the Profile layer. Check the details of the layer to ensure it conforms with the DXF
Import specifications.

’ Centreline and Profile missing or incorrect. Correct problem in CAD application and retry.

The system can't find a valid Centreline AND Profile layer in the DXF file.

» Centreline is not inside the Profile. Correct problem in CAD application and retry.

The centreline must pass through the shape profile (Y axis).

} Centreline does not exceed the Profile. Correct problem in CAD application and retry.

The centreline must exceed the extents of the shape profile (X Axis).

’ Centreline not horizontal.

The centreline of the imported CAD drawing is not horizontal. One of the CAD layers to be imported must
contain a single line which is 100% horizontal. This is assumed to be the centre-line.

’ Unexpected end of file.

The end of file has been reach unexpectedly. This suggests a problem with DXF file.
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26 Getting Help
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26.1 How To Access Help

Help can be obtained in the following ways:

e  Viathe 'Help Topics' option on the main menu bar or the 'F1' function key. This will present the main
help window at 'Contents' level access to the reference information.

e  Viathe 'Help' button available within Dialog Boxes. This will provide a Help topic explaining the
functions available within that particular dialog box.

e By moving the standard mouse cursor over different areas of user interface i.e. buttons, menus,
toolbars etc. a yellow information bubble (Tool Tip) will appear with a brief description of the function
or item. To complement this, there is also a text line at the bottom of the Application window which
displays a line of help information.

26.2  Using the On-Line Help System

The Help system interface has several displays and controls. The interface is divided into three sections, called
panes.

The three panes are :

Navigation Pane. This is the pane that appears on the left hand side of the Help window and contains Contents,
Index and Search Tabs. Each selected Tab presents a means of accessing the Help information.

Topic Pane. This is the pane that appears on the right hand side of the Help window and where the Help
content is displayed. This is where you will view the information.

Button Bar Pane.This is at the top of the help window and contains buttons for control of the Help System.

26.2.1 Navigation Pane

The Contents Tab provides a hierarchical view of the content in a table form. Click a topic listed in the table,
and you will be taken directly to that information. A single topic is indentified by a % The table of contents is

also divided into sub categories, like chapters in a book. These are denoted by a @ Double click the category
heading and further topics or categories will be available for selection.

Introduction
| - Z] SAFETY NOTICE
R Yrofil= Hardware
\: Q Pro-Measure Software
| -8 How to Get Help

The Index is an alphabetical list of topics. All major topics will be listed here. Double click the topic or click
once to highlight and press the 'Display Topic' button to show the topic information. You can type a word or
letters in the text box and the list will move to the nearest alphabetical match in the list.
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brating & Profil
Calibration Faults
Calibration Mode

Calibration values of 'daily setting piece'
Cascade command (Window menu)
Close command (Control menus)

Close command (File menu)

The Search Tab provides a means to locate information based on a keyword search of the entire contents. A
word can be typed into the text box at the top of the pane and all topics will be listed that contain the typed
word. Double click on the topic in the list to display it in the Topic pane or click once to highlight and press the
'Display’ button. The selected word will be highlighted where it appears in the topic. Note, it is important that
when the word to search for is typed in the text box that is is pre-fixed with a * otherwise no topics will be
returned i.e.

To search for the word 'Gauge' you must type :

*Gauge

acking up Machine Specific Data
alibrating a Profile Gauge

26.2.2 Topic Pane

This is the viewing area for the information. The text you are reading now is being displayed in the Topic Pane.
If there is too much intormation to fit into the area, scroll bars will become active. The entire help window can
also be sized, shaped and moved in the same way as any other application window. It is sometimes necessary to
re-size the window to suit the contents. Some larger topics have been programmed to open a larger secondary
window automatically. This can be controlled in the same way as the normal topic pane.

TOPICS

The information contained within a topic can vary. It could be text, graphic images, photographs, animations,
control buttons, links to other topics or any combination of them all. Text links to other topics are coloured in
green and underlined. Simply click the mouse pointer onto the link and the associated topic will be displayed.
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26.3 Button Pane

Several buttons are available for controlling the Help system.

Hide Button. Hides the Navigation pane such that just the Topic Pane and Button Bar is visible. The
default Help window opens with the navigation pane visible, click this button to hide. Hiding the
navigation pane is sometimes useful to enable the topic pane to be maximised to fit the whole of the
monitor display.

Show Button. Displays the Navigation pane.

Forward Button.This moves to the next topic if several topics have been viewed and the 'Back' button has
been used.

Back Button. This reverts to a previously viewed topic. Each time the button is pressed, the previous
topic to the one currently displayed can be viewed. This button has no effect if only one topic has been
displayed.

Print Button. This activates the Print command to enable topic contents to be printed. When selected, an
option box is displayed to provide the choice between printing the current topic, or all topics within the
currently selected heading.

Note :
There is no Hide/Show buttons available on secondary windows.

26.3.1 Notes about the Help System Title Bar

The title bar is located along the top of a window. It contains the name of the Help system relevant to the
application it was launched from.

To move the window, drag the title bar.

The following elements can be available in the Title Bar :

Eg Window Control-menu button

Maximise button. This enlarges the window to fill the available space

Minimise button. This reduces the window to an icon

[ Restore button. This returns the active window to its size and position before you chose the Maximise or
Minimise command.

x| Close button. This closes the Help system.
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264 How To Access Help for Procal Keywords

When the Procal Editor is open it is possible to obtain help on Procal Keywords. Highlight the procal word and
press the F1 Help button. This will then display help information on the highlighted selection. It is important
that you highlight the word correctly, otherwise an out of context error message will be displayed when the help
system is called.

Correct method of highlighting words is as shown :

Define: Measz=(HU1l . "Dinenszion 1".,10.0,0.1,-0.1.13}

If an error message appears when you call the help on the highlighted selection, simply close the error message
boxes by clicking the 'OK' or 'Cancel' button and then close the help system. Highlight the word correctly and
press F1 again. The error message that appears will have an incorrect meaning to your action, this is due to a
current limitation of the Help system.
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1

1, 2, ... command (Window menu), 4-11, 18-9
1, 2, 3, 4 command (File menu), 4-5, 18-4

A

About command (Help menu), 4-12, 18-10

Across Flats Feature, 21-12

Add Remove Breakpoint command (Debug Menu),
4-10

Additional features available for a Parallel thread
but not selected as default., 22-3

Advanced User Additional Call Routines, 13-17

Angle Feature, 21-13

Angular Position Feature, 21-14, 21-34

Application Status Bar, 3-3

Archiving to a File, 10-16

Arrange lcons Command (Window menu), 4-11, 18-
9

Ascii to Hex Conversion Table, 10-32

Assignment Instructions, 10-8

Axial Scanning, 24-2

B

Backup command (Tools menu), 4-7, 18-8
Backup Machine Specific Data, 8-2

Basic form of a Procal program, 10-3

BPI - Configuring the Software, 14-4

BPI - Interface Introduction, 14-2

BPI - Programming the box, 14-2

BPI - Using in measurement programs, 14-6
Branching Instructions, 10-18

Breaking out of a Locked Program, 10-34

C

CAD Drawing Format Specifications, 21-3
Calibrate a Profile Gauge, 6-2

Calibration Faults, 6-3

Calibration Mode, 3-4, 6-2

Cascade command (Window menu), 4-11, 18-9
Centre-Line Feature, 21-15

Close a document, 7-5

Close command (File menu), 4-4, 18-3
Component command (Scan menu), 18-6
Component Range, 24-2

Computational Instructions, 10-9
Concentricity Feature, 21-16

Conditional Instructions, 10-14, 10-20
Contact Details, 26-6

Continue Execution command (Debug Menu), 4-10
Control environment, 10-3

Co-ordinate Data Structure, 10-4

Copy a document, 7-5

Copy a whole line, 12-9

Copy command (Edit menu), 4-2

Copy several lines at once, 12-9

Copy to another document, 12-9

27-2

Copy words or part of a line, 12-8

Create a New document, 7-4

Creating a New Database, 11-3

Cursor Function, 6-8

Customised Reports to the Printer, 10-13
Cut command (Edit menu), 4-2

D

Debug Calibration command (Debug Menu), 4-9

Debug Measurement command (Debug Menu), 4-9

Debug menu commands, 4-8

Default features output for a Parallel Thread., 22-2

Default features output for a Taper Thread., 22-5

Default features output for a Worm Thread., 22-7

Define a Centre-Line, 21-33

Define a Length, 21-34

Define a Reference Edge, 21-31, 21-32

Define an Angular Position A-B, 21-34

Define Feature Properties, 21-29

Define the component position, 21-2, 21-32

Define the Features, 21-10

Defining Measurements Thread Zones., 22-3

Defining the Component Position - Principle, 21-32

Defining the Measurements - Principle, 21-7

Definition of Terms, 10-2

Delete a file, 7-5

Delete a whole line, 12-8

Delete All Measurements, 18-4, 18-10, 21-38

Delete All Measurements command (Edit Menu),
18-4

Delete characters, 12-7

Delete command (File Menu), 18-3

Delete Individual Measurements, 21-38

Delete several lines at once, 12-8

Delete words or part of a line, 12-7

Device Mapping - Principle, 9-2

Device Mapping Dialog Box, 9-2

Dialog Boxes and their settings, 20-2

Diameter Feature, 21-18

Display windows, 3-2

Draw Zone Mode, 3-4, 6-7

DXF, 7-3, 18-7, 20-3, 21-3, 21-4, 22-6, 24-2, 25-11

E

Edge Feature, 21-21

Edit menu commands, 4-2

Edit Toolbar, 17-2, 19-2, 21-7, 21-10, 21-34, 21-37
Editor command (Tools menu), 4-6

Enable Sub Measurement Features, 21-30

Error Messages, 25-1, 25-3, 25-9, 25-10, 25-11
Error Trapping, 10-33

Execution Mode, 6-4

Exit command (File menu), 4-5, 18-4

Export command (Scan menu), 18-7

F

Feature command (View menu), 18-5, 20-8



Feature Labels, 21-8

FeatureID number table, 11-9
FeatureParameterID number table, 11-11
Features Available, 21-11

Features Toolbar, 17-2, 18-5, 19-4, 21-10
File menu commands, 4-4, 18-2

File Operations, 7-2

Find command (Edit menu), 4-3
Floating Menu Commands, 18-10
Folder Structure, 7-3

Form Deviation Feature, 21-24
Formatted Input/Output, 10-31

G

Gageport Diagnostics, 15-13

Gageport Diagnostics, 15-13

Gageport Gage Number Table GP2102-NT, 15-10
Gageport Gage Number Table GP2102-NT, 15-10
Gageport Measurement Programs, 15-5

Gageport Measurement Programs, 15-5

Gageport Port Assignments, 15-14

Gageport Port Assignments, 15-14

Gageport Program Examples, 15-8

Gageport Program Examples, 10-30, 15-8
Gageports - Configuring the software, 15-2
Gageports - Configuring the software, 15-2
Gageports - Digital NT and Probe NT, 15-9
Gageports - Digital NT and Probe NT, 15-9
Gageports (NT) with Pro-Measure software, 15-2
Gageports (NT) with Pro-Measure software, 15-2
Gauge command (Tools menu), 4-6

General Controls, 3-5

Geometric Best Fits, 21-7

Groove Depth Feature, 21-24

H

Headers and Footers, 7-3, 20-3, 23-1, 23-2

Help menu commands, 4-12, 18-10

Help Topics command (Help menu), 4-12, 18-10
How To Access Help, 26-2, 26-5

How To Access Help for Procal Keywords, 26-5

I

Import a CAD Drawing, 21-3

Import command (Scan menu), 18-7

Include Files as Headers or Footers, 23-2
Include Headers or Footers Messages, 23-3
Input Instructions, 10-8

Interactive Instructions, 10-8

Interpretation of Graphics Display Results, 6-6
Interpretation of Text Display Results, 6-5
Introduction, 2-1, 2-2, 13-2, 14-2, 16-1, 16-2

K

Keyword Reference - Introduction, 13-2
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L

Label Floating Menu, 18-10

Language command (Tools menu), 4-6, 18-8
Language Syntax, 10-2

Length Feature, 21-25

Looping Instructions, 10-21

M

Machine Settings command (Tools menu), 18-8

Machine Specific Data, 3-5, 8-1, 8-2, 8-3

Main Menu Commands, 18-2

Main Menu Options, 4-2

Making a Component Picture - Principle, 21-2

Map a device, 9-3

Mapping Dialog Box, 9-2

Measurement Mode, 6-3, 6-4

Measurement Mode Controls, 6-4

Measurement Properties - Measurement Page, 20-
9

Measurement Properties - Reference Page, 20-15

Measurement Properties - SPC Page, 20-17

Measurement Properties - Standards Database
Page, 20-14

Measurement Properties Dialog Box, 20-8, 21-29,
21-31

Measurement Zones, 10-11, 21-37

Measuring Line lliustration, 21-5

Modify and Create Standards Databases, 11-2

Modify Measurement Zones, 21-37

Modify the Measurement Properties, 21-37

Move a whole line, 12-10

Move information into another document, 12-11

Move several lines at once, 12-10

Move words or part of a line, 12-10

Multiple measuring modes, 24-2

N

New command (File menu), 4-4, 18-3
New command (Window menu), 4-11, 18-9
Notes about Rotational Draw Zone, 6-10

0]

Offset Diameter Feature, 21-25

Open an Existing document, 7-4

Open Calibration command (File menu), 4-5
Open command (File menu), 4-4, 18-3

Open Measurement command (File menu), 4-5
Operating Codes, 10-4

Options - Advanced Page, 5-2, 20-3

Options - Folders Page, 5-3, 20-3

Options - Passwords Page, 5-3, 20-4
Options - Selector Page, 5-5, 20-5

Options command (Tools menu), 4-7, 18-8
Options Dialog Box, 5-2, 20-3

Output Instructions, 10-12

Overview command (View menu), 17-4, 18-5
Overview of Design, 3-2

Overview of Pro-Composer Design, 17-2



Overwrite and Insert text, 12-7

P

Page Control - Text/Graphic Display Screen, 6-5

Parallel Threads, 22-2

Paste command (Edit menu), 4-2

Preparing Measurements for Output, 10-12

Principle of Operation, 21-2

Print a document, 7-6

Print a Procal Program, 12-11

Print command (File menu), 4-5, 18-3

Print Measurement results, 6-10

Print part of a Procal Program, 12-11

Print Preview command (File menu), 18-4

Print Setup command (File menu), 4-5, 18-4

Procal Editor, 4-6, 12-1, 12-2, 12-3, 12-4, 12-5, 23-2,
26-5

Procal Editor - Automatic Colour Coding, 12-3

Procal Editor - Cursor control, 12-3

Procal Editor - Display Window, 12-2

Procal Editor - Editing controls and shortcut keys,
12-4

Procal Editor - Highlighting, 12-5

Procal Editor - Status Bar, 12-2

Procal Editor - Typing, 12-4

Procal Keyword Reference - Manual Edit, 13-4

Procal Keyword Reference - Pro-Composer, 13-3

Procal Registers, 10-5

Procal Serial Trace command (Debug Menu), 4-9

Procal Watch command (Debug Menu), 4-8

Pro-Composer Defining Measurements Error
Messages, 25-10

Pro-Composer File Types, 7-3

Pro-Composer General Error Messages, 25-9

Pro-Composer Import DXF Error Messages, 25-11

Pro-Composer Introduction, 16-1, 16-2

Profile Measurement - Basic Concepts, 16-2

Program Debugging, 10-34

Program Example - Lengths and Diameters, 10-23

Program Example - Standards Database, 10-25,
11-3

Program Example - Thread Measurement, 10-25

Program Making - Hints, 21-36

Program Making - Stages, 21-2

Program structure and control environment, 10-2

Programming Hints - Draw
Zone, 10-36

Programming Hints - Modifying CALL statements,
10-36

Programming Hints - Overscanning, 10-37

Programming Hints - Rotational Measurement
Functions, 10-38

Programming Hints - Scanning of Zones, 10-37

Programming Hints - Thread Measurement
Functions, 10-38

Programming with Procal, 10-2

Projector Range, 24-2

Pro-Measure Error Messages, 25-3

Pro-Measure File Types, 7-2

Properties command (View menu), 18-6, 18-10
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R

Radial Scanning, 24-2

Radius Feature, 21-26

Reference Edge - Principle, 21-31
Reference Function, 6-9

Region command (Scan menu), 18-7
Restore Machine Specific Data, 8-3
Rotation Diameter Feature, 21-26
Run Out Feature, 21-27

S

Save a document, 7-5, 21-35

Save As command (File menu), 4-4, 18-3

Save command (File menu), 4-4, 18-3

Saving the Schematic - Principle, 21-35

Scan a component, 21-4

Scan a Region, 21-6

Scan menu commands, 18-6

Scan Region - Principle, 21-6

Schematic Floating Menu, 18-10

Schematic Overview Window, 17-3

Schematic Properties - Measurement Page, 20-6

Schematic Properties - User PROCAL Page, 20-7

Schematic Properties Dialog Box, 20-6

Scroll bars, 3-5, 4-8

Scroll Bars, 17-5

Search a document, 12-7

Selection of Units, 11-3

Set Component Position (Scan menu), 18-7

Setting the Schematic Properties - Principle, 21-6

Single Step command (Debug Menu), 4-10

Special Notes about Parameter fields for worm
threads., 22-8

Special Notes about Safety Critical Features., 22-3

Special Notes for Defining Taper Thread
Measurements, 22-5

Special Notes on Taper Thread Parameters, 22-5

Standard Toolbar, 17-2, 19-4

Standards Databases, 10-38, 11-1, 11-2, 11-8, 20-3

Standards Databases - Programming Hints, 10-38,
11-8

Start a Measurement program, 6-3

Start-Up Problems, 25-2

Status Bar, 3-2, 12-2, 17-2, 17-4, 18-5, 21-7, 21-10

Status Bar command (View menu), 18-5

Straightness, 13-38, 13-76, 19-4, 21-9, 21-11, 21-28

Subroutines, 10-19

T

Taper Threads, 11-2, 22-4, 22-5

Terminate Debugging command (Debug Menu), 4-
10

Thread Feature, 21-28

Thread Measurement, 10-25, 10-35, 10-38, 13-16,
22-1,22-2,22-5

Thread Measurement Option, 10-35

Tile command (Window menu), 4-11, 18-9

Title Bar, 3-2, 3-4, 17-2, 17-5, 26-4

Toggle Control - Text Display Screen, 6-4



Toolbar, 3-2, 3-4, 6-7, 17-2, 18-5, 19-2, 19-3, 19-4, AV
21-7,21-10, 21-33, 21-34, 21-37

Toolbar command (View menu), 18-5 View menu commands, 18-5
Toolbars, 18-5, 19-1, 19-2
Tools Menu commands, 4-6, 18-7 W
Trouble Shooting, 25-1, 25-2
Types of Procal Instructions, 10-7 Window menu commands, 4-10, 18-9
Workspace Window, 17-2, 17-3
U Worm Threads, 22-2, 22-7

Writing Data to a Serial Port, 10-18
Using the FIND command, 10-11
Using the On-Line Help System, 26-2 7
Using the Standards Database in Pro-Composer,
11-8 Zone Function, 6-7
Zoom Extents Button, 19-3
Zoom Function, 6-7
Zoom Select Button, 19-3
Zoom Toolbar, 17-2, 19-3
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